CME 2 User Guide

copley &2
controls”

11111111111
Revision 00
aaaaaaaaaaa



CME 2 User Guide

Contents

ADOUL TRIS IMBNUAL ...ttt ettt a et e ettt oo bt e ea ket e 4 ke et ook bt e £ 4a ke £ o4 s b e e e ek b et e 4a b e £ e e n b et e e aa b et e eab et e e ennt e e e anbeeesnnbeeeens
R EoL=To l B o od0 o =T o1 L1 (o] o H O PP OUPPPRPPPRN
Copyrights ........ccuveeeee.
Document Validity.....
Revision History.....
1: Introduction .........cccoceeeiiieiennnen.
1.1: Host Computer Requirements .
Computer aNd OPEIALING SYSTEM......eiiiiiiiiiit ettt e e ae et e e e e b bt e e oa bt e e aabe e e e aabe e e e ah bt e e sabe e e e abbe e e e bbeeeanbeeeeennreas
DEFAUIL FIlE LOCALIONS ......eeiiieiiiitieiee e ettt e oottt e e e e ettt et e e oo e sa bbbt e e e e e e o s kbbb et e e e 4 e s babe e e e e e e o nb bbb e e e e e e e anbabeeeaeeesnnbeneeaeesannnnrees
Serial Communications...
CAN Communications.....
EtherCAT Communications.
1.2: OVEIVIEW ...
Setup and Tuning ..... .
1o (=T o Vo TR PP PP PPPPTRPROIN
(O 1o 0 T 1= o] =TS TP TP PPPPTN
1.3: Servo Operating Modes and Control Loops ..........
Control Loops Model..........cccoocvieiniiiciniiiennnen, .
Basic Attributes Of All SEIVO CONLIOI LOOPS ....c.uutiiiiiiiieiiiite ittt ettt ettt skt e e e e s e e e eanreas
2: Installation, Startup, @nd INEEITACE TOUT.......uiii et e e e e s ettt e e e e e s bbbe et e e e e s e nsbebeeaaeaesnbbbeeeaeeeannnbereaaeeas
2.1: Download and Install CME 2 Software...................
2.2: Special Notes for Windows 7 and Windows 8
INStaller.........occoveeiiiieiiiee e
Set up CME 2 to run as administrator
23:Start CME 2., .
2.4: COMMUNICALIONS WIZAIT .......eieitiie ittt ettt ettt e e et b et e ek bt e o2t et a4k bt e e ok bt e e oab e £ e e b b e e e ek bt e e aa ket e e bb e e e e nnbeeesnbeeeeaneneas
(o101 1o [N (IST=T (E= I 2o T4 T OO OPPPPTRP
Configure CANopen Network....
Configure EtherCAT Network....
2.5: Connect to an Amplifier
2.6: Rename an Amplifier ......
2.7: CME 2 Interface Tour... .
LI Lo I = - L PP PUPROPPPRRN
LY [T LU= =T PP PO PP PPPPPPTR PRI
Functional Diagram...........cccccceeenne
CAN Information and Status Bar .
3: P ] o1 T ER ST (U o PP PRSPPI
o ST (BT oI = (o Tod =T L1 T PP OUPRPPPPTN
Warnings and Notes .............ccc...... .
4 Basic Setup.....ccccceevviveeennnnn.
4.1: Overview
4.2: Change Basic Setup Settings
4.3: ServoTube Setup.......cccovcvveeriiicennnnn. .
5: MOTOTTFEEADACK ...ttt e oo b e oo bt oo e et o4kt e e ekt e e e ettt e ekt b e e s br e e e neb et e s eanneeens
5.1: Motor/Feedback Screen Overview
5.2: Load Motor/Feedback/Brake Settings from a File..
5.3: Rotary Motor Parameters............cccvvveeeeniiieeeeenn.
5.4: Linear Motor Parameters ..........
5.5: Feedback Parameters, Rotary ..
5.6: Feedback Parameters, Linear............ .
L A Yo To [ o o 1o g [0 L= PSSR U PP OUPPPPPI
5.8 BraKe/StOP PAr@MELEIS. ... ..eiiiiiiiiiiiii ettt a oo a oot e bt e oo a et o et e kbt e ekttt et e e e s
5.9: Calculate .........ccccevveennne
6: Digital Inputs and Outputs.. .
(30 B o 11 = L g o 10 £ OO T TP TP TP PP P TP PP PP PUPPRPPI
(S BT 117 I O 11 11 o1 U £SO PP PO TR PPPUPPPPPOROTRE
6.3: Custom Event Triggered Output................ .
6.4: Custom Trajectory Status Triggered Output.
6.5: Custom Position Triggered Output.............
6.6: Synchronizing PWM Switching Frequency ...
6.7: Analog /O ..ccouviiiiiiii .
ANAIOG MOLOT TEIMPETATUIE SENSO ......eeitieeeiiiitietee e e e ettt et e e e e e e ttet et e e e e aaaebbe e e eeeeaasbebeeeae e e o sabe et eeeeaannbsbeeeeeeeanbnbeeeeeee e nnbnreeeeens
F Y E=1(oTs IO U 1 o 1| TP PP PUPP R POPPPPPI
7: Command Inputs .........ccceeennne .
7.1: Analog Command Settings
Analog Command Notes.
7.2: PWM Input Settings................
50% Duty Cycle (One-Wire)

Copley Controls 2



CME 2 User Guide

10:

11:

100% DULY CYCIE (TWO-WITE) ... eteiieeeeiiiitieteeeeestiteteeeeesssstaaeeeeeeaastateeeaeeesasstaaeeaaeaeasssseeeeeee s sstsseeeeesaansnsaeeaeeessnsnsenanesnssnnens 74
Failsafe Protection from 0 or 100% Duty CycCle COMMEANAS ........oc.uuiiiiieiiiiiiiiie ettt e e e et r e e e e e ssnbe e e e e e e e annnees 74

7.3: Digital POSItION INPUL SELNGS ... eeeieiiieieiite ettt e e e e ettt e e e e e s s bbb et e e e e s e aaba b et e e e e e s b bbe e e e e e e e anbsbeeeeeeeaasnbeeeeaeeaaannnrnes 75
Pulse Smoothing

PUISE AN DIFECHION. ...ttt ettt et h e e et e e e ab e e e eh b et e sk e e e e b bt e e sab et e ekt e e e e nab e e e sbe e e e eaneeas
COUNE UP/COUNT DOWIN ...ttt ettt ettt e e+ ekttt e e e+ o4k bttt et e e o4 a e bbb et e e e o4 aa kb be et e e e e e nbbb b e e e e e e e ambbbeeeaeeeaannbbbeeaaeaeanes
QuAadrature ........ccccvveveeeeeiiiiiieee e e
7.4: Software Programmed Input Settings....
Programmed Position ..
Programmed Velocity...
Programmed Current
Network Configuration ..
8.1: CANopen Network.....
8.2: MACRO Network ......
8.3: EtherCAT NetworK...........ccocvvvvevnnnenne
EtherCAT Address (Station Alias)...
FaUItS ...
9.1: Overview ...
9.2: Fault Descriptions ..
Motor Phasing.............
FO.1: AULO PRESE ...ttt h e b oo b e e e e b e e e e b e e et s bt e e e e e e e s aee e
Auto Phase EXample: SErVO AMPITIET.......coi ittt e e et e e sa bt e st et e e et bt e e sabe e e sbeeeennane
Auto Phase Example: Stepper Amplifier, No Encoder
Auto Phase Example: Stepper Amplifier with Encoder, in Stepper MOUE .........cccciiiiiiiiiiiiiiiiiice e 97
Auto Phase Example: Stepper Amplifier with Encoder, in SErvo MOGE............coiuiiiiiiiieiiiiee et 98
10.2: Tips for Auto Phase Current and Increment Rate
10.3: Troubleshooting the AUto Phase PrODIEMS ..........coiiiiiiiii et
Motor direction setup
Motor wiring setup .... .
PRESE COUNT EEST ... ittt h et e oo ab et e oo b et o4 bt e oo h bt e e a et e sa b et e e bt et e e bbb e e sabe e e e eineees
[ EE 1T To JET= (1] o OO ROPPPPPPRRRPI
10.4: Manual Phase
Phase Initialization for Motor WithoUt HAUIIS ..........ccocuiiiiiiiiic e
Manual Phase Example: MOtOr With RESOIVET ...........oiiiiiiiiiiii ettt e e e snbe e e s bn e e e aneeeas
Troubleshoot Manual Phase w/ Encoder and Halls
D= = . Lo o0 = (o L (=] PP PP PPN
=g ool [T N1 g To [ ) SO TPROPPPPUPRRRPI
Hall signals test .....
Hall transition test ..
Control LoopS....cccvveeviieeiiiicenien.
11.1: Current Loop Setup and Tuning.
11.2: Current Loop Auto TUNE ......ceevviiieiiiiiieeeeee
11.3: Notes on the Current Mode and Current Loop ...
Current Loop Diagram ........cccccceeeviieeiiieeennnnne.
Current Loop Inputs..

Current Loop Gains ..
Current Loop Output..

11.4: Velocity Loop Setup and Tuning ..........ccceeeevveennne
11.5: Notes on the Velocity Mode and Velocity Loop .....
AV 4= (o1t VA Mo Lo o B To | = 4 I PR PRPPPRN
18] 01U ST PP PP PO P PP PP PR PR PR PR PRPRPION
Velocity Loop Limits
Diagram: Effects of Limits on Velocity COMMEANG............oiiiiiiiiiiiie ettt e e e snbe e e s be e e e aneeeas 123
V4= (o1 1A VA o Lo o Y =113 PP OUPRPPPRN
Velocity Gains Shift...
V4= (o1 1AV o Lo o ) 1 =Y £SO ROUPRTPPRN
V4= (o1t VA o Lo o J O 1011 o 10 £ PSP PRTPPRN
Proper Tracking Over Time.
VelOCity TraCKiNgG HUSIFALION ......cooiiiiiiiiiiei ettt ettt e e e e ettt et e e e s bbb b et e e e e e ambbbe et e e e e e nbsbeeeeeeeanbnbeeeeeeesannnnnnes 124
11.6: POSItioN LOOP SELUP AN TUMING ..eeeeiiiiiiiiiieee ettt ee ettt e e e sttt e e e e e s bbbt e e e e e e s as bbb et e e e e e sabbbe e e e e e e aannbabeeeeeeeaannbneeeeeesannrnneen 125
Parameter
[ D=2 od (] 1 (T o IO OO PP PP PPPPPPPPPON 127
11.7: Notes on the Position Mode and POSItION LOOP ......cuciiiiiiiiiiiiee ittt ettt e e e ettt e e s e nbeb et e e e e e senbereeeeeeannnnnees 132
Position Loop Diagram..........cccccevveeernieeinieeeennns ... 132
Trajectory LIMItS ........ueeeiiiiiiiieiee e ... 132
Position Loop Inputs From the Trajectory Generator ..... 132
Position LOOP GaINS.......cvviiiiiiieiiieceiee e 133
Position Loop Feedback .. ... 133
Position Wrap ............ ... 133

FOHOWING EITON FAUIES ......ceeieiiee ettt oo a et £ ket e e st e e a et e et e e e bttt e e nsn et e sbe e e e enneeas 133

Copley Controls



12:

13:

14:

15:

16:

17:

Copley Controls

CME 2 User Guide

FOIOWING EFTON WAITHNGS ...ttt ettt e et a et e ke e e as et ookt e 4 a ket a4 e h e e e s et e ea bt e e b et e e anbe e e s e e e e nnnnees
Position and Velocity Tracking Windows
Following Error Fault Detalls..................
11.8: Auto Tune all LOOPS fOF LINEAT IMOTOTS .......veiiiiiiiieiiiiee ettt ettt ettt ettt et e a e ettt e ekt e e e bt e e e aab e e e e bbe e e e nb e e e sabeeeenneeas
0= o] o1=T g UL 1o o [P O PSPPSR PUPPROPPPRIN
12.1: Stepper Motor Support.....................
12.2: Position Limits (Stepper Amplifier) ...
=120 0= =T PPN
[ D=2 od ] o] (o] o PO PO PP P P PPPPPON
12.3: Encoder Correction..........
12.4: Detent Compensation Gain..
Homing..............
13.1: Overview
13.2: Absolute Encoder Calibration..
[V [=To] g Eo T g Tt B o (o 41 o To [P TPPPP T OPOUPPPPPN
(OS] = 1o o OO P PRSPPI
Control Panel ...........ccceevvene.
14.1: Control Panel Overview
14.2: Status Indicators and Messages
14.3: Control Panel Monitor ......................
Monitor Variables
I o g1 o] B U g To) o] PPN PTR PR
ST Lo To TV oo [ T T T T T P O T P PP P PP P PP PP PP PPPRPPOP
Oscilloscope.....
15.1: Overview
15.2: Menu, DiSPlay ANT CONLIOIS .......ciuuiiiiiiiie ittt h ettt ettt e b bt e e e et e e bb et e e bbbt e st et e e kbt e e e rar e e e sbeeeeanneees
FIE IMIBINU ..ot ootk o ke 4ea et e e h et o4 bt e 4o h bt e ek et et e et bttt e e s
File Menu..
Display.......ccoceeveineenne
Trace Display Zoom.....
Controls.........cccveeeene
15.3: Function Generator.....
R S (o] [ [N =T =T = L (o] O TP T T T O T P P T PP PO PP PP PPPRPRPOI
15.5: Trace Channel VariabIEs ..........covioiiiiiiiiiie ettt st e e et e nae e e e st e nne e e e e nneeene s
15.6: Trigger Setup.......cccccveeee.
15.7: Measurement Tab............
15.8: Control Loop Parameters.
Gains Tab.......cccccovevnenne
Trajectory Limits Tab ......
POSItION LOOP PAIAMELEIS. ... .eiiiiiiieiiiie ettt ettt oottt ot bt e e e ab bt e oo hb et e o ket e e eh b et e e aa bt e e embe e e e hbt e e e abbeeesnbneeeaneeeas
VEIOCIEY LOOP PAIAMELEIS .....coiuiiieiiiiee ettt ettt ettt e e e bt e s a ket e ok bt e oo b b et e e R be e e e kbt e e e skt e e e ambe e e e bbe e e enbbe e e snbeeeeanbeaeens
15.9: Scope Trace Files
15.10: Trace Viewer ...........
1= T T TP T PP PO PO PR OPPPPRPPP
16.1: SEHING PArAMELEIS ...ttt ettt e bt e a et e e bt e ook et eea bt e e bb et e e bb et e ettt e et et e
16.2: Filter Configuration Windows ..
16.3: Filter Settings..........cccceevvveeenne
16.4: Input Shaping ...
Analog.............
Velocity Loop............
(104 (= o1 o oo « PP PO PPTPP
SRS = oo Fo Lo 1 Y] o L= S OO RTOPPRRO
Low Pass Filter ............ .
High Pass Filter ........
Notch Filter...............
Band Pass Filter ..........
Custom Biquad Filter ...
16.6: Standard Filter Families
BULEIWOITN FIIEET ...ttt h et h e s et et e e st e s bt e be e ek et e s be e saneente e e neenaneanne
Chebychev Filter
Elliptic Filter .................
16.7: INPUL SNAPING WINGOW ...ttt ettt e ettt e e oo ettt e e e 4o e a bbb et e e e e e e s a bbb et e e a4 e am kb be e e e e e e e s bebeeeeeeesnnbnseeeeesannnnnnen
[T o1V ST s P o] o B Y/ =T SO PSPPSR PUPPROPI
16.8: Measuring Mechanical Vibration .........
Using an Accelerometer with CME 2......
Using CME 2 to Monitor Following Error ...
Data, Firmware, and LOgS .........coecvvvvveeeennnne
17.1: Amplifier RAM and Flash Memory....
LN aaT o)LL T = A OO OO P R PU PP PPPPRN
FIASH < et e et e
17.2: Data Management Tools..
LN 1010111 SO O TP PUPPPPPRN




CME 2 User Guide

Motor/Feedback Screen
17.3: Multi-Axis Data Tools.....
COopY AXIS .evvveeeeeiiiiieenn
SAVE/RESIONE SINGIE AXIS ...ei ettt ittt e et e oo bt e oo a bt e o4kt e e e ea b bt e e oa ket o4 ket e e eabb et e aa bt e e ea b et e e enbr e e e aabe e e e bneeeanane
17.4: DIIVE CONFIGUIALION .....eeteiee ettt ettt ettt e oo ookttt e e e e e o abte e et e e 24 e s tbbe e e e e oo aana bbbt e e e e e e aa b b be e e e e e e e nnbabeeeeeeesnnbnbeaaeeaannbnneen
Save Drive Configuration....
Restore Drive Configuration............
17.5: COPY DIIVE DALA .......eeeeiieeeieetee ettt ettt e e+ ookttt et e oo 4o s bbbttt e e 24 e a bbbt e e e e oo o aa bbbt e e e e e e aa b b bbb e e e e e e R bbb et e e e e e anbbbeteaeeeaanrnneen
17.6: Save MACRO File for Delta Tau Controllers
17.7: Lock/UNIOCK CME .......cocviiiiiieeieceeesreeee e
17.8: Firmware Download ...
17.9:Error Log ....cooeeeeeeeeeennn.
17.10: Communications Log ..
18:  Virtual Amplifier........c.cc.......
L1811 OVEIVIEW ...ttt ettt h et e e e okt e ekttt e ekttt oo b bt e e 4 ek e £ ook b e e e e b b e e e 4a b et o4 bb et e e bbb e e e aE et e e bb et e e b e e nn et e e as
e €= 1] g E- RS Tod o 1=To [N ] 11 o [T PT T UOTUPPRPTRPTPIRE
19.1: Overview ...... .
Storage Limits.................
19.2: Configure Gain Scheduling..............
19.3: Set Up Gain Scheduling Tables
20: Regen Resistor Configuration ...........cccoceeeiiiieinnien e,
Configure a Standard Copley Controls Regen Resistor
Configure a Custom Regen Resistor
View Regen Settings
I*T Time Limit Algorithm
(@Y= 4= T T PP PO PP PP PP PP PUPPPPPPPRIO
Formulas and Algorithm Operation
Application Example ..........ccccevieeennee
Homing Methods ........cccvveeiiiiiiiiiiee e,
OVEIVIEW ...t
Homing Diagram Legend............ccccceeenne
Homing Method Descriptions....................
Set CUITENt POSILION BS NOME ..ottt e ettt b et e et e e ea et e s be e e e et r e e e nabe e e s bneeeenans
LI EEY A [T 1= G PP PR PPRPRTRN
Limit Switch ..........ccee.e.
Limit Switch Out to Index
Hardstop.......cccccveevinennne
Hardstop Out to Index..
Home Switch ..................
HOME SWItCH OUL T0 TNOEX ...ttt h e st e b e et e sae e e ar e e et e e e neesen e e reeeneenaneanne
Home Switch In to Index
Lower Home....................
Upper Home. ..........ccc.....
LOWET HOME OULSIAE INUEBX.....ceteeiiiieiiieitie ettt se ettt e bt st e e et esae e e e e et e e bt e sen e e te e e neenaneanne
LOWET HOME INSIAE INAEX ...ttt ettt a ekt e e a et e e ettt e st e e bttt e e st e e nbn e e e eaenees
Upper Home Outside Index.
Upper Home Inside Index ...
ASCIl Commands/Serial Control .....................
Copley ASCII Interface ........cccceeveeeviieeennnne.
CME 2 ASCII Command Line Interface Tool
Single-Axis Serial Connection
MUIEI-DIrOP SEIAI CONMMECTION ......eeiitiii ittt ettt ettt ettt ettt e e ettt e e hb e e e ekt e e e oabe e e e ahb e e e e s b e e e aaEe e e e bbb e e e ambe e e ambe e e e asbe e e e anbeeesnbbeeeanneeas
B&B USB to Serial Adapter
Recommended Device
[ T (o] S T 0T LT PP PR PP

5 Copley Controls



About This Manual

About This Manual

Related Documentation

e Indexer 2 Program User Guide
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Camming User Guide
Parameter Dictionary
Serial Encoder Guide

Copley Controls software and related information can be found at:
http://www.copleycontrols.com/Motion/Products/Software/index.html

Copyrights
No part of this document may be reproduced in any form or by any means, electronic or
mechanical, including photocopying, without express written permission of Copley Controls.

CME 2, Copley Virtual Machine, CVM, Xenus, Accelnet, Stepnet, Accelus, and Junus are
registered trademarks of Copley Controls.

Windows 7, Windows 8, and Windows XP are registered trademarks of the Microsoft Corporation.

Document Validity

We reserve the right to modify our products. The information in this document is subject to change
without notice and does not represent a commitment by Copley Controls. Copley Controls
assumes no responsibility for any errors that may appear in this document.


http://www.copleycontrols.com/Motion/pdf/indexer_user_guide.pdf
http://www.copleycontrols.com/Motion/pdf/ASCII_ProgrammersGuide.pdf
http://www.copleycontrols.com/Motion/pdf/Camming_User_Guide.pdf
http://www.copleycontrols.com/Motion/pdf/Parameter_Dictionary.pdf
http://www.copleycontrols.com/Motion/pdf/encoder-guide.pdf
http://www.copleycontrols.com/Motion/Products/Software/index.html

Product Warnings

Observe all relevant state, regional and local safety regulations when installing and using Copley
Controls amplifiers. For safety and to assure compliance with documented system data, only
Copley Controls should perform repairs to amplifiers.

Hazardous voltages.
Exercise caution when installing and adjusting Copley amplifiers.

Risk of electric shock.

DANGER

On some Copley Controls amplifiers, high-voltage circuits are connected to mains
power. Refer to hardware documentation.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-enables the PWM
output stage without operator intervention. In this case, motion may re-start
unexpectedly. Configure faults as latched unless a specific situation calls for non-
latched behavior. When using non-latched faults, be sure to safeguard against
unexpected motion.

Latching an output does not eliminate the risk of unexpected motion with non-
latched faults.

Associating a fault with a latched, custom-configured output does not latch the fault
itself. After the cause of a non-latched fault is corrected, the amplifier re-enables
without operator intervention. In this case, motion may re-start unexpectedly.

For more information, See Faults.

When operating the amplifier as a CAN or EtherCAT node, the use of CME 2 or ASCII
serial commands may affect operations in progress. Using such commands to initiate
motion may cause network operations to suspend.

Operation may restart unexpectedly when the commanded motion is stopped.
Use equipment as described.

Operate amplifiers within the specifications provided in the relevant hardware manual
or data sheet.

FAILURE TO HEED THESE WARNINGS CAN CAUSE EQUIPMENT DAMAGE,
INJURY, OR DEATH.
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1.1: Host Computer Requirements

Computer and Operating System
Minimal hardware requirements:

e CPU:1GHz

e RAM:1GB

Operating Systems Supported: Windows XP, Windows 7 and Windows 8.

Default File Locations

The default location for CME 2 data files (ccx, ccm, etc.) is determined by the Operating System.
Windows XP:

C:\Program Files\Copley Motion\CME 2

Windows 7 and Windows 8
C:\Users\Public\Documents\Copley Motion\CME 2

Serial Communications
e Standard RS-232 serial port or a USB-t0-RS-232 adapter.
e Serial communication cable. See data sheet for part numbers.

CAN Communications
e CAN card. The following CAN card manufacturers are supported:
Copley Controls CAN PCI card (CAN-PCI-02)
Kvaser
IXXAT
CANopen network cable (see data sheet for part number and wiring instructions).

EtherCAT Communications
e Ethernet adapter dedicated to the EtherCAT network.
o EtherCAT network cable, (see data sheet for wiring instructions).

Copley Controls 10



1.2:
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Overview

Setup and Tuning

Java based CME 2 configuration software is powerful and intuitive. Comprehensive diagnostics,
auto-tuning and advanced oscilloscope tools simplify system commissioning. Auto-phasing
eliminates time consuming rewire-and-try for encoder/Halls/motor connections. CME 2
automatically compensates for crossed wires eliminating the most common cause of startup
headaches.

Indexing

Point-and-click to define up to 32 indexes or index sequences. Simply select the index/sequence
and command GO. Index sequences can include motion, parameter changes, dwell times and 1/0O
control. Any parameter can be assigned to a register for efficient control by a PLC.

Custom functions can be provided for complex applications. Install the Java "bean" and fill in the
blanks. Copley also provides a flexible OEM programming environment. Copley Virtual Machine
assembler/debugger enables the development of fast, compact control program.

Cam Tables

Camming is an effective way to produce repetitive motion synchronized to an external device. A
pre-defined cam-table of slave positions is typically cycled through by a master encoder connected
to the drive. The drive performs linear interpolation between points to minimize cam-table size.

NOTE: The feature descriptions in this manual may not apply to all Copley Controls amplifiers

under all configurations. Significant differences between amplifier models are noted. See the
relevant hardware manual or data sheet for more information.
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1.3: Servo Operating Modes and Control Loops

Servo Operating Modes and Control Loops

Copley Controls drives use up to three nested control loops - current, velocity, and position - to
control a motor in three associated operating modes. (Stepper drives operated in stepper mode,
function as traditional open position loop stepper drives).

Control Loops Model

In position mode, the amplifier uses all three loops. As shown in the typical system illustrated
below, the position loop drives the nested velocity loop, which drives the nested current loop.

Limits
Target Position Velocity Limited Current Limited PWM
Position Command Command | Velocity Command | Current Command
) : » : 1 [@ — 3. : .
Trajectory . Position : Vt_alqcny - IS Velocity ! 5| CL_Jrrent ! Current : Motor/
Generator Loop Limiter . Loop Limiter Loop Sensors
’—A:tual Position ’_;erived Velocity ’—;ctual Current

In velocity mode, the velocity loop drives the current loop. In current mode, the current loop is
driven directly by external or internal current commands.

Basic Attributes of All Servo Control Loops

Loop Description

Attribute

Command Every loop is given a value to which it will attempt to control. For example, the velocity loop
input receives a velocity command that is the desired motor speed.

Limits Limits are set on each loop to protect the motor and/or mechanical system.

Feedback The nature of servo control loops is that they receive feedback from the device they are
controlling. For example, the position loop uses the actual motor position as feedback.

Gains These are constant values that are used in the mathematical equation of the servo loop. The
values of these gains can be adjusted during amplifier setup to improve the loop
performance. Adjusting these values is often referred to as tuning the loop.

Output The loop generates a control signal. This signal can be used as the command signal to
another control loop or the input to a power amplifier.

For more information on using CME 2 to set up and tune control loops, see Control Loops.

Copley Controls 12
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Installation, Startup, and Interface Tour CME 2 User Guide

2.1: Download and Install CME 2 Software

1 Navigate to:
http://www.copleycontrols.com/Motion/Downloads/index.html
Select CME 2 to start the download.

2 Navigate to the folder where CME 2 was downloaded to and extract the contents of
CME2.zip.

3 Run Setup.exe and follow the instructions on the installer screens. We recommend
accepting all default installation values.

Copley Controls 14
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2.2:

CME 2 User Guide Installation, Startup, and Interface Tour

Special Notes for Windows 7 and Windows 8

Installer

When the installer starts, Windows will display a dialog asking for permission to make changes to
your computer. Click the button to allow the installer to continue, and CME 2 will be installed
properly.

Set up CME 2 to run as administrator
On some versions of Windows 7 and Windows 8, CME 2 will have to be set up to run as
administrator to access the communications drivers (serial, CANopen, EtherCAT).

&l Right-click the CME 2 icon on the desktop.

2 Choose Properties from the pop-up menu.

Open
Troubleshoot compatibility
Run with graphics processor »

Open file location
® Run as administrator
Restore previous versions
Send to »

Cut
Copy

Create shortcut
Delete

Rename

Properties
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3 Click the Advanced button on the Properties dialog.

52 CME 2 Properties S (23]
Security I Details | Prewvious Versions
General | Shorteut | Compatibiliy

CME 2

Target type: Application

Target location: CME 2

Target: am Files x86)"\Copley Motion\CME 2\CMEZ exe”
Start in: "C:\Program Files {x86)"Copley Motion\CME 2"

Shortcut key:  Mone

Bun: [Norrnal window ']

Comment:

Open File Location ] ’ Change lcon... l [ Advanced... ]

0K || Cancel Apply

4 Select Run as Administrator. Click OK to close the Advanced Properties dialog, then OK
to close the Properties dialog.

P

Advanced Properties \EI

Choose the advanced properties you want for this shortout.

[#]Run as administrator

;This option allows you to run this shortcutas an - |
administrator, while protecting your computer from |
unautharized activity.

Run in separate memory space

[ OK J [ Cancel
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2.3: Start CME 2

2 If communications were set up
already...

...the CME 2 Main Screen opens. If there are
multiple ports, Copley Neighborhood will be
selected in the tree as shown below:

i

(2} CME2 V7.0 Beta17
File Amplifier Tools Help

S E AW EL

i§ Copley Meighborhood
- BB Virtusl Amplifier
oo BB COM1: H-Axis

Lo COM2: Y-Rxis

Select the desired drive. For instance:
B}, Copley Neighborhood

- K Virtual Amplifier

- K COMA: X-Axis

N R oz v-Axis

Installation, Startup, and Interface Tour

Double-click the CME 2 shortcut icon on the Windows desktop to start CME 2.

If communications were not set up...

...the Communications Wizard will be displayed as
shown below:

L It
2 Communications Wizard ﬁ

Select device:
@ Serial Ports
(71 CAN Network
(71 EtherCAT

P oMexts [ Cancel

e -

In this case, proceed to Communications Wizard

After an amplifier has been selected, the CME 2 Main Screen looks similar to this:

9 CME 2 V7.0 (XE2-230-20 X-Axis) Axis A
File Amplifier Tools Help

Ay B (VB [ E |l <l

-

fo]-o-]fs]

=~} Coepley Neighborhood
BB Virtusl Amplifier
= COMI: Y-Axis
B W CONZ oA

Input / Output

CWM Centrol Program

P L

() Axis B
Axis D
Sine Commutation |F‘.013ry Motor ICANopen over EtherCAT (CoE) Control F12 To Disable

17
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2.4: Communications Wizard

Configure Serial Ports

1 Startthe Communications Wizard

If communications has never been set up, the Communications Wizard will be displayed
automatically when CME 2 starts up.

Otherwise choose Tools-> Communications Wizard

Q Communications Wizard @

Select device:

() CAN Network
(") EtherCAT

[ Mext = l [ Cancel l

Choose Serial Ports and click Next

2 Select serial ports
Select one or more serial ports from the Available Ports list then click Add.

3 Communications Wizard
Select Ports
To add serial ports, select them from the Available Ports list, then press Add.
To remove serial ports, select them from the Selected Ports list, then press Remove.

Available Ports: Selected Ports:

[comz ] com1

< Remove

[<§ad<] { Next> ] [ Cancel

When finished, click Next.

3 Configure serial ports

Copley Controls
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¢ Highlight a port in the Selected Ports list.
¢ Choose a Baud Rate for that port.
e Repeat for each selected port.

3 Communications Wizard =)

Configure Serial Ports

Select one or more serial ports from the list, then select the baud rate.
Selected Ports:

BaudRate: 115200

| <Back | [ Fmish | | cancel

Click Finish to save the settings.
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Configure CANopen Network

1 Start the Communications Wizard

If communications has never been set up, the Communications Wizard will be displayed
automatically when CME 2 starts up.

Otherwise choose Tools=>Communications Wizard

i Y

Q Communications Wizard @

Select device:

() Serial Ports

i) EtherCAT

Mext = ] [ Cancel

Choose CAN Network and click Next

2 Configure CANopen Network

Select the CAN card from the list.
Enter the channel number (0 for single channel CAN cards).
Select the bit rate.

e ™

Q Communications Wizard @

Configure CAN Network

CAN Card: |Copley v
Channel: 0

Bit Rate: . 1Mbit/s v

[ < Back ] i Finish l Cancel ]

Click Finish to save the settings.
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NOTES:

1. The CAN Card list only shows the CAN cards that are supported by CME 2 and are
properly installed on the PC.

2. All amplifiers must be set to the same bit rate (default is 1 Mbit/s).
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Configure EtherCAT Network

1 Startthe Communications Wizard

CME 2 User Guide

If communications has never been set up, the Communications Wizard will be displayed
automatically when CME 2 starts up.

Otherwise choose Tools=>Communications Wizard

Q Cormmunications Wizard

Select device:
(7 Serial Ports
(71 CAM Network
(@) EtherCAT

=

[ Mext= | [ Cancel

Choose EtherCAT and click Next.

2 Select the Network adapter

Select the appropriate Network Adapter.

=

Q Communications Wizard

Network Adapters:
Realtek PCIe FE Family Controller

| <Back || Finsh || Cancel

Click Finish to save the settings.

Copley Controls
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2.5: Connect to an Amplifier

Installation, Startup, and Interface Tour

Choose an amplifier by clicking on its name in the Copley Neighborhood. When there is only one
amplifier, CME 2 will automatically connect on startup.

One serial port:

- -
&) CME2 V7D {%-D‘QD-ID H-Po

File Amplifier Tools Help

ﬁﬁﬁ..ﬁ

EI--- | Copley Neighborhood
E Wirtual Amplifier

O W o A [

CAN network:

r -
£} CME 2 V7.0 (SP2-090-10 Y-Ax

File Amplifier Tools Help

ﬁﬁﬁ..ﬁ

(= | Copley Neighborhood
E Virtual Amplifier
O CANT: X-Axis [
R canz: v-Axis

EtherCAT network:

v -
£ CME 2 V7.0 (XE2-230-20 X-A»

File Amplifier Tools Help

A& AW EE

B ) Copley Neighborhood

23

Multiple serial ports:

r -
i CME 2 V7.0 (XPL-230-40 Y-Ax

File Amplifier Tools Help

ﬁﬁﬂ--f

EI"' | Copley Meighborhood
E Virtual Amplifier
- EE COM1: X-Axis [
W COM2: -xis

Multi-drop: CAN

r -
(G} CME 2 V7.0 (BPL-090-30 unn:

File Amplifier Tools Help

ﬁ@@..ﬁ

(=1 Copley Neighborhood
E Virtual Amplifier
p— [
K Node 1: Y-Axis

K Node 2: Z-Axis
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2.6: Rename an Amplifier

1 Choose Main Menu Amplifier»Rename to open the Rename Amplifier screen.

( Rename Amplifier ﬂ

Enter the new name:

X-axis

2 Enter the new name and click OK to close the screen.
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2.7: CME 2 Interface Tour

Installation, Startup, and Interface Tour

CME 2 features are called out in the diagram below. Screen details vary depending on amplifier
model and mode selection. Details follow in the chapter.

Copley ———
MNeighborhood
Tree

Aois Selection —e

Status Bar —-

Tool Bar

(3 CME 2 V7.0 (XE2-230-20 X-Axis) Asis A
File Amplifier Tools Help

Oy =6 (3 [V EE ] B

Main Menu

IEEE T P

. Copley Meighborhood
Lo KB Virtusl Amplifier

Axis A

Axis B

Axis C

.......................

Input / Cutput

'| ©vM Control Program

.| Configure Filters

i {sion 1 1o - s

Configure Regen Configure Faults

Sine Commutation

|Lir|ear Motor

F12 To Disable

CAMNopen over EtherCAT (CoE) Control

Ilcon

Name

For More Information

Basic Setup

Basic Setup

Control Panel

Control Panel

Auto Phase Motor Phasing
@ Auto Tune Auto Tune all Loops for Linear Motors
.'}_4»: Scope Oscilloscope
rr Error Log Error Log
Log

Amplifier Properties

Save amplifier data to disk

Restore amplifier data from disk

Save amplifier data to flash

Data Management Tools

Bkl pm

Restore amplifier data from flash

25
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" Functional
: Diagram
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Menu Bar
Menu Selection Description For More Information
File Save MACRO File (MACRO amplifiers only.) Saves | Data, Firmware, and Logs
amplifier setup and tuning
parameters in a format that can
be read by Delta Tau controllers.
Save Drive Saves the contents of amplifier
Configuration RAM and all CVM flash to a drive
configuration file.
Save Amplifier Saves contents of amplifier RAM
Data to a file on disk.
Save As->Single For multi-axis drives only: saves
Axis one axis to a file on disk.
Save As>V4.1 Saves amplifier data file in format
Format usable by CME 2 Version 4.1.
Copy Axis For multi-axis drives only: copies
the setting from one axis to
another.
Restore=>Drive Restores contents of a drive
Configuration configuration file to amplifier RAM
and CVM flash.
Restore>Amplifier | Restores contents of an amplifier
Data file from disk to amplifier RAM.
Restore=>Single For multi axis drives only:
Axis restores contents of an amplifier
file to only one axis
Restore>CVM Restores a CVM program from a Copley Indexer 2 Program User
Control Program file to the CVM Flash. Guide.
Restore=>Cam Restores a Cam Table file (.cct). See Copley Camming Users
Tables Guide.
Restore>Gain Restores Gain Scheduling Table Gains Scheduling
Scheduling Table from a file (.ccg).
Exit Closes CME 2.
Amplifier | Basic Setup Opens Basic Setup screen. Basic Setup
Control Panel Opens Control Panel. Control Panel
Auto Phase Opens Auto Phase tool. Motor Phasing
Scope Opens Scope Tool screen. Oscilloscope
Error Log Opens Error Log screen. Error Log
Amplifier Displays basic amplifier
Properties properties.
Network Opens the CAN Configuration Network Configuration
Configuration screen.
Rename Prompts for new amplifier name. Rename an Amplifier
Auto Tune Opens Auto Tune for Linear Servo | Auto Tune all Loops for Linear
Motors. Motors
Gain Scheduling Opens Gain Scheduling screen. Gains Scheduling

Copley Controls
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Installation, Startup, and Interface Tour

Menu Selection Description For More Information
Tools Communications Starts sequence of prompts to set | Communications Wizard
Wizard up communications.
Communications Opens Communications Log. Communications Log
Log
Download Starts prompts to download Firmware Download
Firmware firmware from disk to amplifier.
Download CPLD Starts prompts to download PLD
Program code from disk to amplifier.
Manual Phase Opens Manual Phase tool. Manual Phase
View Scope Files Opens Trace Viewer window. Scope Trace Files
I/0O Line States Opens I/O Line States window,
showing high/low status of the
amplifier’s inputs and outputs.
CME 2 Lock/Unlock | Opens screen for locking and Lock/Unlock CME
unlocking CME 2 functionality.
ASCII Command Opens screen to accept ASCII Copley ASCII Interface
Line format commands.
Help CME 2 User Guide | Opens this manual.
All Documents Opens the Doc folder in the CME 2 installation folder
(typically c://Program Files/Copley Motion/CME 2/Doc).
This folder contains all of the related documents that were installed with
CME 2.
Downloads Web Opens default web browser with pages from Copley Controls’ website.
Page
Software Web Page
View Release Opens latest CME 2 release notes in a text viewer.
Notes
About Displays CME 2 version information.

27
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Functional Diagram

The functional diagram, shown below, provides button-click access to most of the screens
used to configure an amplifier. It also indicates the flow of control from input, across all
active control loops, to motor/feedback. Only those control loop buttons that are
appropriate to the amplifier and operational mode appear on the diagram.

Input Command —m

CME 2 User Guide

Zontrol Loops

Input / Cutput

CWM Control Program

| ¥

Analog Command —'-b| P Loop |—P| V Loop |—b| | Loop |—D| Motor/Feedback |
- ;

..... - o

Configure Filters

| Home | Configure Regen |

Configure Faults

Name Description For More Information
Input/ Opens Input/Output screen. Digital Inputs and Outputs
Output
CVM Opens Copley Virtual Machine screen. Copley Indexer Program User’s
Control Guide.
Program
Input Opens screen for configuring the input command. Command Inputs
Command | Button text varies depending on the selected control
loop input.
Control Each opens a control loop configuration screen. Control Loops
Loops
Motor/ Opens the Motor/Feedback screen. Motor/Feedback
Feedback
Home Configure and test homing. Homing
Configure | Opens Regen Settings screen. Regen Resistor Configuration
Regen
Configure | Opens Fault Configuration screen. Faults
Faults
Configure | Opens Filter Configuration Screen Filters
Filters
Encoder (Stepper amplifier with encoder only.) Opens Encoder | Encoder Correction
Correction | Correction screen.
Detent (Stepper amplifier only). Opens stepper amplifier Detent Compensation Gain
Advanced Tuning screen.
Position (Stepper amplifier with encoder only.) Opens Position | Position Limits (Stepper Amplifier)
Limits Limits screen.

Copley Controls
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CAN Information and Status Bar

CAN Information
The Main screen displays the basic CAN information. The example below shows CAN information:
CAMN Metwork:  Address: 1 State: Pre-operational

The Address field shows the amplifier’s present CAN address. For more information, see Network
Configuration . When the Position Loop Input is set to CAN, the State field shows the state of the
amplifier's CANopen state machine (for more information, see Copley Control's CANopen
Programmer’s Manual).

Status Bar

The status bar describes the present commutation mode, motor type, and amplifier control status
as shown below. It also includes a reminder that pressing the F12 function key while CME 2 is
running disables the amplifier.

|Sine Commutation |R|:utary' Motor |M|:.'-E'Eﬂed
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3.1: Setup Procedure

Warnings and Notes

NOTE: To software disable the amplifier at any time while running CME 2, press function key F12.
Also, the amplifier’'s enable input can be used to disable the amplifier.

DANGER: Hazardous voltages.
Exercise caution when installing and adjusting.

Do not make connections to motor or drive with power applied.

DANGER
Risk of unexpected or uncontrolled motion with CME 2 in CAN mode.

CME 2 can be used while the amplifier is under CAN or EtherCAT control.
However, some extreme changes made with CME 2 could cause unexpected
or uncontrolled motion.

Failure to heed these warnings can cause equipment damage, injury, or
death.

Spinning motor with power off may damage amplifier.

Do not spin motors with power off. Voltages generated by a motor can
damage an amplifier.

Failure to heed this warning can cause equipment damage.
WARNING
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1

OR

OR

Prepare for setup

Understand this procedure’s Warnings and Notes.

Verify that amplifier power is OFF.

Verify wiring and connections.

Make sure motor is securely fastened with no load connected.
Apply power to the amplifier.

For off-line amplifiers apply 24V only.
For DC amplifiers apply AUX HV only.

Start CME 2 and enter Basic Setup parameters

Double-click CME 2 icon on the Windows desktop to start CME 2.

If necessary, Connect to an Amplifier from the list in the Copley Neighborhood tree.

ﬁ If the Basic Setup screen does not appear, click the Basic Setup button.
Choose:
In most cases, click Change Settings to Change Basic Setup

[ Change Settings | Settings.
Then proceed to Step 3 of this Setup Procedure.

To load a .ccx file that was prepared for the amplifier/motor
[ Load ccx File | combination, see Copy Drive Data. Then proceed to Step 13 of
this Setup Procedure..

To complete the setup for a ServoTube motor, click ServoTube

ServoTube Setu
[ ervoiube sewp J Setup and see ServoTube Setup.

Copley Controls

CME 2 User Guide
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3 Enter Motor/Feedback/Brake Stop parameters

|M‘ Click Motor/Feedback to open the Motor/Feedback screen.

To optionally load data from an existing motor data file,
see Load Motor/Feedback/Brake Settings from a File and then skip to
Step 4.

OR

On the Motor tab, modify the appropriate Rotary Motor Parameters or Linear Motor
Parameters

On the Feedback tab, as appropriate for each encoder or resolver, verify the parameters
described in Feedback Parameters, Rotary or Feedback Parameters, Linear

If using a brake, click the Brake/Stop tab to verify Brake/Stop Parameters

4 Use Calculate to set initial gains and limits

Calculate

Click Calculate to have the software calculate and display initial loop gains and limits.
See Calculate.

Load the calculated values into amplifier RAM by clicking OK.

5 Configure digital 1/0

Input / Output

Click Input/Output on the Main screen to open the Input/Output screen.
Verify the 1/O settings described in Digital Inputs and Outputs.

On the Input/Output screen, click Close.

6 Configure the command input

Analog Command ‘ or [ PWM Command ‘ Digital Input | or ’ CAN Caenfiguration

or[
Click the appropriate button to configure the amplifier's command input.

For more information see Command Inputs.

NOTE: If the amplifier is to run CVM programs or in Camming mode see the relevant
documents.

After setting command input parameters, Click Close.
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v

10

11

12

Configure faults

Configure Faults

Click Configure Faults to open the Fault Configuration screen and set latching faults as
needed. See Faults.

Click OK to close the Fault Configuration screen.

Configure an optional regen resistor

Regen Settings

If the amplifier is equipped with a regen resistor, click Regen Settings to open the Regen
Settings screen. See Configure a Standard Copley Controls Regen Resistor for regen
resistor parameters.

Click OK to close the Regen Settings screen.

Phase and jog the motor

Apply AC or HV power.
[a Phase the motor. See Auto Phase
To verify Auto Phase results, see Manual Phase

Jog/move the motor to verify that the amplifier can drive the motor. See Jog Mode

Tune the control loops

Starting with the Current Loop set up and tune all applicable Control Loops
If you are setting up a linear motor, you can optionally Auto Tune all Loops for Linear
Motors.

Set gains and limits for stepper mode (stepper only)

If tuning a stepper amplifier in stepper mode:

= Set Position Limits in Stepper Mode. See Position Limits (Stepper Amplifier) .
= |f using Encoder Correction, set Encoder Correction
= Tune Detent Compensation Gain

Configure Homing

See Homing
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13 Test with load attached

'm On the CME 2 Main screen, click Save to Flash.
Remove amplifier power.

Attach load.

Reconnect amplifier power.

If necessary, re-tune velocity and position loops.
E:x On the CME 2 Main screen, click Save to Flash.

Eﬂ On the CME 2 Main screen, click Save to Disk (for backup or duplication).

The amplifier tuning procedure is complete.

NOTE: To copy the results of this setup to other amplifiers,
see Drive Configuration or Copy Drive Data
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4.1: Overview

Basic Setup

The Basic Setup Wizard is used to set up the parameters that define the fundamental
characteristics of the system. This is where the motor, feedback, and operating mode are
setup. The setup can be done three different ways: manually change settings, load
settings from a ccx file, or run the ServoTube setup wizard. Each of these methods are

explained in this chapter.

1 ﬁCIick to open the Basic Setup screen.

Motor Feedback:
Load Feedback:
Load Feedback Type:
Multi-mode Port:

Operating Mode:

Basic Setup
Settings
Motor Family: Brushless
Motor Type: Rotary
Commutation: Sinusoidal
Hall Type: Digital
Hall Phase Correction: on
Use Halls for Velocity/Position:  Off
Use Back EMF for Velocity: Off

Primary Incremental
Secondary Absolute A
Rotary

Differential Input

Paosition, Digital Input

[ Change Settings |l Load ccx File H SeryoTube Setup H Cancel

2  Review settings.

3  Choose:

[ Change Settings |

OR Load ccx File ]

OR

[ ServoTube Setup J

Click Change Settings to manually Change Basic Setup Settings.

If you have a .ccx file that was prepared for the amplifier/motor
combination, click Load ccx File and see Data Management Tools.

To change Basic Setup settings for a ServoTube motor, click ServoTube

OR Cancel

37

Setup and see ServoTube Setup.

To accept the displayed settings, click Cancel.
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4.2: Change Basic Setup Settings

CME 2 User Guide

1 changesettings |  OnN the Basic Setup screen, click Change Settings to manually change
all Basic Setup settings. Use the Back and Next buttons to navigate
screens. Screen details vary depending on amplifier model and mode

selection.

2 Set Motor Options

Basic Setup

Motor Options

Mator Family:
@ Brughless Brush I:\}

Motor Type:
@ Rotary Linear

[ <Back || Mext = || Cancel

3 Set Feedback Options

Basic Setup
Feedback Options

Hall Type: |Digital -

/| Hall Phase Correction

Motor Feedback: | Incremental

Load Feedbadk: |Absolute A

Load Feedback Type:

‘@ Rotary Linear

Use Load Feedback In Passive (Monitor) Mode

Input Source:

~ | (@ Primary Secondary

- Primary (@) Secondary

< Back || Next > || Cancel

Copley Controls
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Basic Setup

Setting

Description

Hall Type

Select Hall type: None, Digital, or Analog (Analog is used with Copley Controls
ServoTube motors).

Hall Phase Correction

If selected, will enable error checking between hall sensors and encoder phase
angle.

Motor Encoder

Select type and source of motor feedback.

¢ None: No motor encoder.

e Primary Incremental: Incremental encoder on primary feedback connector.
e Secondary Incremental: Incremental encoder on multi-mode port.
¢ Panasonic Incremental A Format

e SSI

e EnDat

¢ BiSS

e Absolute A

e Tamagawa Absolute A

¢ Panasonic Absolute A Format

e Panasonic Incremental A Format

e Sanyo Denki Absolute A

¢ Analog: Analog encoder on primary feedback connector.

e Low Frequency Analog: Copley ServoTube motor on primary feedback
connector.

¢ Resolver: Resolver (—R) version of a Copley Controls amplifier on primary
feedback connector.

Additional encoder types are supported by certain Copley Controls amplifier
models. See the amplifier data sheet for more information.

Position Encoder

Select type and source of Position (load) feedback.

¢ None: No position encoder

e Primary Incremental: Incremental encoder on primary feedback connector.
e Secondary Incremental: Incremental encoder on multi-mode Port.

¢ Analog: Analog encoder on primary feedback connector.

Position Encoder
Type

Select the type of Position (load) encoder:
e Rotary
e Linear

Use Position Encoder
in Passive (Monitor)
Mode

When this is checked, the position of the position encoder will be reported by the
passive load position variable but it will not be used to control the position of the
axis.

Stepper Drives Only

Motor Encoder Select the encoder type:

e None
e Primary incremental

Run in Servo (Requires encoder.) Amplifier operates as a true, closed loop, servo amplifier controlling
Mode a stepper motor.

Enable Encoder | (Requires encoder) Amplifier runs as a stepper drive; encoder feedback is used to
Correction correct positional errors. See Encoder Correction
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4 Set Operating Mode Options

Basic Setup

Operating Mode:

Operating Mode Options
Position -
Command Seurce: |Digital Input -

Digital Input Source
@ High Speed Inputs
Multi-mode Port
Differential Inputs

< Back || Next > || Cancel

Setting Description

Operating Choose the mode of operation: Current, Velocity, or Position.
Mode See Control Loops

Command Choose the command input source (see Command Inputs):
Source

e Analog Command: Analog voltage provides command input.

¢ PWM command (current and velocity mode only): Digital pulse-width modulated signal
provides command input.

¢ Function Generator: Internal function generator provides command input.

¢ Software Programmed: The amplifier is controlled by software commands from either
the Copley Virtual Machine (CVM) or an external source. See Copley Indexer Program
User’s Guide or the Copley ASCII Interface Programmer’s Guide.

¢ Camming: Runs in Camming Mode. See Copley Camming User Guide.
¢ Digital Input: Command input is provided via the chosen Input Source (below).

¢ CAN: Command input is provided over the CANopen network. See the CANopen
Programmer’s Guide.

Input Source

Choose the input source for PWM or Digital input commands:

¢ Single-ended Inputs: Command input is provided via two of the amplifier's
programmable digital inputs.

¢ Multi-mode Port: Command input is provided via differential inputs on the amplifier’'s
multi-mode port.

¢ Differential Inputs: Command is provided via differential inputs.
e High Speed Inputs. Command is provided via two of the amplifier's high speed inputs.

Copley Controls
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Basic Setup

Set Miscellaneous Options

Basic Setup @
Miscellaneous Options
Commutation Mode:
@) Sinusoidal Trapezoidal Estimated Sinusoidal

Use Back EMF For Velocity

Use Halls for Velocity
Multi-mode Port: | Differential Input -

< Back | [ Finish 1 | Cancel

Setting Description
Commutation Commutation method: Sinusoidal, Trapezoidal, or Estimated Sinusoidal

Use back EMF | If selected, will use the motor’'s measured back EMF to determine motor velocity.

for Velocity Recommended only for medium- to high-speed. Accuracy depends on the accuracy of
the programmed Back EMF value, and may be affected by factors such as cable
resistance.

Use Halls for If selected, will use transitions of the Hall switches to determine motor velocity and

Velocity and position. Recommended only for medium- to high-speed applications (may run roughly

Position at low speeds).

Multi-mode Selects the mode for the amplifier’'s multi-mode port:

Port

¢ Buffered Motor Encoder. The multi-mode port functions as a buffered digital encoder
output based on the digital encoder input.

¢ Emulated Motor Encoder. The multi-mode port functions as an emulated digital
encoder output based on the motor analog encoder or motor resolver.

e Emulated Position Encoder. The multi-mode port functions as an emulated digital
encoder output based on the position analog encoder.

o Differential Input. The multi-mode port functions as a differential command input.

When changes are complete, click Finish.
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4.3: ServoTube Setup

The ServoTube Setup wizard sets up the amplifier for use with the chosen ServoTube motor. After
the last step in the wizard is completed, CME 2 will perform the following actions:

e Performs the Calculate function to set initial gains and limits.

e Sets the appropriate programmable digital input as Motor Over Temperature.
e Sets the proper phasing values.

e Saves all values to flash.

e Opens the Control Panel so the user can Test a move in Jog Mode

1 | seveTubesetp | cjick ServoTube Setup to start the Basic Setup wizard. Use the Back

and Next buttons to move from screen to screen as needed.

2 Choose the appropriate Series and Model. Optionally choose to Invert Motor
Direction. Optionally choose the Additional Encoder Option (available with certain
motor series) and choose the appropriate resolution for the optional encoder
(2 um or 5 um).

rBasic Setup
Motor Options

Series: |STB v

[7] Invert Motor Direction [¥] Additional Encoder Option

@ 1lum 1 5um

[ <§ackJ[ Next > H Cancel J
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Set Operating Mode Options.

Basic Setup
Operating Mode Options
Operating Mode: :Position -
Command Source: :Analog Command -

Digital Input Source
High Speed Inputs
Multi-mede Port

Differential Inputs

[ < Back ]l Next

{ ’ Cancel

Set Miscellaneous Options.

Basic Setup

Miscellaneous Options

Commutation Mode:

@) Sinusoidal Trapezoidal Estimated Sinusoidal

Use Back EMF For Velodity

Use Halls for Velocity and Position

Multi-mode Port: | Differential Input -

[ <Back | [ Fimsh || Cancel |

When changes are complete, click Finish.

To test basic move capabilities, test a move in Jog Mode.

Test with Load attached.

Basic Setup
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5.1: Motor/Feedback Screen Overview

Motor/Feedback - Rotary Motor

Motor | Feedbadcl Brake‘nﬁtop|

Peak Torgue:
19546 | MN'm -

Continuous Torgue:
0.6553| [N'm -

Velocity Limit:
5000 [rpm

Back emf Constant:

14.67 | V/krpm -

Resistance:
2.27 | ohms

Inductance:
5.23 \mH

Manufacturer: Copley Units
{ @ Metric () Engish
Model Number: CBL341FE-001
Maotor Inertia: _ _
0.11975 | kg-cm? -
Torgue Congtant: . .
MNumber of Poles: 4 0.1401 _N'rn,#'.pk v

ﬁ @ m m < Calcuite

Lok |

[ Cancel

Motor/Feedback

Action Name Description
Save motor data to Saves motor/feedback/brake settings from PC to a disk file with
disk .ccm name extension.
Restore motor data Restores contents of a .ccm file from disk to PC.
from disk

Save motor data to

Saves motor/feedback/brake settings from PC to amplifier

iﬁ#ﬁﬂﬁh

¢ Too| Calculate

flash permanent flash memory.

Restore motor data Restores motor/feedback/brake settings from flash memory to
from flash the PC.

Calculate Calculates initial tuning and limit values.
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1 it
it ‘ Click Motor/Feedback to open the Motor/Feedback screen.

- ﬂ Load Motor/Feedback/Brake Settings from a File.
OR
Enter settings manually:

| Motor i
Click the Motor tab to view or change Rotary Motor Parameters or Linear Motor
Parameters

| Feedback |
Click the Feedback tab to view or change Feedback Parameters, Rotary or Feedback
Parameters, Linear.

[ Brakestop|
Click the Brake/Stop tab to view or change Brake/Stop Parameters.

Click Calculate to calculate initial gains and limits.

E:x On the Main screen, click Save to Flash to avoid losing the changes.

Copley Controls 46



CME 2 User Guide Motor/Feedback

52: L

47

oad Motor/Feedback/Brake Settings from a File

1 If needed, download a motor data file from the Copley Controls website:

= |n an internet browser, navigate to
http://www.copleycontrols.com/Motion/Downloads/motorData.html

= Click on the appropriate motor name.

= When prompted, save the file to the MotorData folder in the CME 2 installation
folder..

= Extract the contents of the zip file to the same location.

= The folder should now contain the new motor data file (with a .ccm filename
extension).

2 Load the motor data to the amplifier:

LM‘ Click Motor/Feedback to open the Motor/Feedback screen.

= On the Motor/Feedback screen, click Restore Motor Data from Disk.
When prompted, navigate to the folder containing the file,
then click on the file name, and then click Open.

w3
noo | . e . . . .
. " Galadate Calculate initial gains and limits with.

. E:xOn the Main screen, click Save to Flash to avoid losing the changes.

Copley Controls



Motor/Feedback

CME 2 User Guide

5.3: Rotary Motor Parameters

Setting

Description

Manufacturer

Motor manufacturer’'s name. Saved for reference in the motor data file.

Model Number

Motor model number. Saved for reference in the motor data file.

Units

Selects whether the parameters entered in this screen are in Metric or English units.

Motor Inertia

The rotor inertia of the motor. Used for calculating initial velocity loop tuning values.
Range: 0.00001 to 4,294 kg cm®. Default: 0.00001 kg-cm*

Number of Poles

(Brushless only.) The number of magnetic poles in the motor. Required for correct
commutation of the motor. If the number of poles is not known,
Verify the motor’s pole count using the Data accuracy test.. Range: 2 to 200. Default: 4.

Peak Torque

The peak torque that the motor can produce. Peak Torque divided by torque constant =
motor’s peak current limit. Range: 0.0001 to 2,100 Nm. Default: 0.0001 Nm.

Continuous Torque

The continuous torque that the motor can produce. Used with the torque constant to
calculate continuous current. Range: 0.0001 to 1,000 Nm. Default: 0.0001 Nm.

Velocity Limit

Maximum speed of the motor. Used to calculate the velocity and acceleration limits for the
velocity loop. Range dependent on encoder resolution.

Torque Constant

Relates the motor's input current to torque produced. Sometimes abbreviated as K.
Range: 0.001 to 1,000 Nm/Apk. Default: 0.001 Nm/Apk.

Back emf Constant

Relates the motor's input voltage to speed. Sometimes abbreviated as Ke. Used for
calculating the maximum velocity for a given amplifier bus voltage.
Range: 0.01 to 21,000,000 V/Krpm. Default: 0.01 V/Krpm.

Resistance Motor resistance line-to-line. Used for calculating the initial current loop tuning values.
Range: 0.01 to 327 Q. Default: 0.01 Q.
Inductance Motor inductance line-to-line. Used for calculating the initial current loop tuning values.

Range: see the hardware documentation.

Stepper Amplifiers

Only

Rated Torque

Motor’s rated operating torque. Min: .001. Max: 1000.

Rated Current

Motor’s rated continuous current. Min: 0.001. Max: 1000.

Basic Step Angle

Fundamental stepper motor step, in degrees. Min: 0.225. Max: 22.5. Default 1.8.

Microsteps/Rev

Number of microsteps per revolution of the motor.
Min: 4. Max: 100,000,000. Default 4000.

Full Steps/Rev

This read-only value can be used after entering Basic Step Angle to cross-check against
motor data sheet.

Copley Controls
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Motor/Feedback

5.4: Linear Motor Parameters

Setting

Description

Manufacturer

Motor maker's name. Saved in the motor data file. Choose from list or enter manually.

Model Number

Motor model number. Saved in the motor data file. Choose from list or enter manually.

Units Selects whether the parameters entered in this screen are in Metric or English units.

Mass The mass of the motor. Used for calculating initial velocity loop tuning values.
Range: .0001 Kg to 100,000 Kg. Default: .0001 Kg.

Peak Force The peak force that the motor can produce. Peak Force divided by Force Constant =

motor’s peak current limit. Range: 0.00001 to 2,000 N. Default: 0.00001 N.

Continuous Force

The continuous force that the motor can produce. Used with the force constant to
calculate continuous current. Range: 0.00001 to 1,000 N. Default: 0.00001 N.

Velocity Limit

Maximum speed of the motor. Used to calculate the velocity and acceleration limits for
the velocity loop. Range dependent on encoder resolution.

Force Constant

Relates the motor's input current to force produced. Sometimes abbreviated as Kf.
Range: 0.00001 to 2,000 N/Amp. Default: 0.00001 N/Amp.

Back emf Constant

Relates the motor's input voltage to speed. Sometimes abbreviated as Ke. Used for
calculating maximum velocity for a given amplifier voltage. Range: 0.01 to 1,000
V/IM/Sec. Default: 0.01 V/M/Sec.

Resistance Motor resistance line to line. Used for calculating the initial current loop tuning values.
Range: 0.01 to 327 Q. Default: 0.01 Q.
Inductance Motor inductance line to line. Used for calculating the initial current loop tuning values.

Range: see the hardware documentation.

Magnetic Pole Pair Length

The length of a pair of magnets which equals the distance moved in one electrical cycle
of the motor.

Stepper Amplifiers Only

Rated Force

Motor’s rated operating force. Min .001 N. Max 1000 N.

Rated Current

Motor’s rated continuous current. Min: 0.01 A. Max 1000 A.

Full Step Fundamental stepper motor step distance. Min: 0.0001mm. Max: 5000 mm.
Microsteps/ Number of microsteps per full step. Min: 1. Max: 100,000,000.
Full Step
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5.5: Feedback Parameters, Rotary

Details for serial encoders can be found in the Serial Encoder Guide.

Feedback Type | Parameters/Actions
Incremental In the Motor Encoder lines or Position Encoder lines field, enter the number of encoder lines
(see encoder or motor data sheet). As indicated by the counts field, the number of encoder
counts per revolution is equal to 4 x the number of lines. Enable Encoder Loss Detection
and/or Index Loss detection if desired.
Motor Feedbadk
1000| lines = 4000 counts
Enable Encoder Loss Detection
Enable Index Loss Detection
Analog In Fundamental Lines, enter the number of fundamental encoder lines (see encoder or motor
data sheet). As indicated by the Fundamental Counts field, the number of fundamental
encoder counts per revolution is equal to 4 x the number of Fundamental Lines.
~Motor Feedback
Fundamental Lines: 64 = 256 Fundamental Counts
Interpolation: 14 x|
Interpolated Counts Per Rev: 1024
Optionally modify the encoder resolution by changing the Interpolation value. The
interpolated resolution (Interpolated Counts Per Rev) is the product of Fundamental Counts
value and the Interpolation value.
Resolver Optionally modify the feedback resolution by changing the value in Counts Per Rev. Default:
16384.
Resolver
16384  counts per rev
Halls With amplifier set to Use Halls for Velocity/Position, optionally increase the counts per rev
ratio by incrementing the Halls Count Multiplier.
rMotor Halls — =
Hall Count Multiplier: | 1 v
Counts per Rev.: 24

Copley Controls
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Motor/Feedback

5.6: Feedback Parameters, Linear

Details for serial encoders can be found in the Serial Encoder Guide.

Feedback Type

Parameters/Actions

Incremental Choose units and then enter the Encoder Resolution (see encoder or motor data sheet).
Enable Encoder Loss Detection and/or Index Loss detection if desired.
Motor Feedback
Encoder Resolution: i ymm @um ) nm
[ | Enable Encoder Loss Detection
[] Enable Index Loss Detection
Analog Enter the Fundamental Pitch (distance between encoder lines; see encoder or motor data

sheet). As indicated by the Fundamental Resolution field, Fundamental Pitch divided by four
gives Fundamental Resolution. The interpolated resolution is the dividend of Fundamental
Resolution value/Interpolation value. Optionally modify the Interpolated Resolution by
changing the Interpolation value.

—Motor Feedback
() mm i@ um ) nm
Fundamental Pitch: 40| um = 10 um EE_.’;E J{}EHE"
Interpolation: i -
Interpolated Resolution: 10 um

Low Frequency
Analog

Normally used with ServoTube, Pole Pitch is the distance between poles in a pole pair, as
entered in the Magnetic Pole Pair Length field on the Motor tab. The interpolated resolution is
the dividend of Pole Pitch/Counts per pole value, expressed in micrometers. Optionally
modify the resolution by changing the Counts/Pole value. Click Restore Default to restore
default Counts/Pole.

—Motor Feedback
() mm i@ um ) nm
Fundamental Pitch: 40| um = 10 um EE_.’;E J{}EHE"
Interpolation: i -
Interpolated Resolution: 10 um
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Feedback Notes

Encoder and Resolver Support

Some Copley Controls amplifiers are offered in multiple versions to support different types of
encoder or resolver feedback. Some encoder versions support digital quadrature encoders, some
support analog sin/cos encoders, and others support both. Encoder versions normally require
Halls for the commutation of brushless motors. The resolver versions support standard, single
speed, transmit-type resolvers.

Dual Feedback
Some Copley Controls amplifiers can receive position feedback from sensors on the motor, the
load, or both, through the Primary Feedback channel, a Secondary Feedback channel (multi-mode
port) or both. (Some amplifiers can also operate in certain modes without encoders or resolvers.)
A drive configured with a multi-mode port can:
¢ Provide a buffered digital encoder output based on the digital encoder input.
¢ Provide an emulated digital encoder output based on the analog encoder or resolver input.
¢ Provide a second digital encoder input to be used in the dual encoder position mode. In this
mode, an encoder attached to the load provides position loop feedback, and the motor
encoder or resolver provides velocity loop feedback.
A dual-feedback setup is shown below. The amplifier receives feedback from an incremental motor
encoder through the Primary feedback channel. Position (load) encoder feedback comes through
the multi-mode port. The ratio of motor turns to position encoder turns is 1 to 10.

Motor/Feedback - Rotary Motor
| Motor | Feedback | grake\Stop |
~Motor Encoder
1000 | lines = 4000 counts
[ ] Enable Encoder Loss Detection
[] Enable Index Loss Detectior:
L
Position Encoder -
1000 | lines = 4000 | counts
rRatio
Motor turns: 1
Position turns: 10
N —— s —
ﬁ ﬂ m M S@] Calculate [ OK ] [ Cancel
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5.8: Brake/Stop Parameters

Many control systems employ a brake to hold the axis when the ampilifier is disabled. On brake-
equipped systems, disabling the amplifier by a hardware or software command starts the following
sequence of events.

e The motor begins to decelerate (at Abort Deceleration rate in position mode or Fast Stop
Ramp rate in velocity mode). At the same time, the Brake/Stop Delay Time count begins.
This allows the amplifier to slow the motor before applying the brake.

¢ When response time has passed, the amplifier’s output stages are disabled. This delay
ensures the brake has time to lock in before disabling the power section.

e This feature is not available when the amplifier is configured for current mode. In this
mode, the amplifier output turns off and the brake output activates immediately when the
disable command is received.

-

Motor/Feedback - Rotary Motor @

Motor | Feedbacdk | Brake'Stop

Erable Ingut —_— "l-l"i Brake/Stop delay time
:
1
1
Speed '
Y : BrakesStop activation velocity
:
1
Brake Cuptput '
i
1
i
1
Enahkle - PO clelay s

Powver Section BrakesStop responze time

Brake/Stop delay time: 10| ms
Brake /Stop activation velodity: 6| rpm
PWM delay brake/stop response time: 100 ms

Set Defaults

| Motor Wiring Detection |

m ! Caloulate | oK | | Cancel

Parameter Description

Brake/Stop Delay Time Range of accepted values: 0 to 10,000 mS

Brake Activation Velocity Range of accepted values: 0 to encoder resolution dependent limit rpm (mm/s for linear
motor)

PWM Delay Brake/Stop Range of accepted values: 0 to 10,000 mS

Response Time
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—_—————— Sets the three brake parameters to defaults values, based on the motor data.
Set Defaults
Displays the Motor Wiring Detection screen
I Motor Wiring Detection I play 9

Motor Wiring Detection

On the Plus Family of drives, the amplifier can check for a disconnected motor. Upon enable, the

amplifier will apply current to the motor windings, while keeping the brake engaged for the brake
hold time. If the current vector cannot be applied, then a motor disconnected fault will occur and

the brake will not be released. If the motor is connected, the brake will be released after the brake

hold time expires.

#

Q Motor Wiring Detection

Enable Input

Brake Output

Motor Check Current

Brake Hold Time On Enable:

Motor Check Current:

Set Defaults

i 1
B ———

Brake Hold Time on Enable

0 ms

Close

Parameter

Description

Brake Hold Time on Enable

The time during which the amplifier is enabled, but the brake is engaged and the
current is applied to the motor windings. Units: mS

Motor Check Current

The amount of current to apply to the motor windings. Units: 0.01 A

Set Defaults

Sets the motor wiring detection parameters to zero.

Copley Controls
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Calculate

The Calculate function uses the motor and feedback data to calculate initial gains and limits.
These can be modified to fine-tune the amplifier. Follow the steps below:

1 @J Click Calculate to calculate and display settings.

[ Calculated Amplifier Settings ‘
Current Loop Cp Gain: 3426 e
Current Loop Ci Gain: 571
Peak Current Limit 9.64 A =
Continuous Current Limit 3.85
I2T Time Limit 1000 ms
Current Loop Offset 0 A
Current Ramp: 0 mA/s
Programmed Current: 0 A
Velocity Loop Vp Gain: 3144
Velocity Loop Vi Gain: 699
Velocity Integral Drain: 0
Velocity Loop Velodty Limit: 2250 rpm
Velocity Loop Accel., Decel., Fast Stop: 750 rps?

Velocity Tracking Window: 9375 rpm
Velocity Tracking Time: 100 ms v
Cancel J

2 Verify the peak current limit, continuous current limit, and velocity loop velocity limit.
If one or more of these values seems inappropriate, click Cancel and check: Peak
Torque (or Force), Continuous Torque (or Force), Velocity Limit, and Torque (or Force)
Constant. Correct them if needed. See Rotary Motor Parameters
or Linear Motor Parameters.

If the Motor/Feedback values were correct but the peak current limit, continuous current
limit, or velocity loop velocity limit values are not optimal for the application, change
these limits during the tuning process.

3 Save the values into amplifier RAM by clicking OK.
NOTE: When loading motor data from a file, if the motor wiring configuration in the motor
file does not match the configuration currently stored in the amplifier, CME prompts for

verification on which configuration to use. Select the file configuration by clicking Yes.
The configuration will be tested as part of Motor Phasing.

4 E:H On the Main screen, click Save to Flash to avoid losing the changes.
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6.1: Digital Inputs

Input / O . .
\ peti Ovp |CI|ckInput/Output on the Main screen.

A typical screen is shown below. Options vary with model and configuration.

Red light: inhibited motion or active input depending on input function.
Grey light: motion not inhibited.
No light: not configured.

Lo/Hi: indicated state of input.
,Q Input/Output =] IE

Digital Inputs 1-5 | Digital Inputs 6-12 | Digital Outputs|
Debounce time CAN address
Yy Vv
S e [IN1] | Amp Enable-HI Enables With Clear Faults - 0 ms H =»
© Pullup +5V
 Pull down [IN2] ' not Configured v o ms Hi BITO
[IN3] Not Configured v 0 ms Hi BIT 1
& Pull up +5V [IN4] Not Configured v 0| ms Hi BIT 2
() Pull down 1 -
[IN5] Not Configured v 0/ ms Hi BIT3
A

* Hold position when limit switch is active Restore Defaults Close

Hold position setting. Indicates input is used as a CAN address bit.

Parameter | Description

Pull up +5V | Pulls up the group of inputs up to internal +5 V.

Pull down Pulls the group of inputs down to internal signal ground.
Debounce Specifies how long an input must remain stable at a new state before the amplifier recognizes the
Time state. Increase to prevent multiple triggering caused by switch bounce upon switch closures.

Range: 0 to 10,000 mS.

Debounce does not affect inputs that have been configured as PWM, Pulse and Direction, or
Quadrature control inputs.

IN1- INy Select the function for the input.

57 Copley Controls



Digital Inputs and Outputs CME 2 User Guide

*Hold position Available in position mode only:
when limit switch is | \when one or more inputs are configured as a limit switch (NEG Limit-HI Inhibits, NEG Limit-
active LO Inhibits, POS Limit-HI Inhibits, or POS Limit-LO Inhibits). The *Hold position option

prevents any motion while a limit switch is active. This option uses the Abort Deceleration
rate to stop the motor as described in Trajectory Limits.

CAUTION: If the amplifier is switched back to current or velocity mode with this option
selected, the limit switches will no longer function

Restore Defaults Restores all inputs and outputs to factory defaults.

Copley Controls 58



CME 2 User Guide

Digital Input Functions

Depending on the mode of operation, some inputs may have a predefined function such as enable

Digital Inputs and Outputs

or motor temperature sensor. Typically IN1 is defined as an enable input.

Input Function

Description

AMP Enable-
LO Enables with clear faults

A low input will enable the amplifier.
Any transition will clear latched faults and outputs.

AMP Enable-
HI Enables with clear faults

A High input will enable the ampilifier.
Any transition will clear latched faults and outputs.

AMP Enable-
LO Enables with reset

A low input will enable the amplifier.
A low to High transition will reset the amplifier.

AMP Enable-
HI Enables with reset

A High input will enable the ampilifier.
A High to low transition will reset the amplifier.

AMP Enable-LO Enables

A low input will enable the amplifier.

AMP Enable-HI Enables

A High input will enable the amplifier.

Not Configured

No function assigned to the input.

NEG Limit-HI Inhibits*

A High input will inhibit motion in negative direction.

NEG Limit-LO Inhibits*

A low input will inhibit motion in negative direction.

POS Limit-HI Inhibits*

A High input will inhibit motion in positive direction.

POS Limit-LO Inhibits*

A low input will inhibit motion in positive direction.

Reset on LO-HI Transition

A low to Hi transition of the input will reset the amplifier.

Reset on HI-LO Transition

A High to low transition of the input will reset the amplifier.

Motor Temp HI Disables

A High input will generate a Motor Over Temperature fault.

Motor Temp LO Disables

A low input will generate a Motor Over Temperature fault.

Home Switch Active HI

A High input indicates the home switch is activated.

Home Switch Active LO

A low input indicates the home switch is activated.

Motion Abort Active HI

A High input causes the amplifier to stop motion, using the Abort
Deceleration rate described in Trajectory Limits. The amplifier remains
enabled.

Motion Abort Active LO

A low input causes the amplifier to stop motion, using the Abort
Deceleration rate described in Trajectory Limits. The amplifier remains
enabled.

Hi Res Analog Divide Active HI

A High input causes the firmware to divide the level of the analog input
signal by 8.

Hi Res Analog Divide Active LO

A low input causes the firmware to divide the level of the analog input
signal by 8.

High Speed Position Capture on LO-HI
Transition

Position will be captured on the low to high transition of the input.

High Speed Position Capture on HI-LO
Transition

Position will be captured on the high to low transition of the input.

PWM Sync Input

PWM synchronization input. Synchronizing PWM Switching Frequency.
(For high-speed inputs only.)
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6.2: Digital Outputs

A typical Digital Outputs screen is shown below. Options vary with model and configuration.

Red LED: Qutput is active
Gray LED: Output is inactive

Indicates the state of the output On/Off or HilLo

& Input/Output o] = ==
| Digital Inputs 1-6 | Digital Inputs 7-14| Digital Oututs | Analog 10
[OUT 1]  Fault-Active High - Hi 3
[OUT 2 _NolCOnﬁgu;;d = How
[OUT 3] _Not(‘.mﬁgu;;d = o =
[OUT 4] _NotConﬁgu;;d ) of =
[OUT 5] NotConﬁgu;;_d = - off =
[OUT 6] Brake-Activ; Higk: E .: Hi ™
* Hold position when limit switch is active Restore Defauts | | Close |
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Digital Output Functions

Output Function Description

Not Configured No function. Output remains Hi/Off.

Fault Active Hi/Off Output goes Hi/Off when one or more faults are detected.
Fault-Active Lo/On Output goes Lo/On when one or more faults are detected.
Brake-Active Hi/Off Output goes Hi/Off to activate the brake.

Brake-Active Lo/On Output goes Lo/On to activate the brake.

PWM Sync Output (OUT1 only) The PWM synchronization output.

Custom Event See Custom Event Triggered Output

Custom Trajectory Status See Custom Trajectory Status Triggered Output.

Custom Position Triggered Output See Custom Position Triggered Output.

Program Control Active Hi/Off Output state controlled by CVM or external program.
Program Control Active Lo/On Output state controlled by CVM or external program
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6.3: Custom Event Triggered Output

Digital outputs can be configured for one or more bits in the Event Status (faults, warnings, and

status).

1

[OUT 2] | Custom Event v

Configure Custom

Choose Custom Event for the output configuration, then click Configure Custom to

Lo -

open the Event Triggered Output screen.

m

[] Motor Phasing Error
[] Feedback Error

[ Motor Over Temp
[7] Under Voltage

[T Over Voltage

[ Short Circuit

[] Current Limited

< 1] 3

() Output Active High @) Output Active Low

Event Triggered Output
[] Amplifier Fault o
[] Amp Over Temperature [ Latch Output

[OK] [Cancel]

[ Help }

Select one or more events from the list

. Selections are OR’ed together, so that any

event will cause the output to go active.

The Clear button clears all selections.

Choose Output Active Hi/Off or Output

Copley Controls

Active Lo/On.
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Digital Inputs and Outputs

4 To latch the output, set the Latch Output option.

Latching an output does not eliminate the risk of unexpected
motion with non-latched faults.

Associating a fault with a latched, custom-configured output does
not latch the fault itself. After the cause of a non-latched fault is
corrected, the amplifier re-enables without operator intervention. In

DANGER  this case, motion may re-start unexpectedly.
Failure to heed this warning can cause equipment damage,
injury, or death.
5 Click OK to save changes to amplifier RAM and close the screen

Event

Description

Amplifier Fault

A latched fault is active.

Amp Over Temperature

For descriptions of these fault events, see Faults

Motor Phasing Error

Feedback Error

Motor Over Temperature

Under Voltage

Over Voltage

Short Circuit

Current Limited

The current output is being limited by the 12T Algorithm or a latched current fault
has occurred.

Voltage Limited

Current loop is commanding the full bus voltage in an attempt to control current.
Commonly occurs when the motor is running as fast as the available bus voltage
will allow.

Positive Limit Switch

Axis has contacted positive limit switch.

Negative Limit Switch

Axis has contacted negative limit switch.

Amp Disabled by Hardware

Amplifier enable input(s) is not active.

Amp Disabled by Software

Amplifier is disabled by a software command.

Attempting to Stop Motor

The amplifier, while in velocity or position mode, has been disabled.

In velocity mode, amplifier is using the Fast Stop Ramp described in

Velocity Loop Limits. In position mode, the amplifier is using the Abort Deceleration
rate described in Trajectory Limits.

The output remains active until the amplifier is re-enabled.

Motor Brake Active

Motor brake activated.

PWM Outputs Disabled

The amplifier's PWM outputs are disabled.

Positive Software Limit

Actual position has exceeded the positive software limit setting.
See Homing.

Negative Software Limit

Actual position has exceeded the negative software limit setting.
See Homing

Following Error

Following error has reached programmed fault limit.
See Following Error Faults

Following Warning

Following error has reached programmed warning limit.
See Following Error Faults

Position has Wrapped

The position counters have exceeded the maximum range of
231~ 2%.1 and have wrapped. Normal amplifier operation is not affected.
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Velocity Limited

The velocity command (from analog input, PWM input, or position loop) has
exceeded the velocity limit. See Velocity Loop Limits

Acceleration Limited

In velocity mode, motor has reached an acceleration or deceleration limit that was
set as described in Velocity Loop Limits

Pos Outside of Tracking Window

The following error has exceeded the programmed value.
See Position and Velocity Tracking Windows

Home Switch Active

Axis has contacted the home limit switch.

In Motion

The motor is moving, or it has not yet settled after a move. The amplifier is settled
when it comes within the position tracking window and stays there for the tracking
time at the end of a move. Once this bit is set, it remains set until a new move is
started.

Vel Outside of Tracking Window

Difference between target and actual velocity has exceeded the window. See
Position and Velocity Tracking Windows

Phase not Initialized

Amplifier is using Phase Initialization function and phase is not initialized.

Command Input Fault

PWM or other command signal (e.g., EtherCAT master) not present. If Allow 100%
Output option is enabled by a setting Bit 3 of Digital Input Command Configuration
this fault will not detect a missing PWM command.

Latched vs. Non-Latched Custom Event

An output that is configured for a custom event can be latched or non-latched.

If a non-latched output goes active, it will go inactive as soon as the last of the selected events is
cleared. If a latched output goes active, it remains active until at least one of the following actions

has been taken:

o Reset or power-cycle the amplifier.
e Cycle (disable and then enable) an input that is configured as Enable with Clear Faults or

Enable with Reset.

e Open the Control Panel and press Clear Faults or Reset.

The latched/non-latched behavior of an output configured as a custom event is independent of the
drive’s latched/non-latched fault. Consider the following example:

OUT3 is configured as a custom event: under voltage and latched, but the Under Voltage
fault on the Configure Faults screen is set to non-latched. The table below shows the
difference in behavior between the output and the drive’s fault

Condition

Drive OuUT3

OCCurs

Under voltage condition

Disables PWM outputs, and reports Goes to active state

under voltage faults

corrected

Under voltage condition is

Under voltage fault is not reported and
PWM outputs are enabled

Stays active

Copley Controls
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6.4: Custom Trajectory Status Triggered Output

Digital outputs can be configured for one or more events in the Trajectory Status.

[OUT 2] | Custom Trajectory Status v Hi a

[ Configure Custom ]

Choose Custom Trajectory Status for an output and then click Configure Custom to
open the Trajectory Status Triggered Output screen.

Trajectory Status Triggered Output

[7] Homing Error

[| Referenced (Homed)

[~] Homing In Progress

[7] Move Aborted

[ Trajectory Generator Running

[ Camming Buffer Error

") Output Active High (@ Output Active Low

P oK H Cancel J

2 Select one or more events from the list. Selections are OR’ed together, so that any
event will cause the output to go active.

Status Description

Homing Error Activate output if an error occurred in the last homing attempt.
Referenced (Homed) Activate output if the most recent homing attempt was successful.
Homing in Progress Activate output when a homing move is in progress.

Move Aborted Activate output if move is aborted.

Trajectory Generator Activate output while trajectory generator is generating a move.
Running

Camming Buffer Error | A camming buffer error has occurred.

3 Choose Output Active High to have the output go high when active or Output Active Low
to have the output go low when active.

4 Click OK to save changes to amplifier RAM and close the screen.
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6.5: Custom Position Triggered Output

[OUT 2] | Custom Position Triggered Output - lo =

L Configure Custom J

Choose Custom Position Triggered Output for an output and then click Configure
Custom to open the In Position Triggered Output screen.

Position Triggered Output

Configuration
@ In Position Window
_) Trigger At Position
Trigger Positive Motion
Trigger Negative Motion

Output Active High @ Output Active Low

Upper Position: 0| counts

Lower Position: 0| counts

@ Use Actual Position

*) Use Limited Position
i Cancel
2 Select one of the configurations described below and enter appropriate values for the
parameters.
Configuration | Description and Parameters
In Position Activates the output while the axis is in the window between the programmed Upper
Window and Lower positions.

Trigger at Position | Activates the output for the programmed Time when the axis travels through the
programmed Position.

Trigger Positive Activates the output for the programmed Time when the axis travels in the positive
Motion direction through the programmed Position.

Trigger Negative Activates the output for the programmed Time when the axis travels in the negative
Motion direction through the programmed Position.

3 Choose Output Active High to have the output go high when active or Output Active Low
to have the output go low when active.

4 In stepper mode with no encoder, choose Use Limited Position. Otherwise choose Use
Actual Position.

5 Click OK to save changes to amplifier RAM and close the
Custom Output Configuration screen.
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Synchronizing PWM Switching Frequency

In some situations, such as when sampling small analog signals, it is desirable to synchronize the
PWM switching frequency among multiple amplifiers. In these cases, one amplifier serves as a
master for one or more slave amplifiers. The PWM sync output of the master sends a signal that is
received as a PWM sync input by each slave. To configure this, an output of the master must be
configured as PWM Sync Output and one input on each of the slaves must be configured as PWM
Sync Input.

[OUT 4]  Eiiii Sync Cutput -

[IN4] PWM Sync Input -

Analog I/O

A typical Analog I/O screen is shown below. Currently, only the Xenus Plus single axis drive has
analog /O functionality.

@ Input/Output (ol & || =]

|Digita| Inputs 1-6 | Digital Inputs 7-14 | Digital Outputs | Analog IO\

Analog Motor Temperature Sensor

@) Fault When Above Limit () Fault When Below limit
Limit: 0 mV
Actual Voltage: 4999 mV

Analog Output

Mode: Manual v

Programmed Value: 0imv

[] *Hold position when limit switch is active Restore Defaults ] [ Close }
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Analog Motor Temperature Sensor
Enter a voltage limit in mV. Fault will occur when voltage is above limit. Actual voltage is the
sensor reading in mV.

Analog Motor Temperature Sensor

Limit: 0|/mV

Actual Voltage: mV

Analog Output

The Analog Output has two modes of operation, Manual and Actual Current.

When Manual is chosen the output is set to the programmed value, +/- 5V, entered in mV.

Mode: _Manual v

Programmed Value: 1/ mV

When Actual Current is chosen the output value is proportional to the actual motor current.

Mode: | Actual Current v |

Analog Output Value: 1mVv
Actual Current: 0.01 A
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7.1: Analog Command Settings

Analog Command

| Click the Analog Command button on the Main screen.

@ Analeg Command E (=] @
Scaling: 2,13 A =10V
Dead Band: O my
[ Invert Command
Offset
Offset: 0O my

Parameter

Description

Scaling

Current mode: output current produced by +10 Vdc of input.

Range: 0 to 10,000,000 A. Default: Peak Current value.

Velocity mode: output velocity produced by +10 Vdc of input.

Range: 0 to 100,000 rpm (mm/sec).

Default: Maximum Velocity value.

Position mode: position change (counts or mm) produced by +10 Vdc of input.
Range: 0 to 1,000,000,000 counts.

Default: 1 Revolution of a rotary motor or 1 pole pair distance for a linear motor.
For more information, see Scaling

Dead Band

Sets dead band. Range: -10,000 to 10,000 mV. Default: 0.
For more information, see Dead Band

Invert Command

Inverts polarity of amplifier output with respect to input signal.

Offset

(Current and Velocity modes only.) Used to offset input voltage error in an open loop system. Not
recommended for use when the amplifier is part of a closed loop system.
Range: -10,000 to 10,000 mV. Default: 0. For more information, see Offset
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Analog Command Notes

The amplifier can be driven by an analog voltage signal through the analog command input. The
amplifier converts the signal to a current, velocity, or position command as appropriate for current,
velocity, or position mode operation, respectively. The analog input signal is conditioned by the
scaling, dead band, and offset settings.

Scaling

The magnitude of the command generated by an input signal is proportional to the input signal
voltage. Scaling controls the input-to-command ratio, allowing the use of an optimal command
range for any given input voltage signal range.

For example, in current mode, with default scaling, +10 Vdc of input generates a command equal
to the amplifier's peak current output; +5 Vdc equals half of that.

Scaling could also be useful if, for example, the signal source generates a signal range between 0
and +10 Vdc, but the command range only requires +7.5 Vdc of input. In this case, scaling allows
the amplifier to equate +7.5 Vdc with the amplifier's peak current (in current mode) or maximum
velocity (in velocity mode), increasing the resolution of control.

Dead Band

To protect against unintended response to low-level line noise or interference, the amplifier can be
programmed with a “dead band” to condition the response to the input signal voltage. The amplifier
treats anything within the dead band ranges as zero, and subtracts the dead band value from all
other values. For instance, with a dead band of 100 mV, the amplifier ignores signals between —
100 mV and +100 mV, and treats 101 mV as 1 mV, 200 mV as 100 mV, and so on.

200

100 Dead Band

------------------------

Output
o
<
N

-100

-200

-200 -100 0 100 200
Input
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Offset

To remove the effects of voltage offsets between the controller and the amplifier in open loop
systems, CME 2 provides an Offset parameter and a Measure function. The Measure function
takes 10 readings of the analog input voltage over a period of approximately 200 ms, averages the
readings, and then displays the results. The Offset parameter allows the user to enter a corrective
offset to be applied to the input voltage.

The offset can also set up the amplifier for bi-directional operation from a uni-polar input voltage.
An example of this would be a 0 to +10 Vdc velocity command that had to control 1000 rpm CCW
to 1000 rpm CW. Scale would be set to 2000 rpm for a +10 Vdc input and Offset set to -5V. After
this, a 0 Vdc input command would be interpreted as -5 Vdc, which would produce 1000 rpm CCW
rotation. A +10 Vdc command would be interpreted as +5 Vdc and produce 1000 rpm CW rotation.

Monitoring the Analog Command Voltage
The analog input voltage can be monitored in the Control Panel and in the Scope Tool. The
voltage displayed in both cases is after both offset and deadband have been applied.

Analog Command in Position Mode

The Analog Position command operates as a relative motion command. When the amplifier is
enabled the voltage on the analog input is read. Then any change in the command voltage will
move the axis a relative distance, equal to the change in voltage, from its position when enabled.
To use the analog position command as an absolute position command, the amplifier should be
homed every time it is enabled. The Homing sequence may be initiated by CAN, ASCII serial, or
CVM Indexer program commands.
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7.2: PWM Input Settings

PWM Command | . .
' Click the PWM Command button on the Main screen.
£} PWM Command [ | & =
Scaling: [t0.48 | A at 100% duty cyde
Input Type:
@ 50% Duty Cydle (") 100% Duty Cyde
Options:
[] Invert PWM Input
(] Allow 100% Output
Invert Sign Input

Parameter Description

Scaling Current mode: output current at 100% duty cycle.
Range: 0 to 10,000,000 A. Default: Peak Current value.

Velocity mode: output velocity at 100% duty cycle.
Range: 0 to 100,000 rpm (mm/sec).
Default: Maximum Velocity value.

PWM Input Type One wire 50% or two wire 100% with direction.

Options Invert PWM input: Inverts the PWM logic.

Allow 100% output: Overrides the 100% command safety measure.
See Failsafe Protection from 0 or 100% Duty Cycle Commands

Invert Sign Input: In 100% duty cycle mode, inverts the polarity of the directional input.
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50% Duty Cycle (One-Wire)
The input takes a PWM waveform of fixed frequency and variable duty cycle. As shown below, a
50% duty cycle produces zero output from the amplifier. Increasing the duty cycle toward 100%
commands a positive output, and decreasing the duty cycle toward zero commands a negative
output.

—~-g——  Decreasing Duty Cycle Increasing Duty Cycle

e IUUUUTT

50 % Duty Cycle

Amplifier Output O rrrrresasaasaasaasaaaasaasaaaaas

Max -

The command can be inverted so that increased duty cycle commands negative output and vice
versa.

100% Duty Cycle (Two-Wire)

One input takes a PWM waveform of fixed frequency and variable duty cycle, and the other input
takes a DC level that controls the polarity of the output. A 0% duty cycle creates a zero command,
and a 100% duty cycle creates a maximum command level. The command can be inverted so that
increasing the duty cycle decreases the output and vice versa.

100% 100%
Duty Cycle Duty Cycle

o NI

Direction Input

Amplifier Output

Failsafe Protection from 0 or 100% Duty Cycle Commands

In both formats, the amplifier can be programmed to interpret O or 100% duty cycle as a zero
command, providing a measure of safety in case of controller failure or cable break.
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7.3: Digital Position Input Settings

Digital Input

I Click the Digital Input button on the Main Screen.

2 Digital Input
71;1put Coniﬁgﬁf

Control Input:

() Pulse Up / Pulse Down

) Quadrature
Stepping Resolution
1| InputPulses =

[7] Invert Command

o] &=

Increment Position on:
@ Rising Edge

Falling Edge

1! Output Counts

Close

Parameter

Description

Control Input

Pulse and Direction: One input takes a series of pulses as motion step commands, and
another input takes a high or low signal as a direction command.

Pulse Up / Pulse Down: One input takes each pulse as a positive step command, and
another takes each pulse as a negative step command.

Quadrature: A/B quadrature commands from a master encoder (via two inputs) provide
velocity and direction commands.

Increment position on

Rising Edge: Increment position on the rising edge of the input pulse.
Falling Edge: Increment position on the falling edge of the input pulse.

Stepping Resolution

Input Pulses: Number of Input Pulses required to produce output counts.
Range: 1 to 32,767. Default: 1.

Output Counts: Number of Output Counts per given number of input pulses.
Range: 1 to 32,767. Default: 1.

Invert Command

When selected, inverts commanded direction.

Pulse Smoothing

In digital position mode, the amplifier’s trajectory generator can be used to create trapezoidal
profiles, with programmed acceleration, deceleration and velocity, from a simple pulse train or
burst of pulses. To bypass the trajectory generator while in digital or analog position modes, set
the maximum acceleration to zero. The only limits in effect will now be the velocity loop velocity
limit and the current limits. (Note that leaving the maximum acceleration set to zero will prevent
other position modes from operating correctly.)
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Pulse and Direction

In pulse and direction format, one input takes a series of pulses as motion step commands, and
another input takes a high or low signal as a direction command, as shown below.

Pulse Input J_ﬂ_ﬂ_ﬂ ML

Direction Input =~ m——————— e - - - m - m - - m - - - - - m - - -

Velocity /
Command # = = = = o - - - . - e, - - - e - - .- - /7

The amplifier can be set to increment position on the rising or falling edge of the signal. Stepping
resolution can be programmed for electronic gearing.

Count Up/Count Down

In the count up/count down format, one input takes each pulse as a positive step command, and
another takes each pulse as a negative step command, as shown below.

Up Input J_|_|_|_|_H
Down Input M

Velocity /
Command = = = = = = & & & & & = & o, —, e - - - - - - -= - /7

The amplifier can be set to increment position on the rising or falling edge of the signal. Stepping
resolution can be programmed for electronic gearing.

Quadrature

In quadrature format, A/B quadrature commands from a master encoder provide velocity and
direction commands, as shown below.
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Alnput

B Input

Velocity /
Command =———--dGD == =@ = - - . - - —,.—_— - e = - - - - 7___

The ratio can be programmed for electronic gearing.
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7.4: Software Programmed Input Settings

CME 2 User Guide

These settings can be saved to flash to allow default conditions to be set and used when the
amplifier is powered up or reset.

Programmed Position

Programmed Position . . .
Click the Programmed Position button on the Main screen.
€8] Programmed Command = IE |ﬁ|
Move: Type:
@ Relative @ Trap
(") Absolute (*) S Curve
Distance: 0 | counts
Setting Description
Move Relative or Absolute.
Type Trap or S-Curve.
Distance Move distance (relative) or location (absolute)
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Programmed Velocity

Pr med Veloci , . .
i =2 ] Click the Programmed Velocity button on the Main screen.
) Programmed Command =] (3]
Programmed Velocity: 0| rpm

Close

Potential for unexpected movement.

If the Programmed Velocity is set to values other than 0, the motor
will move after power-up or reset if the amplifier is hardware
enabled.

DANGER Failure to heed this warning can cause equipment damage,
injury, or death.

Setting Description
Programmed Velocity Move velocity. Units: rpm (rotary) or mm/s (linear).

Programmed Current

Pr med C . .
otk U=t | Click the Programmed Current button on the Main screen.

Q Programmed Command | o IEI l&l
Programmed Current: 0lA
Current Ramp: 0/ mA/s

Close

Potential for unexpected movement.

If the Programmed Current is set to values other than 0, the motor
will move after power-up or reset if the amplifier is hardware
enabled.

DANGER Failure to heed this warning can cause equipment damage,
injury, or death.
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Setting

Description

Programmed Current

Current applied during the constant velocity portion of the move. Units: A.

Current Ramp

Acceleration/deceleration current. Units: mA/s.
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8.1: CANopen Network

A CANopen network can support up to 127 nodes. Each node must have a unique and valid
seven-bit address (Node ID) in the range of 1-127. (Address 0 should only be used when the
amplifier is serving as a CME 2 serial port multi-drop gateway.)

1 Verify that the CAN network has been cabled and terminated as per amplifier documents.

CAN Configuration

Click CAN Configuration to open the CAN Configuration screen. (If CAN is
not the Position Loop Input, choose Amplifier=>Network Configuration instead.)

CAN Configuration
Network Type: Input Mapping
() DeviceNet
Number of Inputs: |0
Bit Rate: | 1Mbit/s v
Bit 0: |None Switch
Address Configuration
Bit 1: |None Switch
[¥] Use Switch
= Bit 2: |None Switch
|| Use Inputs
[~ Use Programmed Value L toae ot
Bit 4: | None
Switch Value:
Input Lines Value: b Hooe
Bit 6: |None
Sgve & Reset { Save & Close ] [ Cancel ] [ Help [

3 Choose network type (CAN or DeviceNet). This is optional for some drives.

4 Choose a Bit Rate and choose any combination of address sources (Switch, Inputs, and
Programmed Value). The address is the sum of the values from these sources.

5 For each source selected, perform the additional steps described below.

Source Additional Steps

Use Switch Verify the S1 switch setting. (Assigns values for Bit 0 — Bit 3 of CAN address.)
Use Inputs Enter Number of Inputs, then choose inputs to represent each CAN address bit.
Use Programmed Value | Enter the Programmed Value.
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6 Click Save & Reset to save changes to amplifier flash, close the screen, and reset the

amplifier. Click Save & Close to save changes to amplifier flash without resetting.
NOTE: Address and bit rate changes take effect only after power-up or reset.
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MACRO Network

A Delta Tau PMAC card can hold up to four MACRO IC'’s, each of which is a master on a MACRO
ring. Each master IC can address 16 stations (nodes, slaves), enabling the addressing of up to 64
devices on a ring. Of these, 32 can be motion devices such as Xenus XML. A node address is an
8-bit value with bits 7-4 addressing the master IC and bits 3-0 addressing the slave.

XML switch S1 is set to select the master IC to which the Xenus will be linked. The four possible
values for this setting are 0,1,2, and 3.

As a MACRO station or node the XML has eight available addresses as a motion control device.
These are 0,1,4,5,8,9,12, & 13.

1  Verify the S1 and S2 switch settings.

Select Amplifier->Network Configuration from the CME 2 Main Screen to open the MACRO
Configuration screen as shown in the following example.

MACRO Configuration
Master Address: 0
Slave Address: 0

Scaling Input Command: 15000| A

Heart Beat Time Out: 0| ms

Home Status Bit:
~) Use Motor Encoder Index

@ Use Home Input

Auxiliary Data Registers
First: Digital Input v

Second: :Analog Input v

[ ] Enable Position Output Scaling
[ ] Active Network Required for Amp to Enable

[] Enable MACRO Network Synchronization

Current Loop Frequency: 16 | kHz
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Parameter Description

Scaling Input Command | Current mode: output current produced by +10 Vdc of input.
Range: 0 to 10,000,000 A. Default: Peak Current value.

Velocity mode: output velocity produced by +10 Vdc of input.

Range: 0 to 100,000 rpm (mm/sec).
Default: Maximum Velocity value.

Heart Beat Time Out The frequency at which the drive will produce heartbeat messages. This parameter
may be set to zero to disable heartbeat production.

Home Status Bit Use Motor Encoder index: Return the primary encoder index state in the home
status bit of the MACRO status word.

Use Home Input: The state of any general purpose input configured as a home
input will be returned in the home status bit of the MACRO status word.

Auxiliary Data Registers | Defines what type of additional data is transmitted in the Auxiliary data registers of
every MACRO response message.

First Register: Digital input Value, Secondary Analog Input Value.
Second Register: Analog Input, Motor Encoder, Position Encoder.

Enable Position Output When selected, position data sent over the MACRO network is shifted up 5 bits to
Scaling be compatible with Delta-Tau controllers.

Enable MACRO Network | Allows the drive’s PWM frequency to be adjusted to allow synchronous operation
Synchronization with the MACRO ring. Note that changing the PWM Frequency will affect the

Current Loop Frequency current loop tuning. Therefore, current loop tuning will need to be checked.

Active Network Required | If selected, drive will not enable if network is not active.
for Amp to Enable
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EtherCAT Network

An EtherCAT network enables high-speed control of multiple axes while maintaining tight
synchronization of clocks in the nodes. Data protocol is CANopen over EtherCAT (CoE) based on
DSP-402 for motion control devices.

Stations on EtherCAT are automatically addressed by their bus location. The first drive on the
network is station address -1. The second is -2, and so on.

As an alternate to the default addressing, switches S1 and S2 may be used to program a station
alias. The default address and station alias are always available. If the switch-based station alias is
used, it is the responsibility of the user to ensure that each drive has a unique station alias.

EtherCAT Address (Station Alias)

1 View the S1 and S2 switch settings on the drive.

2 Verify the S1 and S2 switch settings select Amplifier->Network Configuration from the CME 2

Main Screen to open the EtherCAT Settings screen as shown in the following example.

= —

2 EtherCAT Settings @

S1: 0
S2: 1
Resulting Address: 1
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9.1: Overview

Latched vs Non-latched Faults

When a fault is configured to be latched, the fault can only be cleared after the fault has
been corrected and at least one of the following actions has been taken:

o Power-cycle the amplifier

e Cycle (disable and then enable) an input that is configured as
Enable with Clear Faults or Enable with Reset

e Open the Control Panel and press Clear Faults or Reset
e Clear the fault over the CANopen network or serial bus

A non-latched fault will be cleared when the fault condition has been removed. This can
occur without operator intervention.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-
enables the PWM output stage without operator intervention. In this
case, motion may re-start unexpectedly. Configure faults as latched

DANGER unless a specific situation calls for non-latched behavior. When using
non-latched faults, be sure to safeguard against unexpected motion.
Failure to heed this warning can cause equipment damage,
injury, or death.

Example

The drive’s temperature reaches the fault level. The drive reports the fault and disables the
PWM output. Then, the drive temperature falls below the fault level.

Non-latched fault operation:

The fault is cleared and the amplifier's PWM outputs are enabled without operator
intervention.

Latched fault operation:

The fault remains active and the drive’s PWM outputs remain disabled until the faults are
cleared as described above.
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nfiaur= =4 | Click the Configure Faults button on the Main screen.

Fault Configuration
-Latch Fault
[¥] Short Circuit

[7] Amp Over Temperature
[¥] Motor Over Temp

[] Over Voltage

[7] Under Voltage

[] Feedback Error

[] Motor Phasing Error

[¥] Following Error

[7] Command Input Fault

~Optional Faults

[OK] [Cancel] [Help]
2 Select the faults to latch. See Fault Descriptions.
3 Click OK to close screen and save changes to amplifier RAM.

4 E:x On the Main screen, click Save to Flash to avoid losing the changes.
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9.2: Fault Descriptions

Note: The list of faults may vary with amplifier model.

CME 2 User Guide

Fault Description

Fault Occurs When...

Fault is Corrected When...

*Amp Over Temperature

Amplifier's internal temperature exceeds
specified temperature.

Amplifier's internal temperature falls
below specified temperature.

Motor Phasing Error

Encoder-based phase angle does not agree
with Hall switch states. This fault can occur
only with brushless motors set up using
sinusoidal commutation. It does not occur
with resolver feedback or with Halls
correction turned off.

Encoder-based phase angle agrees
with Hall switch states. See
Troubleshoot Manual Phase w/
Encoder and Halls

*Feedback error

Over current condition detected on output of
the internal +5 Vdc supply used to power the
feedback.

Resolver or analog encoder not connected or
levels out of tolerance.

Differential signals from incremental encoder
not connected.

Encoder power returns to specified
voltage range.

Feedback signals stay within specified
levels.

Differential signals connected.

*Motor Over Temp

Motor over-temperature switch changes
state to indicate an over-temperature
condition.

Temperature switch changes back to
normal operating state.

Under Voltage

Bus voltage falls below specified voltage
limit.

Bus voltage returns to specified
voltage range.

Over Voltage

Bus voltage exceeds specified voltage limit.

Bus voltage returns to specified
voltage range.

*Following Error

User set following error threshold exceeded.

See Following Error Fault Details

*Short Circuit Detected

Output to output, output to ground, internal
PWM bridge fault.

Short circuit has been removed.

Command Input Lost

PWM or other command signal not present.

Command signal restored.

Over Current (Latched)

Output current I°T limit has been exceeded.

Amplifier is reset and re-enabled.

Motor Wiring Disconnected

The drive detects that it cannot push current
through the motor windings

The motor is reconnected.

*Latched by default.
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10.1: Auto Phase

The examples in this chapter show particular amplifier operating modes and motor feedback
configurations. Some screens and choices may vary from those described here.

Auto Phase Example: Servo Amplifier

NOTE: The following steps show Auto Phase with a brushless rotary motor, digital Halls, and an
incremental quadrature encoder. Screens vary for other configurations.

1 Verify that the Enable Input is not activated and that HV or AC power is applied.

2 E’] Click Auto Phase to open the Auto Phase wizard.

Q Auto Phase @
Motor Direction Setup

Move the motor in the direction that you want
to be positive. Press Next when done.

Motor Actual Position: 0 counts
[ Release Brake ] [ Next> i { Skip > ] [ Cancel ]
3 Move the motor in the direction to be considered positive

OR
If you cannot move the motor, click Skip (you will confirm motor direction later).

NOTE: If an output is configured as a brake you can temporarily release the brake by
holding down the Release Brake button. The brake will be reactivated when you
release the button.

4 Click Next to go to the Motor Wiring Setup step:
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Q Auto Phase
Motor Wiring Setup Commanded Motor Phase Angle
The software will now micro step the motor. 120 20 80
Make sure the motor is free to move. 150 20

Press Start when ready.

180 0
Auto Phase Current: 0.41 A 210 \ 330

240 o 200
[
Increment Rate: 90 | elecdeg/s
Motor Actual Position: -2 counts
P Strt | [ stp |
Ready
< Back e Cancel

5 Activate the Enable Input.

6 Click Start to begin the motor wiring setup.
The message area displays messages: Configuring Initial Settings, Microstepping, Test
Complete, Motor Wiring has been configured.

During microstepping, a current vector is applied to the motor windings and
microstepped through an electrical cycle at a set rate, causing the motor to move.

If you chose to Skip the motor direction setup step, Auto Phase will prompt for
confirmation of correct motor direction.

If the step fails see Troubleshooting the Auto Phase Problems

NOTE: If incorrect values were entered for inductance and resistance, the calculated Cp
and Ci values may produce current loop oscillation, evidenced by an audible high
frequency squeal during auto phasing.

7 Click Next to go to the Phase Count Test step.

-
2 Auto Phase @
Phase Count Test Commanded Motor Phase Angle
The software will now micro step the motorin 150 20 &
the negative direciton. Make sure the motor is
free to move. Press Start when ready. 150 30
180 / 0
Auto Phase Current: 1.03 A 210 330
240 270 200
Increment Rate: 90 elec deg/s
Actual Motor Position: -
Stop 1 counts
-Configuration Settings Ready
counts per rev 131072
| Poles 8} < Back ] l Skip > ] | Cancel
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10

11
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Click Start to begin the Phase Count Test. Observe status messages. See the prompt:

o
Phase Counts

@f Observe motor motion and verify that it
: ~ moves 1 full turn before any gearing.

When you are ready to observe motion, click OK.
When motion is complete the prompt will be displayed:

F
Phase Counts

‘O' Did motor move 1 full turn?

If motor did not turn 1 full turn, click No and see Phase count test.

If motor turned 1 full turn, click Yes.

For a resolver (—R) version of a Copley Controls amplifier, skip to Step 12.

For a non-resolver amplifier, click Next to open the Hall Wiring Setup screen.

Commanded Motor Phase Angle

Hall Wiring Setup & Hall State

The software will now micro step the motor.
Make sure the motor is free to move. ™ [ |
Press Start when ready. 120 60

Wi =0 [l

Auto Phase Current: 103 A
240 300
Increment Rate: 90 | elecdeg/s [ =
| swo | Hall States
u v w
Hall Offset: 0 deg - .
Ready Hi Lo Lo

Q Auto Phase

Click Start to begin the Halls wiring setup. The message area displays the messages:

Microstepping. Test Complete. Motor has been properly phased.

During microstepping, a current vector is applied to the motor windings and
microstepped through an electrical cycle at a set rate, causing the motor to move. As

the motor moves the Hall lines are decoded for proper commutation.

Copley Controls
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If the step fails, see Halls wiring setup.

12 For a resolver (-R) version of a Copley Controls amplifier, click Next to open the
Resolver Phase Angle Setup screen.
(2 Auto Phase @

Feedback Phase Angle Setup

Feedback angle in red. Commanded
The software will now micro step the motor. motor phase angle in black.
Make sure the motor is free to move.
Press Start when ready.

120 60

Auto Phase Current: 2,06 A 150 2

240 300
Feedback Offset 0 deg
Feedback Angle 56 deg Ready
Motor Actual Position: 8426513 counts
< Back Finis Cancel

13 Click Start to start the resolver phase angle setup. The message area displays status
messages.

14 Click Finish to close the screen and save values to flash memory
OR to close the screen without saving changes, click Cancel.

15 If the Auto Phase algorithm does not produce desired results, try adjusting the Auto
Phase Current and Increment Rate values, using the guidelines in
Tips for Auto Phase Current and Increment Rate.

16 If desired results are not obtained, or to confirm results, proceed to Manual Phase
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Auto Phase Example: Stepper Amplifier, No Encoder

CME 2 User Guide

1 Verify that the Enable Input is not activated and that HV power is applied.

2 E’] Click Auto Phase to open the Auto Phase Motor Direction Setup screen.
e =
Q Auto Phase
Motor Direction Setup
Make sure the motor is free to move. Move motor and observe direction.
Motor direction can be changed by clicking Invert Motor output check box.
Velocity 100 | rpm Ready
Acceleration 17 | rps?
Deceleration 17 | rps2
[TNEG] ......... e
[} Invert Motor Qutput
3 Hold down Move POS to move the motor in the direction considered positive, and
observe the direction of movement.
If the motor does not move see Troubleshooting the Auto Phase Problems
4 If the motor moved opposite the direction that you wish to program as positive, click

Invert Motor Output.

5 Click OK to save the direction setting.
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Motor Phasing

Auto Phase Example: Stepper Amplifier with Encoder, in Stepper Mode

1 Verify that the Enable Input is not activated and that HV power is applied.

2 E’] Click Auto Phase to open the Auto Phase Motor Direction Setup screen.

Q Auto Phase

Motor Direction Setup

Move the motor in the direction that you want
to be positive. Press Next when done.

Motor Actual Position: 0 counts

[ Release Brake ] [ Next> { Skip > ] [ Cancel ]

Activate the Enable Input.

Move the motor in the direction you wish to be considered positive.

Click Next to open the Auto Phase Motor Wiring Setup screen.

Q Auto Phase
Motor Wiring Setup

The software will now micro step the motor.
Make sure the motor is free to move.
Press Start when ready.

Auto Phase Current: 0.41| A

Increment Rate: 90 | elec deg/s

(S [sme )

Commanded Motor Phase Angle

Motor Actual Position:

Ready

-2 counts

Cancel

6 Click Start to begin motor wiring setup with default values.
After successful motor wiring setup, the message “Test Complete” appears.

7 Click Finish to close the screen and save values to flash memory.
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Auto Phase Example: Stepper Amplifier with Encoder, in Servo Mode

1 Verify that the Enable Input is not activated and that HV power is applied.

2 E Click Auto Phase to open the Auto Phase Motor Direction Setup screen.
Q Auto Phase @

Motor Direction Setup

Move the motor in the direction that you want
to be positive. Press Next when done.

Motor Actual Position: 0 counts
[ Release Brake ] [ Next> [ Skip > ] I Cancel ]
3 Move the motor in the direction you wish to be considered positive.

4 Activate the Enable Input.

Click Next to open the Auto Phase Motor Wiring Setup screen.

2 Auto Phase @
Motor Wiring Setup Commanded Motor Phase Angle
The software will now micro step the motor. 120 ¥ e
Make sure the motor is free to move. 150 20

Press Start when ready.

180 0
Auto Phase Current: 0.41 A 210 \ 330

240 . 200
&1
Increment Rate: 90 | elecdegfs
Motor Actual Position: -2 counts
P start | [ stop |
Ready
< Back lext Cancel

6 Click Start to begin the motor wiring setup.
The message area displays messages: Configuring Initial Settings, Microstepping, Test
Complete, Motor Wiring has been configured.

During microstepping, a current vector is applied to the motor windings and
microstepped through an electrical cycle at a set rate, causing the motor to move.

If you chose to Skip the motor direction setup step, Auto Phase will prompt for
confirmation of correct motor direction.
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If the step fails, see Troubleshooting the Auto Phase Problems

NOTE: If incorrect values were entered for inductance and resistance, the calculated Cp
and Ci values may produce current loop oscillation, evidenced by an audible high

frequency squeal during auto phasing.

7 Click Next to open the Auto Phase Count Test screen.
Q Auto Phase @
Phase Count Test Commanded Motor Phase Angle
The software will now micro step the motor in 155 B e
the negative direciton. Make sure the motor is . i
free to move. Press Start when ready. 1 3
180 / 0
Auto Phase Current: 1.03 A 210 330
240 270 200
Increment Rate: 90 |elec deg/s
Actual Motor Position: -1 counts
~Configuration Settings Ready
counts per rev 131072
EE [ o [ 50> |
8 Click Start to begin the Phase Count Test. Observe status messages. See the prompt:
( )
Phase Counts
Observe motor motion and verify that it
moves 1 full turn before any gearing.

9 When you are ready to observe motion, click OK. See the prompt:

( Phase Counts

‘O' Did motor move 1 full turn?

10 Click Next to open the Auto Phase Motor Phase Initialize screen:
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e ™

(2 Auto Phase
Motor Phase Initialize

The amplifier will perform phase intialization. Make sure the
motor is free to move. Press Initialize Phase when ready.

i Initialize Phase |

n

Finish Cancel

11 Click Initialize Phase to start phase initialization. If successful, this message appears:
“Test Complete. Phasing has been initialized.”

12 Click Finish to close the screen and save values to flash memory.
13 After clicking Finish, the following message appears if changes were made:
g )
Motor Data Changed

“0" New configuration will be saved to amplifier flash.

Hall Configuration has changed.
Data file should be saved again.

14 Click OK.

Tips for Auto Phase Current and Increment Rate

e [f friction is high, more current may be required to move the load.

¢ High static friction may require more current to overcome stiction.

e Transition from static friction to dynamic friction, and back, may produce jerky motion.
o A faster increment rate will operate in the dynamic friction range.

o A slower rate will operate in the static friction range.

¢ If the friction is low, as in the case of air bearings, low frequency oscillations may occur;
thus, less current and slower rates may be required. If oscillations persist, then friction may
need to be temporarily added.
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Troubleshooting the Auto Phase Problems

Motor direction setup

If motor direction setup step failed:
e Check Encoder or resolver power and signals.
o Verify that the encoder is differential. (Contact factory if encoder is single-ended.)
e Check shielding for proper grounding.

Motor wiring setup
If motor wiring setup step failed:
o Verify that amplifier is disabled.
Check for mechanical jamming.
Check for smooth motion with no mechanical jerking.
Check for good connections to the motor power wires.
Disconnect motor power wires and measure for proper motor resistance.

Phase count test
If phase count test failed:
o Verify that in the Motor/Feedback screen the following parameters have been set correctly:
¢ Number of Poles for rotary motors. Verify the motor’s pole count with the Data accuracy
test.
e Magnetic Pole Pair Length for linear motors.
Encoder Lines or Fundamental Lines for rotary encoders.
e Encoder Resolution for linear encoders.

Halls wiring setup

If Halls wiring setup step failed:
e Check Halls power and signals.
e Check for smooth motion with no mechanical jerking.
e Check shielding for proper grounding.

If the auto phase procedure fails despite these corrective measures, see Manual Phase
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10.4: Manual Phase

Remove load from the motor.

On the Main screen, choose Tools>Manual Phase to open the window:
Manual Phase

~Configuration r~Monitor
No Faults

-Feedback———————————
i Motor Phase Angle Black

Feedback Angle in Red

Offset 0 deg
Feedback- T 120 60
-Motor Feedback [
Angle 0 deg 120 0
| Invert Input
240 300
Motor Phase Angle: Odeg

~Motor

= Position: 0 ts
| Invert Output oxn o

Actual Current:  U:  -0.03A V: -0.01A W: 0.04A

~Control

Increment Rate: 90| elec deg/s Set Zero Position

= 0.38
Current: A Move Motor

) Enable ©) Disable

(o) (o]
@ Enable (7) Disable

................

Verify the Current setting before enabling the drive.

Move Motor
[ Rev H Fwd J

To control the current vector rotation, command the motor forward or reverse.

NOTE: Some motors have bearings stiction, so helping the motor with mechanical force
is acceptable. Motors with no friction may need friction added to steady motion.

If the motor cannot keep up with the rate of vector rotation, then reduce the Increment
Rate or increase the Current.

Verify that pressing forward button moves motor forward.
If the motor moves in the wrong direction, toggle the Motor Invert Output setting.

Verify actual position count agrees with direction of rotation: increasing counts in
forward direction and decreasing counts in reverse direction. If it does not, toggle the
Motor Feedback Invert Input box setting.

If the motor has no Halls, skip to Phase Initialization for Motor without Halls.
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9 Monitor the vector rotation through one electrical cycle for proper Hall transitions:

= Verify that the red indicator rotates in the same direction as the motor phase angle,
and that the transition occurs when the needle is between indicators (+30 degrees, as
shown below).

Wotor Phase &ngle & Hall Siat=

I %4

120 B0
[ REN ”~

240 300

= |f the needle and Hall states do not track properly, use the Hall Wiring list box and/or

Invert Input options (shown below) to swap the amplifier's Hall wire configuration.
~Halls— .

Invert Input:
Clu v Cw
Hall Wiring: |UVW ~

Hall Offset:

= |f the red indicator transition leads or lags behind the centered needle by more than
30 degrees, then try adjusting the Hall Offset in +/- 30 degree increments:

Hall Offset: 0 deg

10  Phasing of a motor with encoder and Halls is complete. Click OK.

Phase Initialization for Motor without Halls
The Phase Initialization is designed to phase a motor with no Halls.

Halls are strongly recommended for safe, redundant system.

Copley strongly recommends the use of Halls or a commutating
encoder for commutation to provide a safe, redundant system. If the
application requires otherwise, the customer accepts responsibility for

DANGER verifying system performance and reliability.

Failure to heed these warnings can cause equipment damage,
injury, or death.

The Phase Initialization function uses as little motion as possible (less than 1/3 of one electrical
cycle) to determine phasing. Phase Initialization drives the motor in open loop current mode, using
microstepping of a current vector.

1 Ensure that the motor is free to move (for instance, make sure the brake is OFF).
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2 Ensure that no external force, such as gravity, will cause the motor to move. If it is not
practical to eliminate such forces, it may be necessary to use the Forced Phase feature
later in this procedure.

3 [ Initialize Phase

To phase a motor with an encoder and no Halls, click Initialize Phase.

Observe the status messages under Monitor.

4 If the message “Phase Initialized” appears, the phasing of a motor with encoder and no
Halls is complete. Click OK to close the Manual Phase window.

5 Phase Initialize
Time: 400 mS
Current: 0lA

(Current set to 0 uses IPeak)
["] Forced Phase

[7] Increment Phase 90 deg

If the phasing function fails (for instance, message “Phase
Initialized” is not displayed, or if a phasing fault is
indicated) adjust the phase initialization settings described
below and try Step 4 (Initialize Phase) again.

[7] Use Offset Initialize Phase

Setting Description

Time Used first as a delay, allowing amplifier to ramp up current to drive a small move.
Then used as a settling time. If the value is too low, the settling may not occur in
time, possibly resulting in jerky motion. Default: 400 ms.

Current Use to overcome stiction when rotating current vector. If the current is too large,

motion may not settle; a low value may not provide enough current to drive a move.

Forced Phase

When selected, Forced Phase causes the Phase Initialization function to apply
Phase Init Current to alternate pairs of motor wires using the Phase Init Time.
Forced Phasing has been used to overcome various phasing problems, including
situations where gravity introduces unwanted motion. Forced Phasing tends to
produce more jerk and apparent motion.

Increment Phase 90
deg

If set, the amplifier will increase the starting phase angle by 90 degrees after every
failed initialization attempt.

Use Offset

If set, the amplifier uses the Hall Offset value as the initialization starting angle.

Manual Phase Example: Motor with Resolver

1 Make sure that no load is connected to the motor.

2 On the Main screen, choose Tools>Manual Phase to open the window:
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Manual Phase

Verify the Current setting before enabling the drive

Move Motor
[ Rev H Fwd ]

~Configuration ~Monitor
ek No Faults
-Resolver
Motor Phase Angle Black
Feedback Angle in Red
Offset, 90 deg
Resolver - 120 60

-Motor Feedback 18 0

Angle 180 deg

|V Invert Input

240 300
Motor Phase Angle:  274deg

~Motor

] Invert Output Position: -2121  counts

Actual Current:  U: 0A W 0A wW: 0A
Control
Increment Rate: 90 elec deg/s Set Zero Position
Current: 041 A Move Motor
) Enable ©) Disable Re Fwd
Restore Defaults oK
' Disable

Motor Phasing

To control the current vector rotation, command the motor forward or reverse.

NOTE: Some motors have bearings stiction, so helping the motor with mechanical force
is acceptable. Motors with no friction may need friction added to steady motion.

If the motor cannot keep up with the rate of vector rotation, then reduce the Increment

Rate or increase the Current.

Verify that pressing forward button moves motor forward. If it does not, toggle the Motor

Invert Output box setting.

Verify actual position count agrees with direction of rotation: increasing counts in
forward direction and decreasing counts in reverse direction. If it does not, toggle the

Motor Feedback Invert Input box setting.
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7 Adjust Resolver Offset configuration as required, testing Fwd and Rev, to produce
alignment of Motor Phase Angle with Resolver Angle as shown here.

Molor Phase Angle Black
Feedback Angle in Red

120 60
180 fe——J3

290 300

Note: Motor manufacturers typically align the resolver in 30 degree increments, typically
by applying current through a pair of motor power wires.
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Troubleshoot Manual Phase w/ Encoder and Halls

To perform trapezoidal commutation after power-up or reset, the amplifier must receive good Hall
signals. After the first Hall transition is detected, then sinusoidal commutation can be performed. In
sinusoidal commutation, the amplifier uses the encoder for commutation while monitoring the Halls
to verify proper phase. If the error between the encoder count and Hall transition is too large, then
the Hall phase correction will not be performed and a phase fault will be triggered.

Test for phase fault problems in the order shown below.

Data accuracy test
1. Verify the motor’s pole count:
o Apply a current vector at zero Increment Rate to lock motor in position.
e Turn the motor shaft and count the number of distinct locking positions.
e Calculate the number of poles: Poles = number of locking positions * 2
2. Verify the encoder line count OR a linear motor's magnetic pair length and the encoder
resolution.

Encoder wiring test
If the Halls produce good trapezoidal commutation but a phase fault is persistent in sinusoidal
commutation mode, the encoder is highly suspect:

o Verify the differential encoder signals.

o Verify proper twisted shielded cable with good grounding.

¢ Disable the amplifier and move the motor manually to test for phase fault.

L)

If phase fault only occurs under command of current, make sure the motor power cable is
not bundled with the encoder cable.

Hall signals test

If the Halls signals are suspected to be faulty:
o Make sure Halls change states as the motor moves through one electrical cycle.
e Some Hall signals are noisy and require filtering. Check with motor manufacturer.
e Some Halls are not properly calibrated to the motor manufacturer’s specification.

Hall transition test

If the location of the Hall transition is not within +/-30 degrees:
e Adjust Hall offset in smaller increments.
¢ Verify Hall alignment.
e Make sure motion is smooth.
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11.1: Current Loop Setup and Tuning

Control Loops

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be
calculated with Calculate.

| Loop

Click | Loop to open the Current Loop screen:

Q Current Loop

Commanded
Current + ¢

—

Peak Current Limit:

1T Time Limit:

Continuous Current Limit:

Current Loop Offset:

s

o]l = =]
p| Input - Current
! Fiters Limiter
b Commanded
i ‘Voltage
™ cp+Ci
Actual Current
13.95 | A Cp: 1038
1000 | ms Cit 55
4,65 | A
Drive Output
ola (@) Maximize Smoothness

(71 Maximize Speed

[7] Enable Bus Clamping

[ Auto Tune ] [ Bandwidth ]

Close
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Parameter Description

Peak Current Limit Used to limit the peak phase current to the motor. Max value depends upon the
amplifier model; Min value > continuous limit.

I°T Time Limit Sets I°T Time Limit in ms. See 12T Limit Algorithm.

Continuous Current Limit Used to limit the Phase Current. Max Value is < Peak Current and depends upon
the amplifier model. Min value: 0

Current Loop Offset Sets current loop offset. Leave it set to zero until after tuning. For more
information, see Offset

Cp Current loop proportional gain. Range 0 — 32,767.

Ci Current loop integral gain. Range 0 — 32,767.

Drive Output Maximize Smoothness: Amplifier uses circular vector limiting to produce smooth

operation even into the voltage limits.

Maximize Speed: Allows for slightly more of the bus voltage to be used when in
the voltage limit. This may produce a small disturbance at top speed.

Enable Bus Clamping
Auto Tune See Current Loop Auto Tune

Bandwidth Measure bandwidth using the Cp and Ci values now in the amplifier.
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1

2

4

111

Manually tune the Current Loop
Apply square-wave excitation to the current loop and adjust current loop proportional
gain (Cp) and current loop integral gain (Ci) to obtain a desired waveform.

[ Trace Status: Trace Canceled - Ready To Start New Trace

NOTE:
1. During tuning, observe any warnings or faults that appear in the status bar of the
scope.
2. Some users prefer the Auto Tune feature. See Current Loop Auto Tune (p. 121).

Click the Scope Tool.

Apply To: Current v
- Choose Current from the Function Generator Apply To:
list.

Auto SR O the Settings tab, make sure Auto Setup is selected.
Auto Setup automatically sets the following parameters:

Function Generator Tab

Parameter Description

Function Square Wave.

Amplitude 10% of continuous current value.
Frequency 100 Hz.

Settings Tab

Channel 1 Commanded current (green).
Channel 2 Actual current (white).

Amplitude: 0.47 A

Verify that the Amplitude value is not excessive for the motor.
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S ls't‘;'tl Click Start.
6 Current

Cp: 2897

Ci 285|

On the Gains tab, adjust current loop proportional gain (Cp):

= Set current loop integral gain (Ci) to zero.
= Raise or lower Cp to obtain desired step response. (Typically, little or no overshoot

with a 100 Hz, low-current square wave.) If the Cp value is too large, ringing may occur.

If the Cp value is too low, bandwidth decreases.
7 Adjust current loop integral gain (Ci) until desired settling time is obtained.

8 [ s |press Stop to stop the function generator.

9 ":H On the Main screen, click Save to Flash to avoid losing the changes.
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11.2: Current Loop Auto Tune

The current loop Auto Tune algorithm applies a square-wave command to the current loop and
adjusts current loop proportional gain (Cp) and current loop integral gain (Ci) until a desirable
waveform is obtained.

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be
calculated with Calculate.

L e
I Click | Loop to open the Current Loop screen:
Current
Offset
Corgmanc{ed + - : C?_rrecting
urren - _/_ +| » Com ;vls(a: :Jl orque
I Actual
Current
Peak Current Limit: 18 A Cp: 293
1T Time Limit: 1067|ms g
Continuous Current Limit: 409 A Drive Output
@ Maximize Smoothness
Current Loop Offset: \ 0/A () Maximize Speed
| AuoTene | | Bandwidth |

2 Verify that the amplifier is hardware enabled.

3

Click Auto Tune to open screen and start the Current Loop Auto Tune.
Tele =

Auto Tune Current: A
Status: Auto Tune in progress.

Cp: 10 Ci 0 [ Start J [ Stop ] Edose ;

4 To Change the Auto Tune Current, Press Stop, enter the new current in the Auto Tune
Current field, and then press Start.
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5 Observe the Auto Tune process and results. A typical example:

= Sets Cp and Ci to zero and then adjusts Cp and Ci for optimal values.
e [E=RE )

Auto Tune Current: [ 1A
Status: Auto Tune in progress.

.1 G 0 st | TSR] [ Gose |

= _Uses a frequency sweep to determine the small signal, current loop bandwidth.
@ Auto Tune (=l ® ==

T

| 1]

Auto Tune Current: [ 1|a : 2
) Status: Measuring Bandwidth

e 33 G 252 Start [ stn | . CQose |

= Displays the results: a set of Cp and Ci alternatives, and the bandwidth measured
using the high Cp and Ci values.
Auto Tune Results (223

@ Auto Tune has determined new values for Cp and Ci along with

L | J high bandwidth measurement. Select desired settings.

(O Hgh  cp 335 i 252 Bandwidth: 2600 Hz
@ Medium Cp: 201 G 151
Olow  ¢p 134 @ 101
(O Original - ¢ 293 @ 199

@) Save Cp and Ci to Flash
() Keep Cp and Ci in RAM only
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6 Choose an action based on Auto Tune results.

= Choose which set of values to save: High, Medium, Low, or Original.

The Medium values, selected by default, are appropriate for most applications.
= Optionally choose how to save: Save Cp and Ci to Flash

or Keep Cp and Ci in amplifier RAM only.

7 Click OK to save the values as chosen, and close the Auto Tune Results window.
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Notes on the Current Mode and Current Loop

Current Loop Diagram

As shown below, the “front end” of the current loop is a limiting stage. The limiting stage accepts a
current command, applies limits, and passes a limited current command to the summing junction.
The summing junction takes the commanded current, subtracts the actual current (represented by
the feedback signal), and produces an error signal. This error signal is then processed using the
integral and proportional gains to produce a command. This command is then applied to the
amplifier's power stage.

Current Loop PWM

—I|> Current Integral Gain (Ci) | + | Command
o L " :
Current Command—{ Current Limiter | Limited Current ,@—4 Current Proportional Gain (Cp) @_ '
+
A

Current Offset ——| f\_

—

Limits: Feedback (Actual Current)
* Peak Current

* Continuous Current

¢ Peak Current Limit Time

Current Loop Inputs
e The amplifier's analog or PWM inputs.
¢ A CANopen network via the amplifier’'s CAN interface.
e A Copley Virtual Motion (CVM) control program.
e The amplifier's internal function generator.
In velocity or position modes, the current command is generated by the velocity loop.

Offset

The current loop offset is intended for use in applications where there is a constant force applied
to, or required of, the servomotor and the system must control this force. Typical applications
would be a vertical axis holding against gravity, or web tensioning. This offset value is summed
with the current command before the limiting stage.

Limits
The current command is limited based on the following parameters:
Limiter Description

Peak Current Limit Maximum current that can be generated by the amplifier for a short duration of time. This
value cannot exceed the peak current rating of the amplifier.

Continuous Current | Maximum current that can be constantly generated by the amplifier.
Limit
I°T Time Limit Maximum amount of time that the peak current can be applied to the motor before it must be
reduced to the continuous limit or generate a fault.

For more details, see 12T Time Limit Algorithm .

Note: Although the current limits set by the user may exceed the amplifier's internal limits, the
amplifier operates using both sets of limits in parallel, and therefore will not exceed its own
internal limits regardless of the values programmed.

Ramp Rate of change in current command. Used to limit jog moves initiated from the Control Panel
Jog function in current mode, and in advanced Indexer Program functions.
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Current Loop Gains

Gain Description
Cp - Current loop The current error (the difference between the actual and the limited commanded current) is
proportional multiplied by this value. The primary effect of this gain is to increase bandwidth (or

decrease the step-response time) as the gain is increased.

Ci - Current loop integral | The integral of the current error is multiplied by this value. Integral gain reduces the current
error to zero over time. It controls the DC accuracy of the loop, or the flatness of the top of

a square wave signal. The error integral is the accumulated sum of the current error value

over time.

Current Loop Output
The output of the current loop is a command that sets the duty cycle of the PWM output stage of
the amplifier.
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Initial velocity loop proportional gain (Vp) and velocity loop integral gain (Vi) values can be
calculated with Calculate

Min value: 0.

V Leop . . . . .
Click the V Loop button on the Main screen (contents vary with model and configuration):
@Velocity Loocp EI = @
Commanded . .
Velocit Velocity & Accel, Input
Umiter | ’ | Filter —‘
s 3 Commanded
{ \ Gai o Current
> e . Be B R
+‘
vp
+ . - ,
— ) ViDrain — P> Vi
* Actual Velocity
Vel, Limit: 46875 | rpm Accel, Limit: 15625 | rps? Vp: 15865|
_ | Low Gains Shift
Decel, Limit: 15625 | IPs*® Vi 3526
Fast Stop Ramp: 15625 | rps? Vi Drain: 1]
Disable Gains
Tracking Viff: 0
Window: 9375 | rpm
Time: 100 ms
Close
Parameter Description
Velocity Limit Top speed limit. Max value may depend upon the back EMF & the Encoder value.

Acceleration Limit

Maximum acceleration rate. Max value may depend upon load, inertia, & peak
current. Min value: 1. (Does not apply in position mode.)

Deceleration Limit

Maximum deceleration rate. Max value may depend upon load, inertia, & peak
current. Min value: 1. (Does not apply in position mode.)

Tracking Window

Tracking Time

See Position and Velocity Tracking Windows

Vp

Velocity loop proportional gain. Range: 0 to 32,767.

Vi

Velocity loop integral gain. Range: 0 to 32,767.

Fast Stop Ramp

Deceleration rate used by the velocity loop when the amplifier is hardware
disabled. Range: 0 to 100,000,000. Default: velocity loop Decel. Limit value.

Low Gains Shift

Increases the resolution of the units used to express Vp and Vi, providing more
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precise tuning. For more information, see Velocity Gains Shift

Hi Gains Shift Decreases the resolution of the units used to express Vp and Vi, providing more
precise tuning. For more information, see Velocity Gains Shift

Vi Drain (integral Vi drain modifies the effect of velocity loop integral gain. The higher the Vi Drain

bleed) value, the faster the integral sum is lowered. Range: 0 to 32,000. Default: 0.

Vcff Velocity loop command feed forward. The input command to the velocity loop (after
limiting) is scaled by this value and added to the output of the velocity loop.

119 Copley Controls



Control Loops CME 2 User Guide

Manually Tune the Velocity Loop

Apply square-wave excitation to velocity loop and adjust proportional gain (Vp) and
integral gain (Vi) to obtain desired waveform. For instance:

Trace Status: Trace Canceled - Ready To Start New Trace

1 3
Click the Scope Tool.
4 Apcly To: . |liglacky ¥ | Choose Velocity from the Function Generator Apply To:
list.
3 Auto S2P. o the Settings tab, make sure Auto Setup is selected.
Auto Setup automatically sets the following parameters:
Function Generator Tab
Function Square Wave.
Amplitude 10% of maximum velocity value.
Frequency 5 Hz.
Settings Tab
Channel 1 Limited velocity (green).
Channel 2 Actual Motor Velocity (white).
4 S :
il 200 ™™ \/erify that Amplitude value is not excessive for the motor.

S Click Start.

6 On the Gains tab, adjust velocity loop proportional gain (Vp):

= Set velocity loop integral gain (Vi) to zero.
= Raise or lower proportional gain (Vp) to obtain desired step response. (Typically,
little or no overshoot on a 5 Hz small, slow-speed square wave.)

7 Adjust velocity loop integral gain (Vi) until desired settling time is obtained.
8 Press Stop to stop the function generator.

E:H On the Main screen, click Save to Flash to avoid losing the changes.
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Notes on the Velocity Mode and Velocity Loop

Velocity Loop Diagram

As shown below, the velocity loop limiting stage accepts a velocity command, applies limits, and
passes a limited velocity command to the input filter. The filter then passes a velocity command to
the summing junction. The summing junction subtracts the actual velocity, represented by the
feedback signal, and produces an error signal. (The velocity loop feedback signal is always from
the motor feedback device even when an additional encoder is attached to the load.) The error
signal is then processed using the integral and proportional gains to produce a current command.
Programmable digital filters are provided on both the input and output command signals.

Velocity Loop

Velocity Integral Gain (Vi
Velocity Limited ty 9 (Vi | +
D X o _
Command ™| Velocity Limiter - ey Velocity Z —|  Velocity Proportional Gain (Vp) | Z Filter »gz”emd
+ mman

1 I

Limits: |
* Velocity
+ Acceleration* Feedback (Derived Velocity)
* Deceleration*
* Emergency Stop Deceleration*
*Not used w hen velocity loop is controlled by position loop. See "Velocity Loop Limits" for details.

Inputs
In velocity mode, the velocity command comes from one of the following:
o The amplifier's analog or PWM inputs.
o A CANopen network via the amplifier’'s CAN interface.
e A Copley Virtual Motion (CVM) control program.
e The amplifier’s internal function generator.
In position mode, the velocity command is generated by the position loop.

Velocity Loop Limits

The velocity command is limited based on the following set of parameters designed to protect the
motor and/or the mechanical system.

Limiter Description

Velocity Limit | Sets the maximum velocity command input to the velocity loop.

Acceleration Limits the maximum acceleration rate of the commanded velocity input to the velocity loop.

Limit This limit is used in velocity mode only. In position mode, the trajectory generator handles
acceleration limiting.

Deceleration Limits the maximum deceleration rate of the commanded velocity input to the velocity loop.

Limit This limit is used in velocity mode only. In position mode, the trajectory generator handles
deceleration limiting.
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Fast Stop
Ramp

Specifies the deceleration rate used by the velocity loop when the amplifier is hardware
disabled. (Fast stop ramp is not used when amplifier is software disabled.) If the brake
output is active, the fast stop ramp is used to decelerate the motor before applying the
brake.

Note that Fast Stop Ramp is used only in velocity mode. In position mode, the trajectory
generator handles controlled stopping of the motor. There is one exception: if a non-latched
following error occurs in position mode, then the amplifier drops into velocity mode and the
Fast Stop Ramp is used.
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Diagram: Effects of Limits on Velocity Command
The following diagram illustrates the effects of the velocity loop limits.

Limited Velocity

Commanded Velocity x

velLimit- — — 4 -

I I - \

Accel Limit = f=— [==— Decel Limit =

Velocity Loop Gains

The velocity loop uses these gains:
Gain Description
Vp - The velocity error (the difference between the actual and the limited commanded velocity) is
Velocity loop multiplied by this gain. The primary effect of this gain is to increase bandwidth (or decrease
proportional the step-response time) as the gain is increased.
Vi - The integral of the velocity error is multiplied by this value. Integral gain reduces the velocity
Velocity loop | error to zero over time. It controls the DC accuracy of the loop, or the flatness of the top of a
integral square wave signal. The error integral is the accumulated sum of the velocity error value

over time.

Velocity Gains Shift

The Velocity Gains Shift feature adjusts the resolution of the units used to express Vp and Vi,
providing more precise tuning. If the non-scaled value of Vp or Vi is 64 or less, the Low Gains Shift
option is available to increase the gains adjustment resolution. (Such low values are likely to be
called for when tuning a linear motor with an encoder resolution finer than a micrometer.) If the
non-scaled value of Vp or Viis 24001 or higher, the High Gains Shift option is available to
decrease the gains adjustment resolution.

Velocity Loop Filters
See Standard Filter Types

Velocity Loop Outputs
The output of the velocity loop is a current command used as the input to the current loop.

Proper Tracking Over Time

As described earlier, position error is the difference between the limited position output of the
trajectory generator and the actual position. Velocity error is the difference between commanded
and actual velocity.

When the position or velocity error exceeds the programmed tracking window value, a status word
bit is set. The bit is not reset until the error remains within the tracking window for the programmed
tracking time.
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Velocity Tracking lllustration
The following diagram illustrates the use of tracking window and time settings in velocity mode.

Actual Velocity
Limited Velocity \

+ Tracking Window

/ | ~ Tracking |
= Time

Tracking Window
Output
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11.6: Position Loop Setup and Tuning

Control Loops

Initial position loop proportional gain (Pp), velocity feed forward (Vff), and acceleration feed
forward (Aff) values can be calculated with Calculate

P Locop

Click the P Loop button on the Main screen.

2} Position Loop

Trajectory Values | Position Loop Values

Profile Acceleration

Profile Velocity

Limited Position

Pp: 1000

Following Error

Fault:

Warning:

[ Disable Fault

+

_[_ Commanded

— " r
._: Frs \elocity
J Muttiplier

A

I"\’ Actual Position
Fi: 0 Aff: 0 Gains Multiplier: 1
Pi Drain: i ViR | 16384
100%: VT = 16384
Pd: 0
[] Enable PID
Tracking Pogition Wrap

4000 | counts Window: 1000 | counts
2000 | counts Time: 10| ms

Close
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Parameter Description

Aff Acceleration feed forward. Range: 0 to 32,767. See Trajectory Limits

Vit Velocity feed forward. Range: 0 to 32,767. 100% Vff: 16,384.
Trajectory Limits

Pp Position loop proportional gain. Range: 0 to 32,767. See Trajectory Limits

Gains Multiplier

Position loop output is multiplied by this value before going to the velocity loop. In dual
encoder systems, the multiplier’s initial value is calculated based on the ratio of motor
encoder turns to position encoder turns.

Following Error
Fault

The level (in encoder counts) at which the following error produces a fault, which stops
the servo loop. We recommend raising the fault level before tuning the loop.
See Following Error Faults

Following Error

The level (in counts) at which the following error produces a warning (without stopping

Warning the loop). See Following Error Warnings
Disable Fault Stops following error from faulting. See Following Error Faults
Tracking Window | Width of tracking window in counts. See Position and Velocity Tracking Windows

Tracking Time

Position must remain in the tracking window for this amount of time to be considered
tracking. See Position and Velocity Tracking Windows

Pi Position loop integral gain
Pd Position loop derivative gain
Pi Drain Position loop integral drain
Enable PID Enables the PID parameters

Click the Position Wrap button.

Motor Position Wrap:

1 revolution of the motor is 4000 counts.

Load Paosition Wrap:

Load positioning not configured.

(=

0 counts

0 | counts

[OK J[Cancel ][ HeIpJ

Change/verify the position wrap parameters as needed. Set both values to zero to
disable position wrapping. Note that the changes do not take effect until OK is pressed.
For more information about this feature, see Position Wrap

Parameter

Description

Motor Position
Wrap

Position at which the actual motor position count returns to zero. In a single feedback
system, it also applies to the actual load position.

Load Position
Wrap

Position at which the actual load position count returns to zero in dual feedback
systems. If the position encoder is set to passive mode, this value applies to the
passive encoder position.
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Click on the Trajectory Values tab:

(¥ Position Loop EI = @
Trajectory Values | Position Loop Values
Profile Velocity
Commanded Position Soiocity 5 Accaiention Profile Acceleration
Limiter =5l
—‘ Limited Position
-
Max Velodty: 23438 | rpm Max Accel.: 78125 | rps?
_ Max Decel.: 7812.5 | rps?
Clear Limits
@ Abort Decel.: 7312.5 | rps?
Set Default Limits
Jerk: 312500 | rps?
Abort Jerk: 312500 | rps?
Close
Parameter Description
Max Velocity Maximum trajectory velocity. Max value may depend upon the back EMF and the Max

feedback count. Min:0. Default: 0.25 x motor velocity limit.

Max Accel Maximum trajectory acceleration. Max value may depend upon the load inertia and
peak current. Min:0. Default: 0.5 x velocity loop Accel. Limit value.

Max Decel Maximum trajectory deceleration. Max value may depend upon the load inertia and
peak current. Min:0 (disables limit). Default: 0.5 x velocity loop Accel. Limit value.

Abort Decel Deceleration rate used by the trajectory generator when motion is aborted. Min:0.
Default: 0.5 x velocity loop Accel. Limit value.

Jerk Rate of change of acceleration. The value of jerk set during the calculate procedure
produces an S-Curve whose maximum slope is equal to the trajectory profile slope.
This value will produce a maximum acceleration that is not more than the initial default
value of acceleration. Small values will produce less jerking but will take longer to
complete move. Large values will produce more jerking and a more trapezoidal profile
but will complete the move faster.

Note that setting limits to zero disables the trajectory generator so that the command input is not limited by
the generator. Velocity is only limited by the Velocity Limit set in the Velocity Loop.
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Manually Tune the Position Loop

Minimize following error and oscillation by running profiles and adjusting position
proportional gain (Pp), velocity feed forward (Vff), acceleration feed forward (Aff) and
other settings. For instance:

¥ Oscilloscope =2 ECR )

File

Tracé Status: Ready
[ s 20

NOTE: During tuning, observe warnings that appear to the left of the trace.

| Click the Scope Tool.

2 ator | Profile

Select the Profile tab.

3 Auto Se1P o the Settings tab, make sure Auto Setup is selected. Auto Setup
automatically sets the following parameters:

Profile Tab

Move Relative

Type Trap

Distance 2000 counts

Reverse and repeat | Not selected

Settings Tab

Channel 1 Profile velocity (green)

Channel 2 Following error (white)
4 :

Distance: 2000 | counts

If the Auto Setup default profile distance is not appropriate,
enter an appropriate short distance.

S Click Start. The Profile Generator executes a short move.
NOTES:
e The profile may not reach constant velocity during a short move.
e |If a following error occurs, open the Control Panel and click Clear Faults.
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6 —

| 0 | |
— : - | Function Generator | Profile |
| settings | Gains | Trajectory Limits | position Params | Velocity Params | Measurement (RS ‘

Maximum Velogity: 1500 | rpm Move: Type:
@ Relative @ Trap
Maximum Acceleration: 500 | rps? ") Absolute ) S Curve
Maximum Deceleration: 500 rps?
Distance: 2000 | counts
and

Set up a trapezoidal profile by setting the trajectory limits and distance. See table:

Trajectory Limits Tab
Maximum Velocity

Maximum
Acceleration Set values typical of those expected to be used in the application.

Maximum
Deceleration

Profile Tab

Distance Set the move distance to produce a complete trajectory profile. Be sure
that this distance does not exceed mechanical limits of the system.

Move Relative
Type Trap

7 Position

Pp: 5000)
Aff: 0
Vff: | 16384

Adjust position proportional gain (Pp) to minimize following error:

e On the Gains tab, set velocity feed forward (Vff) and acceleration feed forward
(Aff) to zero.

¢ On the Profile tab, click Start. On the Gains tab, adjust position loop proportional
gain (Pp) until best result is obtained.

e Click Start after each adjustment to test on a new profile move.

NOTES:

1. Too much position loop proportional gain (Pp) might cause oscillation.

2. If a following error occurs, open the Control Panel and click Clear Faults.

8  Adjust velocity feed forward (Vff):

= Velocity feed forward (Vff) reduces following error in the constant velocity portion of
the profile. Often, a velocity feed forward (Vff) value of 16384 (100%) provides best
results.

= Click in the Vff field and adjust the value.

= Click Start after each adjustment to test on a new profile move.
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9

10

Adjust acceleration feed forward (Aff):

= Acceleration feed forward (Aff) reduces following error during profile acceleration
and deceleration.

= Click in the Aff field and adjust the value.

= Click Start after each adjustment to test on a new profile move.

NOTES:

1) If, after tuning the position loop, the motor makes a low frequency audible noise while
enabled but not moving, the velocity loop gains (Vp and Vi) may be lowered to reduce
the noise. If the gain values are set too low, the response to instantaneous rates of
change might be reduced (i.e., slow correction to disturbances or transients).

2) If the amplifier is set up to run in position mode under analog input command, and the
analog command signal produces too much noise at the motor after tuning, the Analog
Command Filter or the Velocity Loop Command Filter may be used to reduce the noise
further.

Tune to multiple sets of profiles representing typical moves that might be executed in
the application. Starting with Step 6, repeat the process as needed.
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Test S-Curve Profile

If the amplifier will perform S-Curve profile moves, use this procedure to tune the level
of jerk. (Jerk is the rate of change of acceleration. S-Curve moves reduce jerk to
provide a smooth profile.) Run an S-Curve profile and adjust velocity, acceleration,
deceleration, and jerk levels until the desired profile is obtained. For instance:

.} Oscilloscope E@@

File

Trace Status: Ready

1 iﬂ%ﬁle
Type:
) Trap
© 5 Curve . .
On the Profile tab, click the S-Curve button.
2 Set up an S Curve profile by adjusting the following parameters to represent a typical

move under normal operation.

Trajectory Limits Tab

Maximum Velocity Maximum speed of the profile.

Maximum Acceleration/ Maximum acceleration/deceleration of the profile. The deceleration is
Deceleration set to be the same as acceleration.

Maximum Jerk The value of jerk set during the calculate procedure produces an S-

Curve whose maximum slope is equal to the trajectory profile slope.
This value will produce a maximum acceleration that is not more than
the initial default value of acceleration. Small values will produce less
jerking but will take longer to complete move. Large values will
produce more jerking and a more trapezoidal profile but will complete
the move faster.

Profile Tab
Distance Increase the move distance to produce a complete trajectory profile.
Use an acceptable value the does not exceed mechanical limits of
the system.
Move Relative
Type S-Curve
3 Click Start.
4 Try multiple sets of profiles representing typical moves that might be executed in the

application. Starting with Step 2, repeat the process as needed.
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Notes on the Position Mode and Position Loop

Position Loop Diagram

The amplifier receives position commands from the digital or analog command inputs, over the
CAN interface or serial bus, or from the CVM Control Program. When using digital or analog
inputs, the amplifier's internal trajectory generator calculates a trapezoidal motion profile based on
trajectory limit parameters. When using the CAN bus, serial bus, or CVM Control Program, a
trapezoidal or S-curve profile can be programmed. The trajectory generator updates the calculated
profile in real time as position commands are received.

The output of the generator is an instantaneous position command (limited position). In addition,
values for the instantaneous profile velocity and acceleration are generated. These signals, along
with the actual position feedback, are processed by the position loop to generate a velocity
command.

To bypass the trajectory generator while in digital or analog position modes, set the maximum
acceleration to zero. The only limits in effect will now be the velocity loop velocity limit and the
current limits. (Note that leaving the maximum acceleration set to zero will prevent other position
modes from operating correctly.)

The following diagram summarizes the position loop.

. . Position Loop
Profile Velocity I -
> Velocity Feed Forw ard (Vff) .
Target Trajectory Profile Acceleration + Gai i
- ain
Position ] Generator ,I Acceleration Feed Forw ard (Aff) | | Multiplier V\églmoﬁg]d
- - "
,—» _/_\_ Limited Position @—»| Position Proportional Gain (Pp) |—+A
o A-
Limits:
Max velocit
* y Feedback| /0~ from motor encoder or resolver
¢ Max accel o
« Max decel . "
[ R from optional position encoder (on load
¢ Abort decel P P ( )

Trajectory Limits
In position mode, the trajectory generator applies these limits to generate the profile.

Limiter Description

Maximum Velocity Limits the maximum speed of the profile.

Maximum Acceleration Limits the maximum acceleration rate of the profile.

Maximum Deceleration Limits the maximum deceleration rate of the profile.

Abort Deceleration Specifies the deceleration rate used by the trajectory generator when motion is
aborted.

Position Loop Inputs From the Trajectory Generator
The position loop receives the following inputs from the trajectory generator.

Input Description

Profile Velocity The instantaneous velocity value of the profile. Used to calculate the velocity feed
forward value.

Profile Acceleration The instantaneous acceleration/deceleration value of the profile. Used to
calculate the acceleration feed forward value.

Limited Position The instantaneous commanded position of the profile. Used with the actual
position feedback to generate a position error.

Copley Controls 132



CME 2 User Guide Control Loops

Position Loop Gains
The following gains are used by the position loop to calculate the velocity command:

Gain Description

Pp - The loop calculates the position error as the difference between the actual and

Position loop limited position values. This error in turn is multiplied by the proportional gain

proportional value. The primary effect of this gain is to reduce the following error.

VIf - The value of the profile velocity is multiplied by this value. The primary effect of

Velocity feed forward this gain is to decrease following error during constant velocity.

Aff - Acceleration feed The value of the profile acceleration is multiplied by this value. The primary effect

forward of this gain is to decrease following error during acceleration and deceleration.

Gain Multiplier The output of the position loop is multiplied by this value before being passed to
the velocity loop.

Position Loop Feedback
Some Copley Controls amplifiers feature dual-sensor position loop feedback, configured as
follows:
e Single sensor. Position loop feedback comes from the encoder or resolver on the motor.
o Dual sensor. Position loop feedback comes from the encoder attached to the load.
(Note that in either case, velocity loop feedback comes from the motor encoder or resolver.

Position Loop Output
The output of the position loop is a velocity command used as the input to the velocity loop.

Position Wrap

The position wrap feature causes the position reported by the amplifier to “wrap” back to zero at a
user-defined value instead of continually increasing. Once set, the reported position will be
between 0 and n-1 where n is the user entered wrap value. This feature is most useful for rotary
loads that continually turn in one direction and only the position within a revolution is of interest to
the user.

Relative moves with the wrap value set will move the relative distance called for. Example; if the
wrap value is set to 1000 and a relative move of 2500 is commanded, the axis will turn 2 %2
revolutions.

Absolute moves will move the shortest distance to arrive at the programmed position. This could
be in the positive or negative direction. Moves programmed to a point greater then the wrap value
will cause an error.

Following Error Faults

When the position error reaches the programmed fault threshold, the amplifier immediately faults.
(The following error fault can be disabled.)

Following Error Warnings

When the position error reaches the programmed warning threshold, the amplifier immediately
sets the following error warning bit in the status word. This bit can be read over the CAN network.
It can also be used to activate a digital output.
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Position and Velocity Tracking Windows

When the position error exceeds the programmed tracking window value, a status word bit is set.
The bit is not reset until the position error remains within the tracking window for the programmed
tracking time.

A similar method is used to handle velocity errors.

Following Error Fault Details

Position Error Reaches Fault Level

As described earlier, position error is the difference between the limited position output of the
trajectory generator and the actual position. When paosition error reaches the programmed
Following Error Fault level, the amplifier faults (unless the following error fault is disabled.) As with
a warning, a status bit is set. In addition, the fault is recorded in the error log. See Error Log.

Additional responses and considerations depend on whether the fault is non-latched or latched, as
described below.

Amplifier Response to Non-Latched Following Error Fault

When a non-latched following error fault occurs, the amplifier drops into velocity mode and applies
the Fast Stop Ramp deceleration rate to bring the motor to a halt. The amplifier PWM output stage
remains enabled, and the amplifier holds the velocity at zero, using the velocity loop.

Resuming Operations After a Non-Latched Following Error Fault

The clearing of a hon-latched following error depends on the amplifier's mode of operation. Issuing
a new trajectory command over the CAN bus or the ASCII interface will clear the fault and return
the amplifier to normal operating condition.

If the amplifier is receiving position commands from the digital or differential inputs, then the
amplifier must be disabled and then re-enabled using the amplifier's enable input or though
software commands. After re-enabling, the amplifier will operate normally.

Amplifier Response to a Latched Following Error Fault

When a latched following error fault occurs, the amplifier disables the output PWM stage without
first attempting to apply a deceleration rate.

Resuming Operations After a Latched Following Error Fault
A latched following error fault can be cleared using the steps used to clear other latched faults:
e Power-cycle the amplifier

¢ Cycle (disable and then enable) an enable input that is configured as
Enable with Clear Faults or Enable with Reset

e Access the CME 2 Control Panel and press Clear Faults or Reset
e Clear the fault over the CANopen network or serial bus

Copley Controls 134



CME 2 User Guide Control Loops

11.8: Auto Tune all Loops for Linear Motors

This feature is only available for use with linear motors.

Make sure motor is mounted firmly and verify accuracy and completeness of
motor data.

Failure to heed this warning can cause equipment damage, injury, or death.

DANGER

At any point, use Back to return to the previous screen. Use Skip to tune the velocity loop
without tuning the current loop, or to tune the position loop without tuning the velocity loop.

Verify the motor is mounted firmly. Also verify the accuracy and completeness of the motor
settings.

Current Loop

Make sure the amplifier's Basic Setup and Motor Phasing procedures have been
performed, and that the system is capable of a 10 mm move.

Click Auto Tune to open the Current Loop Tune screen.
Auto Tune

Current Loop Tune

"

® Ready
Gains i
et iSelect initial move direction, then
p: |press start to tune current loop.
Ci: 35

[¥] Inital Move Positive

[ Start ]I Stop rslgp ] [ Cancel ]

The status indicator is blue when the amplifier is ready for tuning.

Verify the Initial Move Positive setting. In most cases, this option should be set. If positive
initial motion is not possible, you can specify negative initial motion by clearing this option.
For instance, negative initial motion may be used when a vertical axis is at the bottom of
the motion range and the positive direction is down.
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5 Click Start to tune the current loop. During tuning, the status indicator is amber.
Cp and Ci values change as the text in the status box gives progress updates.
When the current loop has been tuned, the status indicator turns green, and the status box

contains instructions for the next step.

( Auto Tune ‘

Current Loop Tune

@ Done
Gains
o Bandwidth 1200 Hz
P Press next tc tune velocity loop.
Ci: 86

[] Inital Move Positive

| Start l[ Stop ] [ Next ] [ Cancel J

Velocity Loop:

1 Click Next to open the Jog screen.
g o
Auto Tune
Jog
Jog Speed: 50 | mm/s Pogition your motor in

the center of its range.

Actual Current - A

Current Loop Offset Current 0A

[ Back H Next ][ Cancel ]

6 Move the motor to the center of its motion range. To use a jog move:
= Set the Enable Jog option.
= Optionally adjust the jog speed
= Jog the motor in either direction to move it to the center of its motion range.
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7 When the motor is centered, click Next.

If the amplifier must apply current to hold the new position against a force (such as gravity
in a vertical application), the following message appears:

.

Auto Tune Current offset required @

A current loop offset requirement of 0.41 A
l % has been detected. If you are using a vertical
system the current loop offset should be
changed to compensate for gravity.
Make recommended change?

| OK | [ Cancel }

If this message appears, click OK.
The Velocity Loop Tune screen opens:

Auto Tune @
Velocity Loop Tune

.

® Ready

Target Bandwidth Buto tune will attempt to make a

U Higher 10mm move. If your system is not
capable of a 10mm move cancel now.

Gains

Vp: 386 Adjust target bandwidth then

Vi: 193 press start to tune velccity loop.
[ Start [[ Stop ] [ Back ] [ Skip H Cancel

8 Optionally adjust the Target Bandwidth.

TIP: Increase bandwidth for more stiffness in the holding position. Decrease bandwidth to
eliminate buzzing or oscillations caused when the load is removed.
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9 Click Start to tune the velocity loop. During tuning, the status indicator is amber.
Vp and Vi values change as the text in the status box gives progress updates.
When the velocity loop has been tuned, the status indicator turns green, and the status box
contains instructions for the next step: ‘

Auto Tune @
Velocity Loop Tune
C Done
Target Bandwidth Bandwidth 70 Hz
U Higher Press next to tune position loop.

Gains

Vp: 386

Vi: 193
[ Start § [ Stop ] [ Back ] [ Next ] [ Cancel

Position Loop:
10

Click Next to open the Position Loop Tune screen:

Auto Tune

Position Loop Tune

Move Type
(") S Curve Vff = 100% (optimal settiing and following)
Vff
@ Trap Best Settling U Best Following
® Ready
Gains
Autc tune will attempt tc make a
Pp: 1000 3
10mm move. If your system is not
Vff: 16384 capable of a 10mm move cancel now.
Aff: 0

Select move type then press start
tc tune position loop.

(5ot ] (e )

[ Back ][ Finish ][ Cancel ]
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11
12

13

14

15
16
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Verify the Move Type setting (S-Curve or Trap).

For a trapezoidal profile, optionally optimize the tuning along the scale between Best
Settling (for quicker settling) and Best Following (for less following error).

Click Start to tune the position loop. During tuning, the status indicator is amber.
Pp, Vff, and Aff values change as the text in the status box gives progress updates.

When the position loop has been tuned, the status indicator turns green, and the status box
contains instructions for the next step:

"

Auto Tune
Position Loop Tune
Move Type
(") S Curve Vff = 100% (optimal settling and following)
Vff
@) Trap Best Settling “ Best Following
C Done
Gains
e CEot Press finish tec save tuning
¥ values and exit.
Vff: 4915
Aff: 1229
| start || stop | | Back || Enish || cancel

Click Finish. See the reminder:

Tuning values Changed

New gains must be saved to

( |
&Y' flash after verification

Click OK.

E:x On the CME 2 Main screen, click Save to Flash.
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Stepper Motor Support

CME 2 supports Copley’s stepper amplifier family. Stepper amplifiers can run in stepper mode or
servo mode.

This chapter describes controls that can be used to fine-tune a stepper amplifier in stepper mode:
Encoder Correction and Detent Compensation Gain. It also describes the screen used in stepper
mode to set Position Limits.

When a stepper amplifier is used in servo mode, it operates as a true, closed loop, servo amplifier
controlling a stepper motor. After putting the stepper amplifier into servo mode, set it up and tune it
just as you would a servo amplifier.

Position Limits (Stepper Amplifier)
Perform the following steps to set position limits for a stepper amplifier connected to an encoder
with Encoder Correction enabled (not operating in Servo mode).

Pos Limits . L .
__J Click the Pos Limits button on the Main screen.
2 Position Limits =] = =]
Trajectory Values
Commanded Position Velocity & Acceleration Commanded Current
Limiter
Max Velocity: Q| rpm Max Accel,: 0 rps?
s Max Decel.: 0 rps?
Clear Limits
E— Abort Decel. : 0| rps?
Set Default Limits
Jerks 0 rps?
Abort Jerk: 0 rps3?
Close

Parameter | Description

Max Velocity Maximum trajectory velocity. Max value may depend upon the back EMF and the Max
feedback count. Min:0. Default: 0.25 x motor velocity limit.

Max Accel Maximum trajectory acceleration. Max value may depend upon the load inertia and
peak current. Min:0. Default: 0.5 x velocity loop Accel. Limit value.

Max Decel Maximum trajectory deceleration. Max value may depend upon the load inertia and
peak current. Min:0 (disables limit). Default: 0.5 x velocity loop Accel. Limit value.
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Abort Decel Deceleration rate used by the trajectory generator when motion is aborted. Min:0.
Default: 0.5 x velocity loop Accel. Limit value.

Jerk Rate of change of acceleration. The value of jerk set during the calculate procedure
produces an S-Curve whose maximum slope is equal to the trajectory profile slope.
This value will produce a maximum acceleration that is not more than the initial default
value of acceleration. Small values will produce less jerking but will take longer to
complete move. Large values will produce more jerking and a more trapezoidal profile
but will complete the move faster.

Abort Jerk The value of Jerk used when a move is aborted.

Note that setting limits to zero disables the trajectory generator so that the command input is not limited
by the generator. Velocity is only limited by the Velocity Limit set in the Velocity Loop.
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Encoder Correction

For a stepper motor with an encoder, encoder correction may be used to compensate for lost
microsteps. Normally, in an open loop micro stepping mode with an encoder, the total number of
micro steps per revolution is set to the number of encoder counts per revolution. However, a
following error can accumulate when micro steps are lost.

In encoder correction mode, when a commanded position is not equal to the actual position,
indicated by encoder counts, the following error is multiplied by the Encoder Corrections
proportional gain (ECp), and micro steps are added to the open loop micro stepping loop.

If the error is large or the gain is high, micro steps are added at a higher rate, up to the Max step
rate limit. If the ECp gain is too high, the loop will become unstable and corrections will not reduce
the position error. The position error will not be reduced if the Max step rate is outside of the
motors stepping ability. If steps are lost during a move, encoder corrections are made during the
move, but will tend to accumulate during the trajectory profile and become resolved by the end of
the move.

1

Enc Comrection . i
I Click to open the Encoder Correction screen.
.} Encoder Correction oo @
ECp: of
Max Step Rate: 0 rpm
Close |
2 Set the Encoder Correction parameters:
Parameter Description
ECp Proportional gain used to compensate for lost microsteps. Default: 0.
Max Step Rate Maximum velocity allowed while using ECp to correct position errors.
Excessive velocity can result in more lost microsteps. Default: O.

Test Encoder Correction
While holding position, introduce a position error by rotating the motor shaft by hand.
NOTE: Reduce the holding current slightly if unable to rotate shaft.

The ECp will act on the error and the motor will settle into position slower than a servo
motor but in a reasonable amount of time.
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12.4: Detent Compensation Gain

Stepper motors are subject to torque detent that can cause undesired velocity fluctuation between
full steps of motion. The Detent gain feature can compensate for this detent.

1

) o

k Detent to open the stepper amplifier Advanced Tuning screen.

-

vanced

Ready

Auto Scale Lock
Trace Time: 25 ms = [ start | [ stop |
Setting Description
Velocity Tuning velocity. Default: 0.
Trace Time Length of trace interval to be shown on screen. Default: 25 ms.
Gain (Detent Gain) The Stepper Detent Gain value. Default: 0.
Auto Scale Lock When selected, prevents trace display from rescaling during tuning.

Click Start to begin the tuning.

Adjust Velocity from 0 until the mechanical system begins to resonate. (Using a 1.8
degree step motor with 200 full steps, this will typically occur at a velocity of 40-70 rpm.)

Adjust Gain until the resonance increases, and then back it down until the resonance is
minimized.

Click Stop to stop the tuning.

Click Close to close the window.

“ On the CME 2 Main screen, click Save to Flash.

Copley Controls 144



CHAPTER

13: HOMING



Homing CME 2 User Guide

13.1: Overview

The Homing screen allows homing to be configured and tested. Changes made to this screen get
saved to amplifier RAM. On amplifiers configured for Absolute encoders, calibration can be
performed.

Click the Home button on the Main screen to open the Home screen

I

Home @

Software Limits

Pasifve: 0| counts Deceleration Rate: 0| rps2

Megative: 0| counts

Method: |Hardstop -

Direction of Mation

@) Positive () Negative Offset: 1500 | counts
Current Limit: 2.34| A
Fast Velodity: 150 | rpm Current Delay Time: 250 | ms
Slow Velocity: 30| rpm Following Warning: 2000 counts
Accel/Decel: 50 | rps? Actual Current: A
Actual Position: 0 counts
[] Test without home adjustments Homing Adjustment: counts
I Home I I Stop I Calibrate I Save I I Exit I

Copley Controls 146



CME 2 User Guide
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Parameter

Description

Software limits: Positive

Software limits: Negative

Position of user-defined travel limits that take effect after homing
operation.

Software limits:
Deceleration Rate

Deceleration rate used to stop a motor when approaching a software
limit.

Software limits: Disable

Disables the use of software limits by setting both limits to zero.

Method

Homing method. See Homing Method Descriptions

Direction of Motion

Initial direction of motion for the homing method (Pos or Neg).

Fast Velocity

The velocity used to find a limit or home switch. Also used when
moving to an offset position, or a resolver or Servo Tube index position.

Slow Velocity

The velocity used to find a switch edge, incremental or analog encoder
index pulse, or hard stop.

Accel/Decel

The acceleration and deceleration rate used during homing.

Offset

Execute a move of this distance after the reference is found. Set actual
position to 0 and call the new position home.

Current Limit

Current Delay Time

Hard stop home is reached when the amplifier outputs the homing
Current Limit continuously for the time specified in the Delay Time.

Following Warning

Shows the programmed following warning level.

Actual Current

Shows actual current being applied to windings during homing.

Actual Position

Shows the actual position of the axis.

Homing Adjustment

Shows the Home offset measured after homing is performed.

Test without home
adjustments

Selecting this option and pressing the Home Button tests the adjusted
home position without making any changes to the saved home position.
The resulting homing offset is reported in the Homing Adjustment text
field.

Home

!

Starts the homing sequence using the settings shown on the screen.

Stop

Stops the homing sequence.

Calibrate

!

Starts the Calibration routine for absolute encoders. See Absolute
Encoder Calibration

Save

!

Saves the homing parameters to amplifier flash.

Exit

d

Discards unsaved homing parameters, then closes the screen. The
rules for discarding unsaved values are as follows:

¢ If the Save button was never clicked, all of the homing
parameters will be reverted to the values at the time that the
screen was opened..

e If the Save button was clicked, then the homing parameters will
be reverted back to the values at the time of the last Save
event.

Upon closing, any home sequence in progress will be aborted.

1

AN

7
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Absolute Encoder Calibration

When absolute encoders are used, the absolute encoder value that corresponds to the zero
position in the machine’s reference frame is saved to flash memory in the drive. This value is then
added to the absolute encoder reading so that all position measurements are in absolute units in
the machine’s coordinate system. Movement of the motor to ‘find’ the machine’s reference point is
not necessary. This process is called calibration because it's done once when the machine and
drive are commissioned together and does not need to be repeated until the encoder is changed,
or adjustment of the machine-zero location is changed.

Note: This feature is only available on the Plus family of drives with a minimum firmware version
of 2.00.

Calibration of an absolute encoder is a two-part process:

1. Mechanical Homing
2. Calibration

Mechanical Homing

Mechanical homing is the process of moving the motor to the position that is machine-zero. This is
the location from which all dimensions are absolute in the machine’s position reference frame.

1 Enter the values of the appropriate homing parameters.

2 l"'“il Click the Home button to run the home sequence.
3 Repeat if necessary until the motor is positioned at machine zero.

4 ﬂl Click the Save button.

Calibration

Calibrating the encoder involves saving the absolute position at machine-zero to the drive’s flash.
This value will be saved as a negative number and added to the absolute encoder positions
thereafter by the firmware to convert them to machine absolute values. This value is stored in the
Home Offset parameter. CME 2 provides a single button-click operation to perform this calibration.

Calibrate | Gjick the Calibrate button to initiate the calibration routine.

CME 2 will perform the following sequence:
e Set the calibration bit of the Homing Configuration register.
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¢ Initiate the homing sequence.

The drive will then perform the following sequence:

. Run the home sequence.
. Save the Home Offset in flash.
. Change the home method to Absolute Encoder Immediate Home.

The Homing Adjustment field on the Home screen will show the offset value saved in flash. Once
the calibration is complete, the Calibrate button will be disabled until another home sequence is
run by clicking the Home button. To remove the calibration, change the Home Method from
Absolute Encoder Immediate Home to some other method, and run the home sequence.
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14.1: Control Panel Overview

Click to open the Control Panel.

(2 Control Panel l =2 ES
Status Monitor
Red if fault P # Safety: Enabled Actual Current > _ A
is active —» w  Motor Output: Active
# Hardware Enabled: Enabled Bus Voltage v _ v
Yellow if warning @ Software Enabled: ~ Enabled
is active — A # Positive Limit: Not Active
) Actual Motor Position - _ counts
# Negative Limit: Not Active
Display error Iog —tp | ErrorLog # Software Limits: Not Active oo o
— o Martes Phouas oK Mode: Position, Digital Input
# Motion Abort Input: Not Active
CVM Control Program: Not Running Move
Home: Not Referenced Velodity 75| rom
Net
Acceleratio 00 | rp:
Message box ——p» Decelerati 00 | rps
Control [~ Enable Jog Move NEG
[ Enable | | setzeroPosition ]
Control functions —»
[ Disable ] [ Clear Faults J [ Reset

Statuls indicators

Control Panel

Monitor real-time amplifier values
and operatiorI\aI mode

Jog mode controls

14.2: Status Indicators and Messages

The Status area includes status indicator lights (described below) and a message box. Any red
lights indicate that motion will be inhibited.

Indicator

States/Description

Safety

State of the safety circuit. Enabled or HI/LO disabled. On amplifiers with safety circuit.

Motor Output

State of the PWM output stage. Red if the output stage is inactive (disabled)

Hardware Enabled

State of the hardware enable input(s). Red if one or more enable inputs are inactive.

Software Enabled

State of the software enable. Red if the amplifier is disabled by software.

Positive Limit

State of the positive limit switch input. Red indicates an activated positive limit switch.

Negative Limit

State of the negative limit switch input. Red indicates an activated negative limit switch.

Software Limits

State of the software limits. Red indicates an activated software limit.

Motor Phase

Indicates a motor phasing error. Red indicates a motor phasing error exists.

Motion Abort Input

State of the programmed Motion Abort Input. Red indicates the input is active.

CVM Control Status of the CVM Control Program.

Program

Home Indicates whether the axis has successfully been referenced (homed).

CAN Status Status of the CAN Bus. Yellow indicates CAN warning limit reached. Red indicates bus

error detected.
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Gain Scheduling

Indicates whether Gains Scheduling is active.

Indicates that a fault is active. Check the status message box for a description of the

most recent fault; Fault: Under Voltage .
Check the Error Log for a full history of faults and warnings.

Indicates that a warning is active. Check the status message box for a description of the
most recent: Warning: Pos Outside of Tracking Windaow

Check the Error Log for a full history of faults and Warn.ings.

Message Box

Displays status descriptions.
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14.3: Control Panel Monitor

The Control Panel Monitor displays real-time values of selected variables.

Monitor

- I
- I

Commanded Velocity

Actual Motor Velodity

Actual Motor Position

Mode: Disabled

Control Panel

Monitor Variables

Actual Current

Following Error

Passive Load Position

Actual Motor Velocity

Commanded Current

Limited Position

Actual Motor Position

Commanded Velocity

Analog Command

Actual Load Velocity

Commanded Position

Bus Voltage

Actual Load Position

Profile Velocity

Amplifier Temperature

Profile Acceleration

Velocity Error

Motor Phase Angle

Mode: Displays the amplifier's operating mode in RAM. In camming mode it also displays the

active cam table number
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14.4: Control Functions

The Control area of the screen provides functions related to overall amplifier control. The screen
options vary with model and configuration.

Control
[ Enable ] 1 Set Zero Position ]
L Disable J l Clear Faults ] L Reset J
Control Description
Enable Click to software enable the amplifier.
Disable Click to software disable the amplifier. This will also stop any CVM programs that
are running.
Set Zero Position Click to set the amplifier's actual position counter to zero.
Clear Faults Click to clear all amplifier faults.
Reset Click to reset the amplifier.

Risk of unexpected or uncontrolled motion.

Using the CME 2 Set Zero Position function while the amplifier is
operating under external control could cause unexpected or
uncontrolled motion.

Failure to heed this warning can cause equipment damage.

WARNING
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14.5: Jog Mode

Control Panel

Jog mode provides a simple means for moving/jogging the motor.

Mowe
Velocity 100(| rpm
Acceleration 500 | rps2
Deceleration 500 | rps?
| Enable Jog Maove NEG | | Move POS
1 To put the amplifier in jog mode, select Enable Jog.
2 Set up a jog move by setting the following mode-specific parameters:
Mode Parameter | Description
Current Current Current applied to the motor. Limited by current loop Continuous
Current.
Warning: Unloaded motors may, depending on torque setting,
ramp up in speed very quickly.
Velocity | Jog Speed Velocity of the jog move. Limited by velocity loop Vel. Limit.
Position | Velocity Velocity of the jog move. Limited by velocity loop Vel. Limit.
Acceleration Acceleration limit of the jog move.
Deceleration Deceleration limit of the jog move.
3 Command the move:
Mode Steps
Current | Hold Pos to apply positive current to the motor or hold down Neg to apply negative
current to the motor.
Release the button to command zero current.
Velocity | Hold Jog Pos to command a forward velocity or hold down Jog Neg to command a
negative velocity.
Release the button to command zero velocity.
Position | Hold Move Pos to generate a forward move profile or hold Move Neg to generate a
negative move profile.
Release the button to stop movement.
NOTE: Position mode jog is accomplished by continuously updating the
commanded position. If a following error develops with Following Error Fault
disabled, motion will not stop on button release. Instead, it stops when actual
position = commanded position.
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15.1: Overview

The Oscilloscope can be used to tune the amplifier, monitor performance, and perform
diagnostics. Function Generator and Profile Generator can drive the motor without external control.
Auto Set Up feature sets typical initial values for scope parameters.

2} Oscilloscope =8 ECR

File

Trace Status: Ready

Function Generator | Profile Settings | Gains | Trajectory Lirnitsl Position Paramsl Velocity Paramsl Meawrementl

Move: Type: Trigger Setup
@ Relative @ Trap ] Autosetup
(") Absolute @ scC
o - e Single Trace
Distance: 4000 counts |:| Auto Scale Lock
Trace Time: | 250 ms
FReverseand Repen o
Sample Rate: 125 ps
TS| o ¢] S
[ start | stop |

*‘I. [ Record ] ’ Stop Trace l [ Clear l [ Close l
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15.2: Menu, Display and Controls

File Menu

7 Oscilloscope
File

The File menu contains the options to save/restore scope settings. This feature is useful for
saving custom settings used for tests that are run frequently.

File Menu

Save Settings Saves current scope settings to a file

Restore Settings Restores settings from a file
Display

To access the Trace Display menu, Right-click in the trace display area

Trace Status: Ready

Line Style * @ line

Preferences plus

connected plus

Menu Parameter Description
Line Style line A line connects the plotted data points.
plus The Scope plots data points as plus signs, with no connecting
line.
connected plus | Data points are plotted as plus signs and are connected with a
line.

Preferences | anti-aliasing When anti-aliasing is selected, the Scope removes screen-
related jaggedness in the displayed trace. Use of this feature
may slow down the refreshing of traces on slow computers.

grid When selected a grid is displayed on the scope screen.

Trace Display Zoom
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1 Hold the left mouse button down while dragging a box around the area of interest.

Trace Status: Ready |

2 Release the button to let the display zoom in on the selected area.

[ Trace Status: Ready

3 To restore the normal zoom level immediately, left-click anywhere on the trace.
(Normal zoom level is also restored when the next trigger event occurs.)

Controls
4-" [ Record ] [ Stop Trace ] [ Clear ] [ Close
Action Description

Save a trace. See Scope Trace Files

Begins recording a trace

top Trace Stops recording a trace

ng
m
o
(=8

Clears the trace from the screen and trace data from buffer
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AutoSetup
| Single Trace
Auto Scale Lodk

Trace Time: |1.255 =

sample Rate: 500 ps

Function Description

Auto Setup When selected, the scope will be set up based on the setting for either the Function or Profile
Generator (whichever is active).

Single Trace When selected only one trace will be collected and displayed, otherwise a new trace will be
started as soon as the current trace is displayed.

Auto Scale Lock When displaying the trace data, the scope will automatically scale the vertical axis for optimal
viewing. When Auto Scale Lock is selected, the y-axis scale will be locked at is current setting.

Trace Time This is the total amount of time the trace is recorded.

Sample Rate The rate at which each sample is collected. When tracing multiple channels, all channels are
collected at approximately the same time.
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15.3: Function Generator

The Function generators can provide inputs to the different control loops for tuning and diagnostics
purposes without using an external control source.

Function Generator ‘mﬁfej—

Apply To: |¥elocity H
Function: | Square Wave v
Amplitude: 200 | mm/s
Frequency: 5/ Hz

Start Stop
[ start |

The Start button starts the function or profile generator. The Stop button stops the generator and
aborts any profiles in progress.

Parameter | Description

Apply To Control loop to which the Excitation will be applied: Current (available in all modes), Velocity
(available in velocity or position mode), or Position (available in position mode only).

Function Function that will be applied to the control loop selected in the Apply To list box. The choices vary
with the control loop selected:

Selected Control Loop Functions Available

Current Sine Wave, Square Wave, Step Forward, Step Forward and
Reverse, and Impulse

Velocity Sine Wave, Square Wave, Step Forward, Step Forward and
Reverse

Position Sine Wave, Square Wave

Amplitude Amplitude of the command. Units vary depending on the value chosen in the
Apply To field.

Frequency (Sine Wave and Square Wave only.) Frequency of input command cycle.

Period (Step Forward, Step Forward and Reverse, and Impulse only.) Duration of each input pulse.
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15.4: Profile Generator

| Function Generator | Profile }

Move: Type:

2 Rel 5 (") Trap

") Absolute @ S Curve
Distance: 2000 counts

[ ] Reverse and Repeat

Start

Oscilloscope

of the distance specified until Stop is pressed.

Parameter Description
Move Relative: Moves axis a specified distance from the starting position.
Absolute: Moves axis to a specific position.
Type Trap or S-Curve.
Distance Distance for Relative move.
Position Target position for Absolute move.
Reverse and Repeat (Relative move only.) When selected, will continuously generate forward and reverse moves
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15.5: Trace Channel Variables

Settings | (Gains | Trajectory Limits I Position Params | Velod

)
o

Click the Channel button to open the Trace Variable selection screen

CME 2 User Guide

Channel 1 Trace Variables @
Categoary Trace Variahle
Disabled Profile Velodty
Current Commanded Velocity
Limited Velocity
Position Actual Motor Velocity
Acceleration Velocity Error
Voltage Actual Load Velodity
Miscellaneous Lnfiltered Motor Velodity
Digital Inputs Velocity Loop P Gain
Digital Cutputs Velocity Loop I Gain
Event Status Faults
Event Status Warnings
Ewvent Status Misc.
Raw Encoder Signals
[ QK ] [ Cancel
Category Trace Variable
Disabled <Channel disabled, no associated variable>
Current Commanded Current, Actual Current, Limited Current, I°T Amplifier Accumulator,
I>T Motor Accumulator.
Velocity Profile Velocity, Commanded Velocity, Limited Velocity, Actual Motor Velocity, Actual Load
Velocity, Unfiltered Motor Velocity, Velocity Error
Position Commanded Position, Limited Position, Actual Load Position, Actual Motor Position, Following
Error, Passive Load Position
Acceleration Profile Acceleration
Voltage Analog Command, Bus Voltage, Analog sin Input, Analog cos Input, Terminal Voltage Stepper,
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Terminal Voltage Servo

Miscellaneous | Motor Phase Angle, Amplifier Temperature, Hall States

Digital Inputs Digital input line states

Digital Outputs | Digital output line states

Event Status Short Circuit, Amp Over Temperature, Over Voltage, Under Voltage, Motor Over Temperature,

Faults Feedback Error, Motor Phasing Error, Following Error, Command Input Fault, Amplifier Fault (a
latched fault is active).

Event Status Current Limited, Voltage Limited, Positive Limit Switch, Negative Limit Switch, Following Warning,

Warnings Velocity Limited, Acceleration Limited, Positive Software Limit, Negative Software Limit, Pos

Outside of Tracking Window, Vel Outside of Tracking Window.

Event Status Amp Disabled by Hardware, Amp Disabled by Software, Attempting to Stop Motor, Motor Brake
Misc. Active, PWM Outputs Disabled, Position Has Wrapped, Home Switch Active, In Motion, Phase Not
Initialized.

Raw Encoder Primary Encoder A, Primary Encoder B, Primary Encoder X, Primary Encoder S, Secondary
Signals Encoder A, Secondary Encoder B, Secondary Encoder X, Secondary Encoder S
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15.6: Trigger Setup

| Trigger St | Cjick the Trigger Setup button to open the Trigger Settings screen.

Trigger Settings @

Trigger Type: Above Level —
Trigger On: Channel 1 -

Position: Left -

Level: IDD| rpm

Event Status Bit:

0K Cancel

Setting Description
Trigger Type Type Condition
Immediate Trigger Trigger as soon as a trace is started (when the Record button is
pressed).
Rising Edge Trigger when the selected channel's input changes from below to
above the trigger level.
Falling Edge Trigger when the selected channel's input changes from above to
below the trigger level
Above Level Trigger as soon as the selected channel's input is greater than or
equal to the trigger level.
Below Level Trigger as soon as the selected channel's input is less than or equal
to the trigger level.
Function Generator Trigger on the start of the next function generator cycle.
Input Level High/Lo Trigger when specified input is high or low
Output Active/lnactive | Trigger when specified output is active/inactive
Event Status Rising Trigger on the rising or falling edge of an event status bit.
Edge/Falling Edge
Raw Encoder Signal Triggers when the raw encoder signal is Hi/Lo
Level H/Lo
Trigger On Selects which channel will be used as the trigger source.
Position Selects placement of the trigger event on the screen. (Value is not configurable for Immediate

or Function Generator trigger types.).

o Left for optimal viewing of events following the trigger.

¢ Middle for optimal viewing of events preceding and following the trigger.
¢ Right for optimal viewing of events preceding the trigger.
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Level

Sets the trigger level, in units appropriate to the channel selected.

Event Status Bit

With an event status trigger type selected, choose the status bit that will trigger the trace. For

descriptions of the event status word.
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15.7: Measurement Tab

The Measurement tab allows you to measure and analyze data from up to three parameters during
an interval defined by adjustable cursors. The Cursor Data area displays a parameter’s values at
the left and right cursor locations, and the difference between the two values. The Analysis area
displays the minimum, maximum, average, and root mean square of the parameters during the
cursor period.

Cursors

| @ Osﬁillos:ope E

File

Trace Status: Reaay \j |

Function Generator | Profile | Settings | Gains | Trajectory Limits | Pesition Params | Velocity Params | Measurement
Cursor raw data B Cursor Data lysis <& Cursor data analysis
- . Left Right Delta Min Max Avg rms  Units
Apply To: | Position v = =

- I 1 ° T 1T -] -~"pw
ampituce: [ 8192 courns || (@120w) T o

s

Function: gquaré Wave v ]

e 2 (o3 | G G | E N rps?
m [W] [#] Show Cursors
ol [Record][StopTrace][dea][Close]

When Show Cursors is not set, the Cursor Data fields are inactive and the Analysis fields show
calculations based on data from the entire trace cycle.

1 R - . . :
SUTRELELS To display cursors and activate the Cursor Data fields, set Show

Cursors.

2 To move a cursor, click on the cursor and hold the left button while dragging the cursor
to the desired location. Release the left button to place the cursor in the new location.

3 To select a parameter to measure and analyze within the cursors, choose a channel in
one of the three channel lists on the Measurement tab:
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The Oscilloscope provides convenient access to all of the control loop parameters that might be
used in tuning and diagnosing an amplifier. The user can adjust these parameters and see the
results immediately on the scope. Control loop parameters are accessed through a set of tabs,

shown below.

| Settings | Gains |Trajvau::|:-::nr3-I Limits | Position Params I Velocity Params | Measurementl

Position
Pp: 1000
Aff: ]
Vit 16334

Velodty

Vp:

Wis

Current
-~ -~
403 il Cp: 208 il
43| ° i 223

Note that the parameters represented on these tabs can also be accessed through the screens
used to configure the control loops and the digital position input. Changing a value in the Scope
tool automatically updates the value on the other screens where it appears, and vice versa.

Control loop parameter tab descriptions follow.

Gains Tab
Modes Gains Description For More Information
Pp Position loop proportional gain.
Position mode only Aff Acceleration feed forward. Position Loop Gains
Vff Velocity feed forward.
Position or velocity Vp Velocity loop proportional gain. . .
- - - - Velocity Loop Gains
mode only Vi Velocity loop integral gain.
Cp Current loop proportional gain. .
- - - Current Loop Gains
All modes Ci Current loop integral gain.
ECp Encoder Correction Gain (Stepper only) Encoder Correction
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Trajectory Limits Tab

Available in position mode.

Settings I Gains | Trajectory Limits | Position Params | Velocity Params | Measurement|

Maximum Velodty: 750 | rpm
Maximum Acceleration: 250 | rps?
Maximum Deceleration: ' 2>50' rps?
Maximum Jerk: 10000. rps3

For more information see Position Loop Setup and Tuning

Position Loop Parameters

Available in position mode.

| Settings | Gains | Trajectory Limits | Position Params | velocity Params | Measurement

[ T Actual Position: 120000 counts
Window: 4096 counts
Set Zero Position |
Time: 10 'ms
Following Error: 16384 | counts

[ | Disable Following Error Fault

Set Zero Position sets the amplifier's actual position count to zero. For more information, see
Position Loop Setup and Tuning
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Velocity Loop Parameters

Available in position and velocity modes.

| Settings | Gains | Trajectory Limits | Position Params | Velodty Params Measurementl

Velocity Tracking
Window:‘ 146 | rpm
Time: 100 ' ms

CME 2 User Guide

Accel Limit: : 500  rps?

Decel Limit: 500 | rps2

For information see Velocity Loop Setup and Tuning
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Scope Trace Files

The Oscilloscope can save trace data to disk that can be opened later with the Trace Viewer.
When the save trace data to disk operation is performed, CME 2 saves the data in three different
files:
e .sco: This is a CME 2 format which contains scope settings and trace data
e .csv: This is a standard comma-separated value file format that can be imported into
spreadsheet software like Microsoft Excel.
e .ixt: This is a tab-separated value file similar to the .csv file. This is intended to be imported
by software that can only read tab-separated values.

The format of the .csv and the .txt files are identical except for the separator:
Column 1: time

Column 2: Trace Channel 1 data

Column 3: Trace Channel 2 data (if used)

Column n: Trace Channel n data (if used)

The trace data is in amplifier units, not user units (see Parameter Dictionary for units).
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15.10: Trace Viewer

The Trace Viewer screen displays the contents of .sco files. All of the trace display features
(zooming, line style, etc.) as well as the measurement functions are available in this screen.

1 On the Main screen, choose Tools—>View Scope Files to open the window.

2 Click Open File. When prompted, select the name of the file you wish to open.
Then, click Open to display the file in the Trace Viewer window.

(2 Trace Viewer (testl.sco) =

Settings | Measurement

Function Generator Scope Trigger
(O BBl cnanded Cuent | Type:  Function Generator
(o, W BlA ctual Current

Apply To: Current

Excitation: Square Wave Ch 3: EET Apply To: N/A

e v ch + o A
Ch 5: '

Period: 100 Hz che: DN Level:  NJA
Trace Time: 25 ms
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16.1: Setting Parameters

To change or view filter configurations follow these steps:

]
T | Choose the Configure Filters button from the main screen to open the

Filter Configuration screen.

2 To view present filter settings choose the Filter Settings tab. Choose other tabs to
configure Analog, V Loop, | Loop or Input Shaping settings.

@ Filter Configuration

|§Fi|tEF Settings | Analog I V Loop | I Loop | Input Shaping|

16.2: Filter Configuration Windows

Along with the location of a cut-off frequency on the filter curve, there are several filter
configuration parameters available depending on the initial choice of: Standard Filter
Types and Standard Filter Families.

Filter configuration choices may include:
o Number of Poles (the location of a cut-off frequency on the filter curve)
o Cut Off Frequency
o Frequency 2 (If two poles are chosen)
e Pass Band Ripple
e Stop Band Ripple

16.3: Filter Settings

The Filter Settings tab opens a window that shows what filters have been selected.

Q Filter Configuration E = @
Filter Settings ‘ Analog I V Loop | 1Loop | Input Shapingl
Type Family Poles Frequency
Analog Reference Disabled
V Loop Input Disabled
¥ Loop Qutput 1 Low Pass Butterworth 2 200
V Loop Output 2 Disabled
V Loop Qutput 3 Disabled
ILoop Input 1 Disabled
I Loop Input 2 Disabled
Input Shaping Disabled 0.1
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Input Shaping
Input shaping is a method by which unwanted command induced vibrations are kept to a minimum

by damping them with superimposed impulses. This produces a command that will drive the
system with limited residual vibration.

In order to set the input shaping parameters, first measure the mechanical frequency; see
Measuring Mechanical Vibration.

Below is a diagram of the input shaping process.

Step Command Input Output Command
A Shaping A
N |
Time X - T ,  Time
0 0 T

25 — ,
F’JJI
- 20— S
s .
g
= 15 p—
4]
)]
£
E s—me—e VD
5 S
oL |
0.6 1.4

Frequency (F/Fm)
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The Analog tab opens a window that shows analog filter choices and a representative
curve. Modify the settings as needed and press Apply.

Q Filter Configuration Axis A : = :
Filter Settings | Analog | | 1 Loop | 1nput Shaping
Analog Reference Input Analog Reference Selected Loop Input
Filter
e [Cemy ]
Family: Butterworth -
E . Default
) 1pole @ 2Pole
Cut Off Frequency (Fc) 00| Hz  g4g
Frequency 2 (F2) 1|Hz b 40dB
decade
Pass Band Ripple (Rp) 0.1/ db
Stop Band Ripple (Rs) 1|db
FIC

Velocity Loop

The V Loop tab opens a window that shows Velocity Loop filter choices and a
representative curve. Modify the settings as needed and press Apply. Selecting Default

will supply a 200 Hz Low Pass filter to the first velocity loop output filter.
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JFdnerSetmgsIAnalog] VLoop | ILoop [ Input Shaping|

@ Output Filter 1
() Output Filter 2
() Output Filter 3

I s+ -

C
B Output T Output » Output Current
Filter 1 Filter 2 Filter 3

Type: Low Pass

v

i

Famiy:  Butterworth

© 1pole

Cut Off Frequency (Fo) |
Frequency 2 (F2) l
Pass Band Ripple (Rp) [

Stop Band Ripple (Rs)

v

Default
@ 2Pole
00[Hz g
-3dB
1|He -40dB
decade
0.1]db
l | | db
Fc

Filters
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Current Loop
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The | Loop tab opens a window that shows Current Loop filter choices and a

representative curve. Modify the settings as needed and press Apply.

2} Filter Configuration

| Filter settings | Analog | v Loop | IL0op | Input Shaping

=R Nl

-3dB

Frequency 2 (FZ)

et EliE 2048
Pass Band Ripple (Rp) 0.1|db decade
Stop Band Ripple (R=) 1| db

o e
EenComd o, | Input Current Current Vot
5 Filter 1 Filter 2 Limiter Conroller
Offset
S Type:
_ Family: Butterworth =
() Input 2 - : Default
@ 1pole () 2Pole
Cut Off Frequency (Fc) 200 | Hz a6

Fc

Close
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16.5: Standard Filter Types

Low Pass Filter
Frequencies below the selectable cut-off are allowed to pass.

Example:
dB
4 -3dB

-40dB
decadea

Fc

High Pass Filter
Frequencies above the selectable cut-off are allowed to pass.

Example:
di
3dB

40de
decade

Fe
Notch Filter

Notch filters allow a bandstop in a range between two selectable frequencies. It may be
Butterworth (no ripple), Chebyshev (selectable passband ripple), or elliptical (ripple on both
passband and bandstop).

Example:
di Jr

&

_f_

Rp

Fi F2

Band Pass Filter

Band pass filters allow a range of frequencies, between two selectable cut-offs, to pass. It may be
Butterworth, Chebyshev, or Elliptical.

di 1'

Rp

F1 Fl
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Custom Biquad Filter
The Bi-Quadratic filter has two quadratic terms: one in the numerator, and one in the denominator.
The numerator affects the filter's two zeros and the denominator affects the filter's two poles. Many
filter classes and types can be expressed in the Bi-Quad form by entering the coefficients. The
coefficients can be calculated using any commercially available math software package and
entered as floating point numbers. However, due to the fixed-point representation, the numbers
may be rounded.
Example:
-1 -2
bn + h1z +h 2

H =
4]

-1 -z
1+az+az
1 z
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16.6: Standard Filter Families

Butterworth Filter
A Butterworth filter has two poles for faster roll-off at the cut-off frequency.

Example:
dB
$ -3dB

-40dB
decads

Fc

Chebychev Filter

A Chebyshev filter has a faster roll-off than a Butterworth filter, but, as a result of the fast roll-off,
ripple is introduced into the passband frequency.

Example:
dB 1
—T—
Rp
Fe
Elliptic Filter

Similar to a Chebyshev filter but ripple is introduced into both the passband and the stopband. It
has a faster roll-off than a Chebyshev filter.

Example:
dB 1
T
Rp
Rs
4
y T
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Input Shaping Window
The Input Shaping tab opens a window that shows Input Shaping choices and a representative
Time and Amplitude table. Modify the settings as needed and press Apply.
Type as well as Frequency and Damping Rate may be adjusted. Overcurrent is adjustable when a
Negative Zero Vibration or a Negative Zero Vibration and Derivative filter is chosen. If Custom is
chosen as the Type, Time and Amplitude may be set manually.

2} Filter Configuration EI =] @
| Filter settings | Analog | v Loop | 1Logp | Input Shaping
——— | Trajectory Generator ——fm-| _[nput Pasition Loop
Shaping
Time Amplitude

Type: Zero Vibration - .
Frequency: 0.1|Hz 5 0.5
Damping Ratio: [u]
Qver Currenting Ratio: |1

Apply Default

Close

Input Shaping Types

Type

Description

Zero Vibration

Single step inputs are replaced with two step inputs of smaller magnitude. One of
which is delayed by one-half the period of vibration. Sensitive to some modeling
errors.

Zero Vibration and Derivative

A zero derivative (of the vibration) constraint is added to Zero Vibration impulse
shaping, thereby reducing modeling errors.

Negative Zero Vibration

Faster than positive input shaping (Zero Vibration, and Zero Vibration and
Derivative), but may magnify high frequency vibrations.

Negative Zero Vibration and
Derivative

A zero derivative (of the vibration) constraint is added to Negative Zero Vibration
impulse shaping.

Custom

Time and Amplitude can be set manually.
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16.8: Measuring Mechanical Vibration

There are several ways to measure mechanical vibration. Two choices are offered below.

Using an Accelerometer with CME 2
Begin with a Copley drive operational and controlled by CME 2.

1

o b~ W0 N

Connect the accelerometer analog output to Copley drive’s Analog + and - on the signal
input as in the diagram below.

Accelerometer Copley Drive
{Analog Devices ADXL105)

Vdd oV

Com GND
Al AIN +

Com AlN -

LT
On CME 2, click the Scope Tool .
Select the Measurement tab, choose a channel, select Voltage, then Analog Command.
Perform a move.

After the move is complete, measure Tm (1/Fm), which is the period of mechanical
oscillation.

Using CME 2 to Monitor Following Error

Monitor the following error using CME 2’s scope option.
Begin with a Copley drive operational and controlled by CME 2.

1

2
3
4

185

X3
On CME 2, click the Scope Tool .
Select the Measurement tab, choose a channel, select Position, then Following Error.

Perform a move.

After the move is complete, measure Tm (1/Fm), which is the period of mechanical
oscillation.
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17.1: Amplifier RAM and Flash Memory

Amplifier RAM

o Volatile. Contents erased when amplifier is reset or powered off.

¢ Initial contents read from flash on power-up. Contents then updated in real time to reflect
certain operational conditions and changes entered with CME 2 software. At any time, the
user can use CME 2 to restore data from flash into amplifier RAM.

Flash

¢ Non-volatile. Contents retained when the amplifier is reset or powered off.

¢ Modified only by using a Save to Flash tool or by closing certain screens (Motor/Feedback,
Basic Setup, Homing, or CAN Configuration), whose contents are automatically saved to
flash upon closing of the screen.

Parameters reside in RAM only, Flash only, or both RAM and Flash. The table below illustrates
the typical parameter locations. Refer to the Parameter Dictionary for information about specific

parameters.
Data Resides In Data
Flash only This category includes all Motor/Feedback screen data and Basic Setup screen
(motor/feedback data only), This data is saved to flash when the user confirms the
values and closes the screens without cancelling.
Amplifier RAM only Includes operating status data such as actual position, actual current, and amplifier

temperature. Such data is never stored in flash. It is destroyed from amplifier RAM with
each power-down or amplifier reset.

Flash and amplifier RAM Includes all other data not represented in the two categories above. When changing
these parameters in CME 2, the value is saved to amplifier RAM only. To save these
values to flash, the Save To Flash operation must be performed or data will be lost on
power down or reset.
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17.2: Data Management Tools
Amplifier

Operations performed using the amplifier data management tools at the top of the Main screen
(shown below) affect amplifier settings, including motor/feedback data. (CVM Control Program
data is not saved by these operations).

e

@ CME 2 V6.1 (XEL-230-36 unnamed)
File Amplifier Tools Help .. .. ... .. ...

Eﬁ ﬁ [Z"i |'ﬂ ﬁ lm ﬁ ;<—Data Management Tools

Action Name Description
Eﬂ Save amplifier data Saves both amplifier and motor/feedback data to a disk with a .ccx filename
to disk extension.
Restores amplifier and motor/feedback data from a .ccx file to the amplifier’s
Restore amplifier RAM, or flash for the flash only variables. See Parameter Dictionary for
ﬁ data from disk parameter descriptions.

A To Flash operation should be performed to insure that all data is saved to flash

Em Save amplifier data Saves contents of amplifier RAM to amplifier flash memory.
to flash

“ Restore amplifier Restores contents of amplifier flash memory to amplifier RAM.
data from flash

Motor/Feedback Screen

Operations performed using the Motor/Feedback screen data management tools only apply to the
motor/feedback parameters.

Motor/Feedback L
data management tools : @ @ ‘ﬂ m ! Caloulate | ok | | cancel |

Action | Name Description
Saves only motor/feedback data to disk with a .ccm filename extension. Amplifier
'ﬂ Save motor data to . ; ok
disk ?lata that is not represented on the Motor/Feedback screen is not saved in this
ile.
ﬁ Restore motor data Restores only motor data from a disk file with a .ccm filename extension
from disk amplifier flash (the motor/feedback parameters are flash only).
Saves the contents of the Motor/Feedback screen from to amplifier flash
L:H Save motor data to memory. Amplifier data that is not represented on the Motor/Feedback screen is
flash not saved. Can be used to assure that all changes are saved to flash without
closing the Motor/Feedback screen.
Restores only motor data from amplifier flash memory to the PC. Amplifier data
m Restore motor data that is not represented on the Motor/Feedback screen is not affected. Can be
from flash used before closing the Motor/Data screen to restore settings to the previously
saved values.
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Multi-Axis Data Tools

The descriptions in this section only apply to multi-axis drives (XE2, BE2, etc.).

Copy Axis

CME 2 allows one axis to be copied to another. This feature allows quick set up of multiple axes,
since only one axis needs to be set up. The Copy Axis operation copies all RAM/Flash and Flash

Only parameters to the other axis.

From the menu on the Main screen, select File->Copy Axis. This will display the Copy Axis
screen:

r

o Copy Axis =2

From: |Axis A - To: |AxisB -

| Copy to Flash

| Ok | | Cancel

Select the source and destination axes, then click OK. Note that Copy to Flash is selected by
default. If this option is not selected, then the RAM/Flash parameters will only be copied to the
destination axis’ RAM, while still copying the Flash Only data to the destination axis’ Flash.

Save/Restore Single Axis

CME 2 allows a single axis of data to be saved/restored on a multi-axis drive. This feature is
useful when one axis of tuning/setup data is common across many multi-axis drives, but only on
one axis. The file will be saved as a .ccx file. Restoring a .ccx file to a single axis, the file must be
written as a single axis, otherwise an error will be displayed.

From the menu on the Main screen, select File->Save As->Single Axis. This will display the
Save Single Axis screen. Select the axis to be saved, click OK, and then continue with naming
and saving the file.

L2 Save Single Axis @

Save Axis: Axis Al w

| oK || Cancel
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From the menu on the Main screen, select File->Save As->Single Axis. This will display the
Restore Single Axis screen. Select the axis to restore the file data to, click OK, then browse to the
single axis file.

@ Restore Single Axis @

Restore to Axis:  #Axis B!
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17.4: Drive Configuration

The Plus Family of drives (Feature set E), have the capability of saving/restoring the entire drive
configuration to a file. The drive configuration consists of all parameters (RAM/Flash and Flash
Only) and the entire contents of the CVM flash, which includes any CVM programs, cam tables,
and gain scheduling tables. The file is saved with a .ccd file extension.

This feature is useful to clone drives in one step rather than separately loading each file (.ccx, .ccp,
.cct, .ccg). Additionally, the file is in XML format which can be read by some EtherCAT masters.
Save Drive Configuration

From the menu on the Main screen, select File->Save Drive Configuration, then choose a
filename. A progress bar will be displayed while the data is being saved to the file.

. Drive Configuration El (=] @

Saving Drive Configuration to file...

Restore Drive Configuration

From the menu on the Main screen, select File->Restore Drive Configuration, then choose a
filename. A progress bar will be displayed while the data is being saved to the file

. Drive Configuration El (=] @
Restoring Drive Configuration to Flash...

All of the data read from the file is saved to the drive’s Flash. After all of the data is written, the
drive will be reset, so that the Flash data is copied to RAM.
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17.5: Copy Drive Data

In product families prior to the Plus Family, the Drive Configuration feature is not available. In
order to clone one drive to the next, multiple steps are required.

OR

Load the .ccx file:

ﬂ From the Main screen, click Restore-> Amplifier Data.

| Losd coxFie | Starting from the Basic Setup screen, click Load ccx File.

When prompted browse to the folder containing the .ccx file and open it.

E:x On the Main screen, click Save to Flash to save the new settings to flash memory.

Load a CVM program .ccp file:
From the menu on the Main screen, choose File>Restore>CVM Control Program.
When prompted, navigate to the folder containing the appropriate .ccp file and open it.

This procedure also results in setting the Enable Control Program on Startup option, which
configures the program to auto start when the amplifier is powered up or reset.

Load Cam Table .cct files:
From the menu on the Main screen, choose File>Restore>Cam Tables.
When prompted, navigate to the folder containing the appropriate .cct file and open it.

Load Gains Scheduling Table .ccqg files:
From the menu on the Main screen, choose File->Restore->Gains Scheduling Tables.
When prompted, navigate to the folder containing the appropriate .ccg file and open it.

TIP: When copying amplifier data to multiple amplifiers in a production environment, consider
locking CME 2 to prevent accidental changes to settings. See Lock/Unlock CME.
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17.6: Save MACRO File for Delta Tau Controllers

This feature is available only on Copley MACRO drives such as the XML Xenus MACRO

1 On the CME 2 Main screen, choose File>Save MACRO File to open the MACRO File
Save window:

"

MACRO File Save [
MACRO node: 0|
[ oK ] [ Cancel ]

2 Enter the ID of the MACRO node with the settings you want to save and click OK.

3 When prompted, enter a File Name. If needed, navigate from the default AmpData
folder to another folder where you wish to store the file.

4 Click Save to save the .pmc file in the same folder and close the screen.

193 Copley Controls



Data, Firmware, and Logs

17.7: Lock/Unlock CME

CME 2 User Guide

The Lock feature of CME 2 is used to lock out most screens to prevent data from being changed.

WHEN CME 2 IS LOCKED:

e User cannot change any amplifier or motor settings.
e User can download amplifier and motor files and Cam Tables, jog the motor, run scope

functions and profiles, and monitor amplifier performance with the scope and control panel.

1 On the Main screen choose Tools>CME 2 Lock/Unlock.

2  Set a new password in the Password and Verify Password fields.

CME 2 Lock

Password:

Enter password to lock CME 2

Verify Password:

[ OK H Cancel
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Click OK to lock out amplifier setting controls.

Data, Firmware, and Logs

2 CME 2 V7.0 (SP2-090-10 Y-Axis) Auis A =N R <=
Eile Amplifier Tools Help
! Copley Neighborhood CAN Metwork:  Address: 0 State: CANopen Interface Disabled
. BB virtual Amplifier
(S - — - WO Y-Axis Inout / Outout
CVM GControl Program |
CAN Configuration  [=| Pos Limits Detent |=| | Loop [=| Moton'Feedback
@ Axis A o N
- Home Configure Faults
() AxisB
e CME 2 Locked
Axis D
Rotary Motor |#u'n|:| Under CAN Contral F12 To Disable

4 To unlock, choose Tools->CME 2 Lock/Unlock.

=

[ CME 2 Unlock =

Enter password to unlock CME 2

Password:

[7] Unlock for this session only

Lo J [ Concel ]

Enter the password. Click OK
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Firmware Download

The amplifier’s flash memory holds the ampilifier’s firmware. As needed, perform the following
steps to obtain new firmware and download it to amplifier flash memory.

NOTES:
e CME 2 does not support downloading firmware to a node amplifier via a multi-drop gateway
amplifier; a direct connection (serial, CAN, EtherCAT) must be used.

e To check the firmware version currently loaded, click the Amplifier Properties button or
choose Help>About.

WARNING: Do not power down or disconnect the amplifier during firmware
download.

1 On the Main screen choose Tools>Download Firmware to open the Download
Firmware window. Browse to where the firmware file is located and click Open to start
the download. The progress will be displayed while downloading.

QFirmware Download | = | = @

Writing new FPGA and firmware image.

When the progress dialog closes, the firmware download is complete.
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17.9: Error Log

Click the Error Log tool on the Main screen

.} Error Log o @ [
Active | History I Frequency | |
Type Diescription
Fault Motor Phasing Errar
q‘" Clear Log Refres
Tab Contents
Active Type and description of each active fault and warning. The contents of this tab are

automatically refreshed as new events occur.

History Type, description, and time of occurrence of each fault and most warnings since the log was
last cleared. The contents of this tab are not refreshed automatically as new events occur. The
contents are refreshed only when the tab is displayed or when Refresh is clicked.

Frequency Type, description, and frequency of each fault and warning that has occurred since the log
was last cleared. The contents are refreshed only when the tab is displayed or when Refresh
is clicked.

Network Status | (Under CAN control only.) Status of CANopen network. Lists warnings and errors.

Saves the contents of the History and Frequency tabs to a text file.

Clear Log Clears all History and Frequency entries in the drive.

By

Refresh Updates the contents of the History or Frequency tabs.
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17.10: Communications Log

CME 2 User Guide

The communications log displays all communications between CME 2 and the amplifier. The data
is only stored in the PC’s RAM by CME 2; it is not part of the amplifier's data.

On the Main screen, choose Tools->Communications Log

¥ Communications Log

09:35:2

09:35:26.
09:35:26.
09:35:26.
09:35:26.
09:35:26.
09:35:26.
09:35:27.
09:35:27.
09:35:27.
09:35:27.
09:35:27.
09:35:27.
09:35:27.
09:35:27.
09:35:27.
.544
09:35:27.
09:35:27.
09:35:27.

897
910
926
936
942
952
191
192
214
224
230
240
499
512
534

550
560
798

COM3
COoM3
COM3
COoM3
COoM3
COM3
COM3
COM3
COM3
COoM3
COM3
CoM3
COM3
CoM3
COM3
COM3
COM3
COoM3
COM3

Send:
Recv:
Send:
Recv:
Send:
Recv:
Send:
Recv:
Send:
Recv:
Send:
Recv:
Send:
Recv:
Send:
Recv:
Send:
Recv:
Send:

Get Amp Desired State in RAM 00 73 01 Oc 00 24 e
Get Amp Desired State in RAM 00 45 01 00 00 le EE
Get Motor Encoder Status 00 78 01 Oc 01 2e L
Get Motor Encoder Status 00 58 02 00 00 00 00 00

Get Camming Configuration 00 53 01 Oc 01 05

Get Camming Configuration 00 4a 01 00 11 00

Get Amp Desired State in RAM 00 73 01 Oc 00 24

Get Amp Desired State in RAM 00 45 01 00 00 le

Get Motor Encoder Status 00 78 01 Oc 01 2e

Get Motor Encoder Status 00 58 02 00 00 00 00 00

Get Camming Configuration 00 53 01 Oc 01 05

Get Camming Configuration 00 4a 01 00 11 00

Get Amp Desired State in RAM 00 73 01 Oc 00 24

Get Amp Desired State in RAM 00 45 01 00 00 le

Get Motor Encoder Status 00 78 01 Oc 01 2e

Get Motor Encoder Status 00 58 02 00 00 00 00 00

Get Camming Configuration 00 53 01 Oc 01 05

Get Camming Configuration 00 4a 01 00 11 00

Get Amp Desired State in RAM 00 73 01 Oc 00 24 -

]

<

[¥] Enable Logging

[] Enable Event Status Logging

Option

Description

Enable Logging

When selected, logging is enabled and all communications, with the exception
of status messages, are recorded in the log

Logging

Enable Event Status

When selected, status messages are included in the log. Note that Show “Get
Variable” Cmnds must also be checked to log Event Status commands.

Cmds

Show “Get Variable”

When selected, “Get Variable” commands are added to the log.

Saves the contents of the Communications Log to a text file.

Clears the log contents from the PC’s RAM
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18.1: Overview

Virtual amplifiers can be used for creating amplifier and motor data files off line. A new virtual
amplifier can be created based on a virtual amplifier template file (.ccv) or from an existing .ccx file.
CME 2 includes a set of .ccv files for each model that is supported.

1 (e
)} CME2 V6.0 (AEP-090-18

File Amplifier Tools Help

87 & 3 [P B

=g Copley Neighborhood

Select the Virtual Amplifier node from the Copley Neighborhood. This will display the
Open Virtual Amplifier screen:

Open Virtual Amplifier

Choose the method you want to use to create the
virtual amplifier.

@ Create new amplifier file

Open existing amplifier file

[ oK l Cancel J [ Help J

2 Create new amplifier file
e Select Create new amplifier and click OK.
e When prompted, select the .ccv that represents the appropriate drive model.
¢ Click Open. The Basic Setup screen will be displayed.
e Motor and amplifier values may now be viewed, entered, and adjusted.

Open existing amplifier file

Select Open existing amplifier file and click OK.

When prompted, select the appropriate .ccx file.

Click Open.

Motor and amplifier values may now be viewed, entered, and adjusted.
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Overview

The Gain Scheduling feature allows you to schedule gain adjustments based on changes to a key
parameter. For instance, Pp, Vp, Vi, and Current Offset (A) could be adjusted based on changes to
commanded velocity.

Gain adjustments are specified in a Gain Scheduling Table. Each table row contains a key
parameter value and the corresponding gain settings. The amplifier uses linear interpolation to
make smooth gain adjustments between the programmed settings.

Gain scheduling involves the basic steps outlined below. Details follow in the chapter.

Storage Limits

The maximum number of lines that can be stored in the Gain Scheduling Table is 1000. A typical
Gain Schedule Table will contain far fewer lines. The number of Gain Scheduling Table lines is
also limited by the amount of CVM memory space available in the amplifier. A Gain Scheduling
Table shares that space with CVM programs and Camming Tables. Therefore, the maximum
number of Gain Schedule Table lines will decrease if CVM programs or Camming Tables are
stored in the amplifier.

The Gain Scheduling screen Tables tab displays the percentage of amplifier memory used:

i
3

CVM memory usage: 1%
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Gains Scheduling

19.2: Configure Gain Scheduling

1 From the menu on Main screen, choose Amplifier->Gain Scheduling.
.} Gain Scheduling =] 2 ]
File Edit
{Confia}

Key Parameter:

Select Gains
Position Loop Pp
Velodty Loop Vp
Velodty Loop Vi
Current Loop Offset

Disable Gain Scheduling -

|Use Absolute Value of Key Parameter
Disable Gain Scheduling Untl Axis is Referenced

i (G ) ) .

2 Choose the Key Parameter:

Key Parameter

Description

Disable Gain Scheduling.

Disable gain scheduling.

Use Written Parameter.

An external controller can write to this parameter using any of several
protocols and corresponding parameter IDs: Copley ASCII Interface or the
Copley Indexer 2 Program (ID 0x128), CANopen and EtherCAT(Index
0x2371), and MACRO I-variable (0x528).

See the Copley ASCII Interface Programmer’s Guide, the Copley Indexer 2
Program User Guide, or the Copley CANopen Programmer’s Guide.

Use Commanded Velocity.

Schedule gain adjustments based on changes to commanded velocity.

Use Actual Velocity.

Schedule gain adjustments based on changes to actual velocity.

Use Commanded Position.

Schedule gain adjustments based on changes to commanded position.

Use Actual Position.

Schedule gain adjustments based on changes to actual position.

3 Optionally set controls:

Control Description
Use Absolute Value of Key If a velocity or position value is chosen for the Key Parameter and this option
Parameter is set, the Key Parameter is interpreted as an absolute value.

Disable Gain Scheduling
Until Axis is Referenced

When this option is set, the scheduled gain adjustments do not take place
until the axis is referenced (homed).

4 Select the gains that you wish to adjust by schedule. The choices are Pp, Vp, Vi and
Current Offset (A). For each gain you select, a column will be enabled in the Gain

Scheduling Table.

5 Continue with Set Up Gain Scheduling Tables

203

Copley Controls




Gains Scheduling CME 2 User Guide

19.3: Set Up Gain Scheduling Tables

On the Gain Scheduling screen, open the Table tab:

(2 Gain Scheduling o @ [
File Edit
Key Value F Loop Pp V Loop Vp V Loop Vi Current Offset (A)
0 a 10 20 20 0.5
500000 20 20 20 1.0

CVM memory usage: 1%
3¢

| <all =)

Close

Description
Creates a new table

Deletes the table from amplifier flash and PC RAM

Saves configuration and table to disk

Restores configuration and table to PC only

Saves configuration and table to amplifier flash

ARAEDEE

Restores configuration and table from amplifier flash to PC. This operation
overwrites all data on the Gains Scheduling screen.

1 On the Gain Scheduling screen, open the Table tab:
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Gains Scheduling

¥ Gain Scheduling
File Edit

Config | Table

(=] & ==

kKey Value

F Loop Pp

W Loop Vp W Loop Vi

Current Offset (A)

CVM memory usage: 1%
it

Sl [l =) (Al

Close

2 D? Click the Create New Table button and enter the number of lines for the table.

L} New Table

Enter Mumber of Lines:

[ aK ][ Cancel ]

=S

2

-

3 Enter the Key Parameter and gain adjustment values.

NOTE:

¢ All values must be whole numbers (no fractional values).

e All Key Values must be increasing.

4 After all values have been entered, click the Save Table button. This action saves

both configuration and table data.

Copley Controls



Gains Scheduling CME 2 User Guide

Copley Controls 206



CME 2 User Guide Regen Resistor Configuration

CHAPTER

20: REGEN RESISTOR CONFIGURATION
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Incorrect values may damage amplifier or external regen
resistor.

For the regen I°T algorithms to work correctly, the values

WARNING entered in the following steps must be correct. Damage to the
external regen resistor may result from incorrect values entered.
Damage to the amplifier may result if an incorrect resistance
value is entered.

Failure to heed this warning can cause equipment damage.

Configure a Standard Copley Controls Regen Resistor

Configure Regen . . .
1 i Click Configure Regen to open the Regen Resistor screen
Regen Resistor
o) None
) XTL-RA-03
) XTL-RA-04

~) Custom Resistor Configure

2 Select the model number XTL-RA-03 or XTL-RA-04 and click OK to save the
configuration and close the screen.

[ Regen Resistor ‘

) XTL-RA-04

~) Custom Resistor Configure

View Settings ] [ oK ][ Cancel
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Configure a Custom Regen Resistor

1 Configure Regen . . .
st Click Configure Regen to open the Regen Resistor screen.
'Regen Resistor '

© fignd

(7 XTL-RA-03

(71 XTL-RA-04

") Custom Resistor Configure

View Settings L OK ] [ Cancel ]

2 Select Custom Resistor and click Configure to enter the custom resistor data. Read the
information displayed and click OK

Custom Regen Resistor ‘

Regen resistors are subject to potentially high power dissipation depending on

the resistor value and the amount of energy being regenerated from the motor and
load. To ensure safety and reliable operation, it is important to select a regen
resistor that is appropriate for your application.

3 Follow the instructions on step 1 through 5 of the Custom Regen Wizard, then click

Finish.

Custom Regen Resistor Configuration @
Step 5

Resistance: 30| Q P

Contivaous Pawer: 25| w Custom regen resistor configuration is
complete.

Pk Powar 25| \ -

Peak Powe : Press Finish to accept the values entered and
save them to the amplifier's RAM and flash.

Time at Peak Power 50| ms
To change any of the values press Prev
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View Regen Settings

1 | viewsSettings

|

Regen Settings
Resistance: 30 Q
Continuous Power: 65 W
Peak Power: 5000 W
Time at Peak Power: 1000 ms

Copley Controls

CME 2 User Guide

] Click Configure Regen Settings to open the Regen Settings screen.
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Overview

The I°T current limit algorithm continuously monitors the energy being delivered to the motor using
the 1T Accumulator Variable. The value stored in the I1°T Accumulator Variable is compared with
the I°T setpoint that is calculated from the user-entered Peak Current Limit, 12T Time Limit, and
Continuous Current Limit. Whenever the energy delivered to the motor exceeds the I°T setpoint,
the algorithm protects the motor by limiting the output current or generates a fault.

Formulas and Algorithm Operation

Calculating the I°T Setpoint Value
The I°T setpoint value has units of Amperes?-seconds (A’S) and is calculated from programmed
motor data. The setpoint is calculated from the Peak Current Limit, the I?T Time Limit, and the
Continuous Current Limit as follows:

I°T setpoint =

(Peak Current Limit? — Continuous Current Limit?) * I°T Time Limit

Algorithm Operation

During amplifier operation, the 1T algorithm periodically updates the 1T Accumulator Variable at a
rate related to the output current Sampling Frequency. The value of the 1T Accumulator Variable
is incrementally increased for output currents greater than the Continuous Current Limit and is
incrementally decreased for output currents less than the Continuous Current Limit. The 1°T
Accumulator Variable is not allowed to have a value less than zero and is initialized to zero upon
reset or +24 Vdc logic supply power-cycle.

Accumulator Increment Formula

At each update, a new value for the 1T Accumulator Variable is calculated as follows:
1T Accumulator Variable ., =
I°T Accumulator Variable ,,
+(Actual Output Current ,,> — Continuous Current Limit?) * Update period

After each sample, the updated value of the I°T Accumulator Variable is compared with the I°T
setpoint. If the I°T Accumulator Variable value is greater than the 1°T Setpoint value, then the
amplifier limits the output current to the Continuous Current Limit. When current limiting is active,
the output current will be equal to the Continuous Current Limit if the commanded current is
greater than the Continuous Current Limit. If instead the commanded current is less than or equal
to the Continuous Current Limit, the output current will be equal to the commanded current.
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Application Example

Operation of the I°T current limit algorithm is best understood through an example. For this
example, a motor with the following characteristics is used:

e Peak Current Limit—12 A
e I°T Time Limit—1S
e Continuous Current Limit — 6 A

From this information, the I°T setpoint is:
setpoint = (12 A>-6 A®) *1 S = 108 A°S

Plot Diagrams

The plots that follow show the response of an amplifier (configured w/ I°T setpoint = 108 A?S) to a
given current command. For this example, DC output currents are shown in order to simplify the
waveforms. The algorithm essentially calculates the RMS value of the output current, and thus
operates the same way regardless of the output current frequency and wave shape.

1T current limit

16 I I

17/ I | |_commanded
124 T EERETEEER . |_actual
< 10 -

4 -

2 -

0

0 1 2 3 4 5 6 !
Time (S)
Diagram A

At time 0, plot diagram A shows that the actual output current follows the commanded current.
Note that the current is higher than the continuous current limit setting of 6 A. Under this condition,
the I°T Accumulator Variable begins increasing from its initial value of zero. Initially, the output
current linearly increases from 6 A up to 12 A over the course of 1.2 seconds. During this same
period, the I°T Accumulator Variable increases in a non-linear fashion because of its dependence
on the square of the current.

At about 1.6 seconds, the I°T Accumulator Variable reaches a values equal to the I°T setpoint. At
this time, the amplifier limits the output current to the continuous current limit even though the
commanded current remains at 12 A. The I°T Accumulator Variable value remains constant during
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the next 2 seconds since the difference between the actual output current and the continuous
current limit is zero.

At approximately 3.5 seconds, the commanded current falls below the continuous current limit and
once again the output current follows the commanded current. Because the actual current is less
than the continuous current, the 1°T Accumulator Variable value begins to fall incrementally.

The 1T Accumulator Variable value continues to fall until at approximately 5.0 seconds when the
commanded current goes above the continuous current limit again. The actual output current
follows the current command until the I°T Accumulator Variable value reaches the 1°T setpoint and

current limiting is invoked.

I°T Accumulator
120
@ 1004 SN R N
< 80 /
> enl |/ | 12T Setpoint L~
o 60 -
S 40 4 12T Accumulator
@ /
= 204
0 /
0 1 2 3 4 5 6 7
Time (S)
Diagram B

I°T Scope Trace Variables
Two Scope Tool trace variables are available for monitoring whether the I1°T accumulator is
accumulating or discharging.
e The I°’T Amplifier Accumulator variable evaluates the accumulator against the factory set
current limits of the amplifier.
e The I°T Motor Accumulator variable evaluates the accumulator against the user-
programmed current loop values.
The value shown Diagram B has been normalized so that 100% equals the I°T setpoint.
When either trace variable line reaches 100%, current limiting will be invoked.
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APPENDIX B

HOMING METHODS
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Overview
There are several homing methods. Each method establishes the:
e Home reference (limit or home switch transition or encoder index pulse)

o Direction of motion and, where appropriate, the relationship of the index pulse to limit or
home switches.

Homing Diagram Legend

As highlighted in the example below, each homing method diagram shows the starting position on
a mechanical stage. The arrow line indicates direction of motion, and the circled H indicates the
home position. Solid line stems on the index pulse line indicate index pulse locations. Longer
dashed lines overlay these stems as a visual aid. Finally, the relevant limit switch is represented,
showing the active and inactive zones and transition.

Mechanical Stage Limits

Axis \l/

<
[l
L
. i, | .
Starting position —> | 0 )

/@4— <— Direction of motion
—— ®<—| <— Starting position

Home position

Index pulse location
Index Pulse | | |

Positive Limit
Switch /T
Switch inactive T Switch active

Swi itch transition

Note that in the homing method descriptions, negative motion is leftward and positive motion is
rightward.
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Homing Method Descriptions

Set current position as home
The current position is the home position.

Next Index

Direction of Motion: Positive

Home is the first index pulse found in the positive direction. Direction of motion is positive. If a
positive limit switch is activated before the index pulse, an error is generated.

| —

—®

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse found in negative direction. Direction of motion is negative. If a
negative limit switch is activated before the index pulse, an error is generated.

[ ] |

Index Pulse | |
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Limit Switch

Direction of Motion: Positive
Home is the transition of the positive limit switch. Initial direction of motion is positive if the positive

limit switch is inactive.

—®

Positive Limit :,—
Switch

Direction of Motion: Negative
Home is the transition of negative limit switch. Initial direction of motion is negative if the negative

limit switch is inactive.

®—

Negative Limit

Switch |
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Limit Switch Out to Index

Direction of Motion: Positive

Home is the first index pulse to the negative side of the positive limit switch transition. Initial
direction of motion is positive if the positive limit switch is inactive (shown here as low).

[ =

Ch
Positive Limit : [
Switch : [_
Index Pulse |

Direction of Motion: Negative

Home is the first index pulse to the positive side of the negative limit switch transition. Initial
direction of motion is negative if the negative limit switch is inactive (shown here as low).

Il |

Negative Limit .1 @

Switch

Index Pulse |
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Hardstop

Direction of Motion: Positive

Home is the positive hard stop. Direction of motion is positive. In servo modes, the hard stop is
reached when the amplifier outputs the homing Current Limit continuously for the amount of time
specified in the Delay Time.

If a positive limit switch is activated before the hard stop, an error is generated.

[ l

| -®

Direction of Motion: Negative

Home is the negative hard stop. Direction of motion is negative. The hard stop is reached when
the amplifier outputs the homing Current Limit continuously for the amount of time specified in the
Delay Time. If a negative limit switch is activated before the hard stop, an error is generated.

i1 |

®- |

Hardstop Methods in Stepper Mode

In Stepnet amplifiers operating in stepper mode with an encoder, the hard stop is reached when
the following error is exceeded. When using hardstop methods in stepper mode, do not disable
following error.
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Hardstop Out to Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the positive hard stop. Initial direction of
motion is positive. The hard stop is reached when the amplifier outputs the homing Current Limit
continuously for the amount of time specified in the Delay Time. If a positive limit switch is
activated before the hard stop, an error is generated.

[ =
| @Q

Index Pulse |

Direction of Motion: Negative

Home is the first index pulse on the positive side of the negative hard stop. Initial direction of
motion is negative. The hard stop is reached when the amplifier outputs the homing Current Limit
continuously for the amount of time specified in the Delay Time. If a negative limit switch is
activated before the hard stop, an error is generated.

[ J |

Index Pulse l l

Hardstop Out to Index Methods in Stepper Mode

In Stepnet amplifiers operating in stepper mode with an encoder, the hard stop is reached when
the following error is exceeded. When using hardstop methods in stepper mode, do not disable
following error.
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Home Switch

Direction of Motion: Positive

Home is the home switch transition. Initial direction of motion is positive if the home switch is
inactive. If a limit switch is activated before the home switch transition, an error is generated.

| |

Home Switch

Direction of Motion: Negative

Home is the home switch transition. Initial direction of motion is negative if the home switch is
inactive. If a limit switch is activated before the home switch transition, an error is generated.

| |
i

Home Switch |
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Home Switch Out to Index

Direction of Motion: Positive

Home is the first index pulse to the negative side of the home switch transition. Initial direction of
motion is positive if the home switch is inactive. If a limit switch is activated before the home switch
transition, an error is generated.

[

N
 I—

Home Switch |

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse to the positive side of the home switch transition.
Initial direction of motion is negative if the home switch is inactive. If a limit switch is activated
before the home switch transition, an error is generated.

[ — |

Home Switch

Index Pulse l l
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Home Switch In to Index

Direction of Motion: Positive

Home is the first index pulse to the positive side of the home switch transition. Initial direction of

motion is positive if the home switch is inactive. If a limit switch is activated before the home switch
transition, an error is generated.

| —

C

Home Switch |

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse to the negative side of the home switch transition. Initial direction of
motion is negative if the home switch is inactive. If a limit switch is activated before the home
switch transition, an error is generated.

| |
T D

< " ]

Home Switch

Index Pulse |
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Lower Home

Direction of Motion: Positive

Home is the negative edge of a momentary home switch. Initial direction of motion is positive if the
home switch is inactive. Motion will reverse if a positive limit switch is activated before the home
switch; then, if a negative limit switch is activated before the home switch, an error is generated.

[ =/ gl
2D D

Cha '

P— i

Positive Limit

Switch / / l

Direction of Motion: Negative

Home is the negative edge of a momentary home switch. Initial direction of motion is negative. If
the initial motion leads away from the home switch, the axis reverses on encountering the negative
limit switch; then, if a positive limit switch is activated before the home switch, an error is

generated.
[ g (%;/ f | ]
o5 —

; @‘_|
Home Switch f_/ /_‘
Negative Limit '
Switch _I // //
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Upper Home

Direction of Motion: Positive

Home is the positive edge of a momentary home switch. Initial direction of motion is positive. If the
initial motion leads away from the home switch, the axis reverses on encountering the positive limit
switch; then, if a negative limit switch is activated before the home switch, an error is generated.

[ el =
~® |

e
7 ’

Home Switch
Positive Limit :
Switch // // l

Direction of Motion: Negative

Home is the positive edge of momentary home switch. Initial direction of motion is negative if the
home switch is inactive. If the initial motion leads away from the home switch, the axis reverses on
encountering the negative limit switch; then, if a positive limit switch is activated before the home

switch, an error is generated.
/
I: ' /' /ED ]

-

Home Switch ,_/ A
Negative Limit '
Switch _l // //
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Lower Home Outside Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the negative edge of a momentary home
switch. Initial direction of motion is positive if the home switch is inactive. If the initial motion leads
away from the home switch, the axis reverses on encountering the positive limit switch; then, if a
negative limit switch is activated before the home switch, an error is generated.

[ ==/ =

@
Home Switch f_/ /_\
Positive Limit / |_

Switch : 7/

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse on the negative side of the negative edge of a momentary home
switch. Initial direction of motion is negative. If the initial motion leads away from the home switch,
the axis reverses on encountering the negative limit switch; then, if a negative limit switch is
activated before the home switch, an error is generated.

I = ]
Gl o

B |
E B
Home Switch : Lo
s T
Negative Limit ; ;
Switch  — : .
' !/

Index Pulse |
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Lower Home Inside Index

Direction of Motion: Positive
Home is the first index pulse on the positive side of the negative edge of a momentary home

CME 2 User Guide

switch. Initial direction of motion is positive if the home switch is inactive. If the initial motion leads

away from the home switch, the axis reverses on encountering the positive limit switch; then, if a

negative limit switch is activated before the home switch, an error is generated.

[

s

vy

Home Switch : / /L|
Positive Limit Ly
Switch 7/
Index Pulse |

Direction of Motion: Negative

Home is the first index pulse on the positive side of the negative edge of a momentary home

switch. Initial direction of motion is negative. If the initial motion leads away from the home switch,

the axis reverses on encountering the negative limit switch; then, if a negative limit switch is

activated before the home switch, an error is generated.

[

Home Switch

ks
—

.

Negative Limit —|

Switch

Index Pulse

e

/ /

—7 /
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Upper Home Outside Index

Direction of Motion: Positive

Home is the first index pulse on the positive side of the positive edge of a momentary home switch.
Initial direction of motion is positive. If the initial motion leads away from the home switch, the axis
reverses on encountering the positive limit switch; then, if a negative limit switch is activated before
the home switch, an error is generated.

I/ l/
7/

-1
1

Home Switch 7 F
Positive L_imit / 5 |
Switch ]/ :

Index Pulse

Direction of Motion: Negative

Home is the first index pulse on the positive side of the positive edge of a momentary home switch.
Initial direction of motion is negative if the home switch is inactive. If the initial position is right of
the home position, the axis reverses on encountering the home switch.

[ i /= |
Y

Home Switch ’_/ /_‘

Negative Limit :
Switch ] // //

Index Pulse
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Upper Home Inside Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the positive edge of momentary home switch.
Initial direction of motion is positive. If initial motion leads away from the home switch, the axis
reverses on encountering the positive limit switch; then, if a negative limit switch is activated before
the home switch, an error is generated.

[ / /AD g ]
| o)
®-

|—)§ Q

Positive Limit / : |

Switch 7
Index Pulse |

Direction of Motion: Negative

Home is the first index pulse on the negative side of the positive edge of a momentary home
switch. Initial direction of motion is negative if the home switch is inactive. If initial motion leads
away from the home switch, the axis reverses on encountering the negative limit; then, if a
negative limit switch is activated before the home switch, an error is generated.

[ é 7 /AD ]
‘ P

CA ) |
Home Switch # / __|
Negative Limit : :

Switch —] / /

Index Pulse | |
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Copley ASCII Interface

An amplifier's RS-232 serial bus can be used by an external control application (HMI,
PLC, PC, etc.) for setup and direct serial control of the amplifier. The control application
can issue amplifier commands from the set of ASCII format commands that make up the
Copley Controls ASCII Interface.

For more information, see the Copley ASCI! Interface Programmer’s Guide.

CME 2 ASCIlI Command Line Interface Tool

As described below, the CME 2 ASCII Command Line Interface tool provides a simple
way to enter Copley ASCIl commands.

Use the ASCIl Command Line Interface to Enter Commands

1 From the Main screen, choose Tools=>ASCIl Command Line to open the tool.

rQ ASCII Command Line |i| =
Command:
Response:
7 »

2 Enter an ASCII Command in the Command field.

3 Press the Enter key to send the command to the amplifier. Observe the Response field.
If a value is returned, it is preceded by the letter “v.” In the following example, the get
command was used to retrieve the amplifier RAM value of variable 0x32 (actual

osition).

Q ASCIl Command Line o] &8

Command: |g r0x32|

Response: |v 71

< ’

An error code would be preceded by the letter “e.”
TIP: To view an error definition, hold the mouse pointer over the error number.

For more information, see the Copley ASCII Interface Programmer’s Guide and the
Copley Amplifier Parameter Dictionary.
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Single-Axis Serial Connection

For RS-232 serial bus control of a single axis, set the CAN node address of that axis to
zero (0). Note that if the CAN node address is switched to zero after power-up, the
amplifier must be reset or power cycled to make the new address setting take effect.

Serial Copley Amplifier
SER-CK "Serial Cable Kit"
PC,PLC,or HMI | COMport | g b erial Cable ki RI11 with ASCII
for ASCII Control for ! RS-232
RS-232
ADDRESS MUST BE SET
TO ZERO BEFORE

POWER-UP OR RESET.

Multi-Drop Serial Connection

A serially connected amplifier can be used as a multi-drop gateway for access to other
amplifiers linked in a series of CAN bus connections. Set the CAN node address of the
serially connected amplifier (gateway) to zero (0). Assign each additional amplifier in the
chain a unique CAN node address value between 1 and 127. For more information on
CAN node address assignment, see Network Configuration. Use 120 Ohms termination on
the first and last amplifier.

TERMINATION MUST BE 120 Ohm
USED ON FIRST AND LAST Terminator
NODE

Serial - ; .

PC, PLC, or HMI ) SER-CK "Serial Cable Kit" Copley Amplifier CAN

for ASCII Control | COMPOrt | 9pin D-sub with ASCII RS-232  ADDR @ CAN Fort
0

for RS-232

CAN Network Cable UTP CAT.5E Gigabit Ethernet

CAN CAN Port CAN CAN Port CAN CAN Port
ADDR ADDR ADDR
1 1

ADDRESSES MUST BE 120 Ohm
SET BEFORE POWER-UP Terminator
OR RESET.
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Recommended Device

Copley Controls recommends using the 232USB9M USB to Serial Adapter made by B&B
Electronics (http://www.bb-elec.com/). Copley Controls has tested this low cost device extensively
with CME 2 software.

Factory Settings

The factory settings for this device works well, but Copley recommends changing the Latency time
for faster performance with CME 2 software. This value is changed through the Windows Device
Manager

1 Open the Device Manager dialog from the Windows Control Panel and expand the Ports
(COM &LPT) node:

ié Batteries
€ Bluetooth Radios
&* CAN Hardware (Kvaser)
/& Computer
&¥ ControlVault Device
¢ Disk drives
&2, Display adapters
o.s DVD/CD-ROM drives
Q,-,; Human Interface Devices
¢ IDE ATA/ATAPI controllers
=5 Imaging devices
= Keyboards
):{ Mice and other peinting devices
& Monitors
&¥ Network adapters
Y Ports (COM & LPT)
'Y Communications Port (COM1)
5" ECP Printer Port (LPT1)
¥ RS-232 Port (COM2)
B Processors
% Smart card readers
& Sound, video and game controllers
- Storage controllers
/M System devices

S

2 Select the COM port that is used by the USB to Serial Adapter (refer to manufacturer’s
documentation for details).

3 Right-click that port and select Properties from the pop-up menu. This will open the device
properties.


http://www.bb-elec.com/

B&B USB to Serial Adapter CME 2 User Guide

RS-232 Port (COM2) Properties (=3

General | Port Settings | Driver | Details |

- R5-232 Port {COMZ)
P
Device type: Ports (COM & LPT)
Manufacturer: B&B Blectronics
Location: on Model 232USB5M
Device status
[This device is working propery. -

[ ok || cancel

4 Select the Port Settings tab, then click the Advanced button.

RS-232 Port (COMZ) Properties ==

Bits per second: | 9600 -|
Databits: [8 -|
Partty: | None -|

Stop bits: [1 -|

Fiow cortirol: [None v

[ Advanced... ] [Bestore Defaults ]

[ ok ][ cancel
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B&B USB to Serial Adapter

Advanced Settings for COM2

COM Port Number: ComM2

USEB Transfer Sizes

Select higher settings for faster perfarmance.

Receive (Bytes): 4096
Transmit (Bytes): 4096
EM Options

Select lower settings to correct response problems.

Latency Timer (msec):

Timeouts
Minimum Read Timeout (msec):

Minimum Write Timeout (msec):

Select lower settings to correct performance problems at low baud rates.

(-7 [l

QK

Cancel

Defaults

Miscellaneous Options
Serial Enumerator

Serial Printer

Cancel If Power Off

Event On Surprise Removal
Set RTS On Close

Disable Modem Ctrl At Startup

1 i T Y

The factory default setting for Latency Timer is 16 ms as shown above. Change the
Latency Timer to 1 ms, No other settings should be changed. Click OK to set the new

value and close the dialog.

Click OK to close the device properties dialog.
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